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Giáo án Tin học lớp 7 – Quyển 2                                  


Tiết: 1                                                                     

 
Ngày Soạn: 08/8/2012
Tuần: 1                                                                    


Ngày dạy :  16/8/2012
LUYỆN GÕ PHÍM NHANH BẰNG

TYPING TEST
I. MỤC TIÊU:

a. Kiến thức:

-Nắm được công dụng của phần mềm Typing Test

-Hiểu được cách thức sử dụng trò chơi Bubbles của Typing Test.

b. Kĩ năng:

-Giúp các em luyện gõ phím nhanh hơn.

-Hình thành kỹ năng nhanh nhẹn, thích khám phá qua từng trò chơi.

II.  PHƯƠNG PHÁP:

     -Thực hành nhóm trên máy

III.  CHUẨN BỊ

1. Chuẩn bị của giáo viên: 

· Giáo án,phòng máy phải được cài đặt sẳn phần mềm Typing Test. 

2. Chuẩn bị của học sinh: 

· SGK, vở, bút.

IV. HOẠT ĐỘNG DẠY HỌC:

1. Ổn định tổ chức: Kiểm tra sĩ số lớp. (5 phút)

2. Kiểm tra bài cũ: 


3. Giảng bài mới:
	TL
	Nội dung
	Hoạt động của Giáo viên
	Hoạt động của HS

	Hoạt động 1: Giới thiệu phần mềm (5 phút)

	
	1. Giới thiệu phần mềm:

- Typing Test là phần mềm dùng để luyện gõ phím nhanh thông qua một số trò chơi đơn giản nhưng rất hấp dẫn. Bằng cách chơi với máy tính em sẽ luyện được kỹ năng gõ bàn phím nhanh bằng 10 ngón.
	- GV giới thiệu :Typing Test là phần mềm dùng để luyện gõ phím nhanh thông qua 4 trò chơi đơn giản. Bằng cách chơi với máy tính, các em sẽ luyện được kỹ năng gõ bàn phím nhanh.

- GV chốt lại một lần nữa cho HS nắm.
	- HS chú ý lắng nghe.

- Ghi vở những gì hiểu được thông qua lời giới thiệu của GV.

- Học sinh ghi vở.

	Hoạt động 2: Khởi động và giới thiệu giao diện phần mềm. (20 phút)

	
	- Nháy đúp vào biểu tượng 
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 trên màn hình nền.
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- Chọn tên hoặc gõ tên mới vào ô Enter Your Name -> nháy nút 
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* Giới thiệu giao diện phần mềm:

B1: Nháy vào nút Warm up games

B2: Chọn trò chơi mà em muốn chơi.

Ghi chú: 

+ Clouds: đám mây

+ Bubbles: bong bóng

+ Wordtris: gõ từ nhanh

+ ABC: bảng chữ cái

B3: Nháy nút 
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 ở phía dưới trò chơi đó.

B4: Nháy nút 
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  một lần nữa để vào màn hình chính của trò chơi.
	- Giới thiệu phần mềm trò chơi trên màn hình để HS quan sát. 

- Gọi 1-3 HS lên gõ tên mới để vào trò chơi.

? Để vào giao diện trò chơi em thực hiện như thế nào.

- GV kết luận.

- Làm qua các bước để vào trò chơi trên máy tính

- Vào trò chơi đám mây để HS quan sát sau đó thoát khỏi trò chơi.

? Để bắt đầu trò chơi ABC em thực hiện ntn.

- Gọi HS lên máy làm, HS còn lại quan sát và nhận xét.

- Kết luận các nhận xét và bài làm của HS
	- Lắng nghe và quan sát trên MH.

- Thực hiện trên máy GV.

- Suy nghĩ và trả lời

- HS còn lại nhận xét

- Lắng nghe và quan sát GV làm.

- Quan sát

- Suy nghĩ và trả lời

- Thực hiện

	Hoạt động 3: Trò chơi Bubbles (bong bóng) (10 phút)
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- Nếu gõ đúng bọt khí sẽ biến mất.

- Nếu gõ không đúng or để bọt khí chuyển động lên trên và che khuất thì sẽ bị tính là bỏ qua.

- Chỉ được phép bỏ qua nhiều nhất là 6 chữ.

* Chú ý: cách gõ chữ in hoa: Shift + chữ cái cần gõ.
	- Giới thiệu qua cách chơi trò chơi bong bóng.

- Cho HS quan sát trên MH

? Để gõ chữ thường thành chữ hoa, em thực hiện theo mấy cách.

? Đó là những cách nào.

- Nhận xét trả lời của HS.

? Trong trò chơi bong bóng này, thực hiện theo cách nào là nhanh nhất.

- Gọi một sô HS lên máy thực hành, HS còn lại quan sát và nhận xét.


	- Nghiên cứu SGK trước.

- Nhận xét

- Suy nghĩ và trả lời

- Trả lời: Nhấn giữ phím Shift + chữ cái cần gõ.

- Ghi vở

	Hoạt động 4: Củng cố (5 phút)

	
	
	- Nắm kỷ cách khởi động, cách chơi trò bong bóng.

- Cách thoát khỏi trò chơi.
	


Tiết: 2                                                                 

             
Ngày Soạn: 08/8/2012
Tuần: 2                                                                         

  
Ngày dạy :  21/8/2012
LUYỆN GÕ PHÍM NHANH BẰNG

TYPING TEST

I. MỤC TIÊU:

a. Kiến thức:

-Nắm được công dụng của phần mềm Typing Test

-Hiểu được cách thức sử dụng trò chơi  ABC, Clouds, wordtris
b. Kĩ năng:

-Giúp các em luyện gõ phím nhanh hơn.

-Hình thành kỹ năng nhanh nhẹn, thích khám phá qua từng trò chơi.

II.  PHƯƠNG PHÁP:

     -Thực hành nhóm trên máy

III CHUẨN BỊ

1. Chuẩn bị của giáo viên: 

· Giáo án,phòng máy phải được cài đặt sẳn phần mềm Typing Test. 

2. Chuẩn bị của học sinh: 

· SGK, vở, bút.

IV. HOẠT ĐỘNG DẠY HỌC:

1. Ổn định tổ chức: Kiểm tra sĩ số lớp. (5 phút)

2. Kiểm tra bài cũ: 


3. Giảng bài mới:
	TL
	Nội dung
	Hoạt động của Giáo viên
	Hoạt động của HS

	Hoạt động 1: Trò chơi ABC (bảng chữ cái) (7 phút)

	
	- Gõ chính xác các chữ cái xuất hiện trong vòng tròn.
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	? Trên bàn phím có bao nhiêu chữ cái.

- Nhận xét.

? Quan sát MH và cho nhận xét: Bảng chữ cái xuất hiện ntn.

- Gọi một số HS lên máy thực hành và HS còn lại qs – nhận xét.
	- Suy nghĩ và trả lời

- Quan sát và trả lời

- Ghi vở

- Thực hiện

	Hoạt động 2: Trò chơi Clouds ( đám mây) (7 phút)
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- Gõ đúng các chữ dưới đám mây thì đám mây sẽ biến mất.

- Phím Space or Enter để chuyển sang đám mây tiếp theo.

- BackSpace: quay lại đám mây đã đi qua.

- Đám mây đóng khung là đám mây cần phải gõ.
	- Các em hãy quan sát trên MH:

? Những đám mấy xuất hiện ntn. Bay theo hướng nào.

- Kết luận nx của HS

? Phân biệt sự khác nhau giữa các đám mây.

- KL nx của HS

- GV thực hành trên máy thông qua một đám mây cho HS nx.
	- Tham khảo SGK trước.

- Suy nghĩ và trả lời

- Suy nghĩ và trả lời

- Nhận xét

- Ghi vở

	Hoạt động 3: Trò chơi Wordtris (gõ từ nhanh) (7 phút)
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- Quy tắc chơi tương tự giống các trò chơi trước.

- Sau khi gõ đúng, thanh chữ sẽ biến mất. Để tiếp tục, em cần nhấn phím cách (Space)
	- Thực hành trên máy, HS quan sát và cho nhận xét.

- KL nx của HS

? Trò chơi này tương tự trò chơi nào.

-> trò chơi  xếp hình Tetris
	- Tham khảo SGK trước.

- Suy nghĩ và trả lời

- Nhận xét

- Suy nghĩ và trả lời

- Ghi vở

	Hoạt động 4: Kết thúc phần mềm ( 4 phút)

	
	- Nháy vào nút 
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 phía trên bên phải màn hình.
	- Hướng dẫn cách thoát khỏi phần mềm.
	- Quan sát

	Hoạt động 4: Củng cố (5 phút)

	
	
	- Nắm kỷ cách khởi động, cách chơi trò đám mây, gõ từ nhanh, bảng chữ cái.

- Cách thoát khỏi phần mềm.

- Nắm kỷ lý thuyết để tiết sau thực hành tại phòng máy.
	


Tiết: 3 - 4                                                          


           Ngày Soạn: 15/8/2012
Tuần: 2                                                                 

 
Ngày dạy :  23/8/2012
LUYỆN GÕ PHÍM NHANH BẰNG

TYPING TEST

I. MỤC TIÊU:

a. Kiến thức:

-Nắm được công dụng của phần mềm Typing Test

-Hiểu được cách thức sử dụng 4 trò chơi của Typing Test.

b. Kĩ năng:

-Giúp các em luyện gõ phím nhanh hơn.

-Hình thành kỹ năng nhanh nhẹn, thích khám phá qua từng trò chơi.

II.  PHƯƠNG PHÁP:

     -Thực hành nhóm trên máy

III.  CHUẨN BỊ

1. Chuẩn bị của giáo viên: 

· Giáo án,phòng máy phải được cài đặt sẳn phần mềm Typing Test. 

2. Chuẩn bị của học sinh: 

IV.  HOẠT ĐỘNG DẠY  HỌC:

1. Ổn định tổ chức: Kiểm tra sĩ số lớp. (5 phút)

2. Kiểm tra bài cũ: 


3. Giảng bài mới:
	TL
	Nội dung
	Hoạt động của Giáo viên
	Hoạt động của HS

	Hoạt động 1: Thực hành 4 trò chơi  (35 phút)

	
	- Thực hành 4 trò chơi trong SGK. 
	- Chia HS theo nhóm và thực hiện theo trình tự sau:

Lần 1: Trò bong bóng và bảng chữ cái

Lần 2: Đám mây và gõ từ nhanh.

- Nhận xét kết quả qua mỗi trò chơi của từng nhóm
	- Thực hành theo nhóm theo sự hướng dẫn của GV.

	Hoạt động 3: Củng cố (5 phút)

	
	
	- Học bài cũ và tham khảo bài mới.
	


Tiết:   5                                                                                          
Ngày Soạn: 26/8/2012
Tuần: 3                                                                  


Ngày dạy :  04/9/2012


I/ MỤC TIÊU:

a) Kiến thức:

-  Biết được nhu cầu sử dụng bảng tính trong đời sống và trong học tập.

-  Biết được các chức nămg chung của chương trình bàng tính.

-  Biết nhập sữa, xoá dữ liệu.

-  Biết cách di chuyển trên bảng tính.

b) Kỷ năng:

- Nhận biết được các thành phần cơ bảng của màng hình trang tính.

- Hiểu rõ những khái niệm hàng, cột, ô, đỉa chỉ ô tính.
II/ PHƯƠNG PHÁP: 

· Minh hoạ, giảng giải, 

III/ CHUẨN BỊ:

- Chuẩn bị của giáo viên: Giáo án, máy tính.

- Chuẩn bị của học sinh: Sách giáo khoa, đọc trước bài.
IV/HOẠT ĐỘNG DẠY HỌC

1. Ổn định tổ chức: Kiểm tra sĩ số lớp. (5 phút)

2. Kiểm tra bài cũ:


3. Giảng bài mới:

	TL
	Nội dung
	Hoạt động của Giáo viên
	Hoạt động của HS

	Hoạt động 1: Giới thiệu bảng và nhu cầu sử lý thông tin. (15 phút)

	
	1. Bảng và nhu cầu xử lí thông tin dạng bảng:

- Chương trình bảng tính là phần mềm được thiết kế để giúp ghi lại và trình bày thông tin dưới dạng bảng, thực hiện các tính toán cũng như xây dựng các biểu đồ biểu diễn một cách trực quan các số liệu có trong bảng.


	* Mục tiêu:

- Biết được nhu cầu sử dụng bảng tính trong đời sống và trong học tập.

* Cách tiến hành:

- Giáo viên treo bảng tính 1.1; 1.2; 1.3. 

- Giáo viên giới tiệu từng bảng tính.

- Qua những ví dụ về bảng tính. Hãy cho biết bảng tính giúp ích gì trong đới sống và học tập của chúng ta?

- Yêu cầu học sinh nhận xét?

- Giáo viên rút ra kết luận.


	* Học sinh quan sát tranh.

- Học sinh nghe giới thiệu.

- Từng cá nhân trả lời.

- Cá nhân nhận xét câu trả lời của bạn.

 (bảng tính giúp ta ghi lại và trình bày thông tin dưới dạng bảng, thực hiện các phép tính toán cũng như xây dựng biểu đồ biểu diễn một cách trực quan các số liệu có trong bảng)

	Hoạt động 2: Giới thiệu một số chương trình bảng tính. (20 phút)

	
	2 . Chöông trình baûng tính :

a. Maøn hình laøm vieäc : (SGK)
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b . Döõ lieäu :

- Döõ lieäu soá, döõ lieäu vaên baûn

c. Khaû naêng tính toaùn vaø söû duïng haøm coù saün

- Vôùi chöông trình baûng tính, em coù theå thöïc hieän moät caùch töï ñoäng nhieàu coâng vieäc tính toaùn, töø ñôn giaûn ñeán phöùc taïp.
- Caùc haøm coù saün raát thuaän tieän ñeå söû duïng khi tính toaùn.

d. Saép xeáp vaø loïc döõ lieäu

(SGK)

e. Taïo bieåu ñoà 

- CTr baûng tính coøn coù coâng cuï taïo bieåu ñoà (moät trong nhöõng daïng trình baøy DL coâ ñoïng vaø tröïc quan)
	* Mục tiêu:

- Biết được các chức nămg chung của chương trình bàng tính.

* Cách tiến hành:

- Giáo viên giới thiệu màn hình làm việc của bảng tính.

- Giáo viên giới thiệu khả năng tính toán và sử dụng hàm có sẵn.

- Giáo viên giới thiệu cách sắp xếp và lọc dự liệu.

- Giáo viên giới thiệu cách tạo biểu đồ.


	- Học sinh quan sát tranh.

- Cả lớp nghe giới thiệu và ghi nhận.

- Học sinh quan sát tranh.

- Cả lớp nghe giới thiệu và ghi nhận.

- Cá nhân  trả lời.

- Cá nhân nhận xét câu trả lời của bạn.



	Hoạt động 3: Củng cố (5 phút)

	
	
	- Học bài cũ, làm các bài tập trong SGK.
	


Tiết:   6                                                                                                Ngày Soạn: 26/8/2012
Tuần: 3                                                                                                Ngày dạy :  06/8/2012


I/ MỤC TIÊU:

        a) Kiến thức:

- Biết được nhu cầu sử dụng bảng tính trong đời sống và trong học tập.

- Biết được các chức nămg chung của chương trình bàng tính.

- Biết nhập sữa, xoá dữ liệu.

- Biết cách di chuyển trên bảng tính.

b) Kỉ năng:

-Nhận biết được các thành phần cơ bảng của màng hình trang tính.

-Hiểu rõ những khái niệm hàng, cột, ô, đỉa chỉ ô tính.
II/ PHƯƠNG PHÁP:

         -Minh hoạ, thuyết trình, 

III/ CHUẨN BỊ:

-Chuẩn bị của giáo viên: Giáo án, máy tính.

-Chuẩn bị của học sinh: Sách giáo khoa, đọc trước bài.
IV/ HOẠT ĐỘNG DẠY HỌC

1. Ổn định tổ chức: Kiểm tra sĩ số lớp.


2. Kiểm tra bài cũ: H. ? Chương trình bảng tính có những tính năng gì. (5 phút)

3. Giảng bài mới:

	TL
	Nội dung
	Hoạt động của Giáo viên
	Hoạt động của HS

	Hoạt động 1: Giới thiệu màn hình  làm việc của chương trình bảng tính. (10 phút)

	
	3 . Maøn hình laøm vieäc cuûa chöông trình baûng tính :
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- Thanh coâng thöùc : Hieän thò döõ lieäu hoaëc coâng thöùc trong oâ tính

- Baûng choïn : Goàm caùc leänh duøng ñeå xöû lí

- Trang tính : Coät, haøng , oâ tính, khoái.
(Trang tính gồm các cột các hàng là miền làm việc chính của bảng tính. Vùng giao nhau giữa cột và hàng là ô tính dùng để chứa dữ liệu)

+ Ñòa chæ oâ : Teân coät vaø teân haøng

+ Ñòa chæ khoái : Ñòa chæ oâ treân cuøng beân traùi : ñòa chæ oâ döôùi cuøng beân phaûi 
	* Mục tiêu:

-Nhận biết được các thành phần cơ bảng của màn hình trang tính.

-Hiểu rõ những khái niệm hàng, cột, ô, đỉa chỉ ô tính.

* Cách tiến hành:

- Giáo viên giới thiệu các nút lệnh: cột, hàng, địa chỉ ô, khối . . .

- Cho học sinh lên bảng chỉ lại các địa chỉ: cột, hàng, địa chỉ ô, khối.

- Vậy trang tính gồm có những gì?

- Cho lớp nhận xét.

- Giáo viên rút ra kết luận
	- Quan sát MH và ghi vở


	Hoạt động 2: Biết cách nhập, sữa, xoá, di chuyển dữ liệu. (20 phút)

	
	4. Nhaäp döõ lieäu vaøo trang tính :

a. Nhaäp vaø söûa döõ lieäu :

- Choïn oâ vaø ñöa döõ lieäu vaøo.
- Söûa döõ lieäu : Nhaáp ñuùp chuoät vaøo oâ caàn söûa. 

b. Di chuyeån treân trang tính :

C1: Söû duïng phím muõi teân.
C2:Söû duïng chuoät vaø thanh cuoán.

c. Goõ chöõ vieät treân trang tính :

- Goõ chöõ vieät nhö soïan thaûo vaên baûn Word.

	- GV hướng dẫn học sinh cách nhập, sữa, xóa, di chuyển trên máy chiếu.
- Gọi một số HS lên máy thực hành.
	- Quan sát và ghi vở. 
- Thực hiện.

- Một số HS khác nhận xét.

	Hoạt động 3: Củng cố (5 phút)

	
	
	- Nắm được cách nhập, sữa, xóa, di chuyển trên bảng tính.
- Nắm được các vùng trên bảng tính: thanh công thức, thanh tiêu đề,…

- Làm bài tập trong SGK.
	


Tiết:   7 - 8

                                                                             Ngày Soạn: 03/9/2012
Tuần: 4                                                                             

Ngày dạy :  11/9/2012
Bài thực hành 1

LÀM QUEN VỚI CHƯƠNG TRÌNH  BẢNG TÍNH  EXCEL

I - MỤC TIÊU 
a. Kiến thức 

- Biết khởi động và thoạt khỏi Excel.

- Nhận biết các ô, hàng, cột trên trang tính Excel.

b. Kỹ Năng

- Thành thạo các thao tác di chuyển, nhập, sửa DL trên trang tính.
III.  PHƯƠNG PHÁP

- Hoạt động nhóm, hoạt động cá nhân..

III CHUẨN BỊ

- Giáo viên: Giáo trình, phòng máy tính.

- Học sinh: Kiến thức và sách giáo khoa.

IV . TIẾN TRÌNH GIẢNG DẠY
1. Ổn định tổ chức: Kiểm tra sĩ số lớp.


2. Kiểm tra bài cũ: H. ? Ô tính đang được kích hoạt có gì khác biệt so với các ô tính khác. Nêu cách nhập DL. (5 phút)

3. Giảng bài mới:

	TL
	Nội dung
	Hoạt động của Giáo viên
	Hoạt động của HS

	Hoạt động 1: Giới thiệu cách khởi động phần mềm Excel (15 phút)

	
	* Hai cách thường được sử dụng nhất:
- C1: Nháy chuột vào nút Start -> All Programs -> M…Office -> Micro…Office Excel.

- C2: Nháy đúp chuột vào biểu tượng Excel trên màn hình nền.
	* Có nhiều cách khởi động khác nhau. 
- Giới thiệu một số cách khởi động trên máy chiếu.
	- Quan sát và ghi vở.

	Hoạt động 2: Lưu kết quả và thoát khỏi Excel (20 phút)

	
	* Lưu kết quả: Chọn File->Save hoặc nháy vào nút lệnh Save trên thanh công cụ.
* Thoát: Chọn File->Exit hoặc nháy nút dấu X màu đỏ phía trên góc phải bảng tính.
	- Thực hiện thao tác lưu và mở trên máy chiếu.
	- Quan sát và ghi vở.

	Hoạt động 3: Thực hành trên máy tính (45 phút)

	
	* Bài tập 1: Khởi động Excel

(SGK)

* Bài tập 2:

(SGK)

* Bài tập 3: 

(SGK)
	- Cho khoảng 2-3 HS/1 máy.

- Mỗi HS làm lần lượt 3 BT.
	- Thực hành trên máy tính.

	Hoạt động 4: Củng cố (5 phút)

	
	
	- Nhận xét giờ thực hành theo từng nhóm, cho điểm một số nhóm.
- Đọc bài đọc thêm số 1 và đọc trước bài 2.
	- Lắng nghe và thực hiện.


Tiết: 9                                                                             


Ngày Soạn: 10/9/2012
Tuần: 5                                                                    

 
Ngày dạy :  18/9/2012


I. MỤC TIÊU

     a, Kiến thức:

- Biết được các thành phần chính của trang tính: hàng, cột, các ô, hộp tên, khối, thanh côngthức;

- Hiểu vai trò của thanh công thức;

b, Kĩ năng:

- Biết cách chọn một ô, một hàng, một cột và một khối;

- Phân biệt được kiểu dữ liệu số, kiểu dữ liệu kí tự.
III.  PHƯƠNG PHÁP:
· Thuyết trình, Giảng giải
IV.  CHUẨN BỊ:

     - Chuẩn bị của Giáo viên: trang thiết bị ở phòng máy,  2 HS/ máy

     - Chuẩn bị của học sinh:SGK, đọc trước bài .

IV.HOẠT ĐỘNG DẠY HỌC

1. Ổn định tổ chức: Kiểm tra sĩ số lớp.


2. Kiểm tra bài cũ: 


3. Giảng bài mới:

	TL
	Nội dung
	Hoạt động của Giáo viên
	Hoạt động của HS

	Hoạt động 1: Bảng tính

	
	- Một bảng tính có nhiều trang tính. Khi mở 1 bảng tính mới, BT  thường gồm 3 trang tính.
- Để kích hoạt một trang tính, em nháy chuột vào nhãn trang tương ứng.
	- Mở một bảng tính mới cho HS quan sát để nhận biết các trang tính và nhãn của trang tính.
	- Lắng nghe, ghi vở và quan sát hình 13/SGK.

	Hoạt động 2: Các thành phần chính trên trang tính

	
	+ Hộp tên: Là ô ở góc trên, bên trái trang tính, hiển thị địa chỉ của ô được chọn. (VD: A2)
+ Khối: Là một nhóm các ô liền kề nhau tạo thành hình chữ nhật.(có thể là 1 ô, 1 hàng hay 1 phần của hàng or cột)

+ Thanh công thức: chứa nội dung ô được chọn. (VD: =5 + 5)
	- Ngoài các thành phần như hàng, cột và các ô tính. Thì trang tính còn có những thành phần khác. 
- 

- Các em hãy quan sát hình 14 SGK rồi qs trên MH.
	- Lắng nghe và quan sát trên MH.
- Ghi vở

	Hoạt động 3: Củng cố
	
	Hoïat ñoäng 4 : Baøi taäp, củng cố

	
	
	- Học bài cũ .
	


Tiết: 10                                                              


Ngày soạn: 10/9/2012
Tuần: 5                                                            


Ngày  dạy : 20/9/2012


I .MỤC TIÊU:

a, Kiến thức:

· Phân biệt được bảng  tính, trang tính và các thành phần của trang tính.

· Phân biệt các kiểu dữ liệu khác nhau trên ô tính.

b, Kĩ năng:

· Mở và lưu bảng tính trên máy.

· Nhập các dữ liệu khác nhau vào ô tính.
II. PHƯƠNG PHÁP:
· Thảo luận nhóm thực hành
III. CHUẨN BỊ

· Phòng máy( 2 học sinh trên một máy) hoạt động tốt.

· SGK, lưu bảng tính với tên danh Danh sách lớp em (đã làm ở bài thực hành 1)
IV.   HOẠT ĐỘNG DẠY HỌC:

1. Ổn định tổ chức: Kiểm tra sĩ số lớp.


2. Kiểm tra bài cũ: 


3. Giảng bài mới:
	TL
	Nội dung
	Hoạt động của Giáo viên
	Hoạt động của HS

	Hoạt động 1: Cách chọn các đối tượng trên trang tính

	
	* Cách chọn như sau:

- Chọn một ô: đưa con trỏ tới đó và nháy chuột.

- Chọn một hàng hoặc cột: Nháy chuột tại nút tên hàng hoặc cột.

- Chọn một khối: kéo thả chuột từ góc bên này đến góc đối diện biên kia.(ô chọn đầu tiên sẽ là ô được kích hoạt) VD: khi chọn khối thì ô địa chỉ có dang A1:D4

- Chọn trang tính: Nháy chuột vào các nhãn của trang tính, trang tính được chọn tên nhãn sẽ hiện lên màu đậm.

* Muốn chọn nhiều khối khác nhau cùng một lúc, nhấn giữ phím Ctrl rồi lần lượt chọn các khối còn lại.
	- Thực hiện các thao tác chọn các đối tượng trên trang tính để HS quan sát.

? Trong Word em muốn chọn đồng thời nhiều khối thì thực hiện như thế nào.

- Nhận xét ý kiến của HS
	- Quan sát trên MH và ghi vở.

- Trả lời câu hỏi.

- Ghi vở

	Hoạt động 2: Giới thiệu các dạng dữ liệu trên trang tính.

	
	a) Dữ liệu dạng số: 0…9 và dấu -, + chỉ số dương, % chỉ tỉ lệ, dấu chấm dấu phẩy để phân cách.

VD: -124

b) Dữ liệu kí tự: là dãy các chữ cái, chữ số và các kí hiệu.

VD: lớp 7A
	? Hãy nêu các dạng DL mà em biết.

- Nhận xét.

- Em có thể nhập vào các ô của trang tính các dạng DL khác nhau. Sau đây các em làm quen với 2 dạng DL thường dùng.
	- Suy nghĩ và trả lời câu hỏi.

-Ghi vở

	Hoạt động 3: Củng cố

	
	
	- Học bài cũ và làm bài tập trong SGK.
- Chuẩn bị bài thực hành số 2
	


Tiết: 11 - 12


                                                                  Ngày Soạn: 16/9/2012
Tuần: 6                                                                       


Ngày dạy :  25/9/2012
Bài thực hành 2:
 LÀM QUEN VỚI CÁC KIỂU DỮ LIỆU TRÊN TRANG TÍNH

I .MỤC TIÊU:

a, Kiến thức:

            -  Biết nhập dữ liệu vào trang tính.

b, Kĩ năng:

-   Mở và lưu bảng tính trên máy.

-   Nhập các dữ liệu khác nhau vào ô tính.
II. PHƯƠNG PHÁP:

· Thảo luận nhóm thực hành
III. CHUẨN BỊ

-  Phòng máy( 2 học sinh trên một máy) hoạt động tốt.

-  SGK, lưu bảng tính với tên danh Danh sách lớp em (đã làm ở bài thực hành 1)

IV. HOẠT ĐỘNG DẠY HỌC:

1. Ổn định tổ chức: Kiểm tra sĩ số lớp.


2. Kiểm tra bài cũ: 

	
3. Giảng bài mới:
TL
	Nội dung
	Hoạt động của Giáo viên
	Hoạt động của HS

	Hoạt động 1: Giới thiệu một số cách mở và lưu bảng tính.

	
	a) Mở bảng tính:

 * Mở một bảng tính mới hoặc một bảng tính có trong máy:

+ Mở bảng tính mới khác: Nháy chuột lên nút lệnh New trên thanh công cụ.
+ Mở một tệp bảng tính có trong máy: Mở thư mục chứa tệp bảng tính vá nháy đúp lên tệp đó. 

b) Lưu bảng tính với tên khác: 

File -> Save As.


	- Ngoài cách mở và lưu bảng tính mà các em đã được học.

- Thực hiện mở và lưu bảng tính theo cách mới mà các em chưa được học. (trên máy)


	- Lắng nghe và quan sát
- Quan sát và ghi vở 

	Hoạt động 2: Thực hành trên máy

	
	* Bài tập 1: Tìm hiểu các thành phần chính của trang tính.
(SGK)
* Bài tập 2: Chọn các đối tượng trên trang tính.
(SGK)

* Bài tập 3: Mở bảng tính.
(SGK)

* Bài tập 4: Nhập dữ liệu vào trang tính.
(SGK)
	- Hướng dẫn HS thực hành trên máy.
- GV có thể lấy DS của chính lớp đó cho HS thực hành.
- Quan sát từng bài làm của từng máy.
	- Thực hành trên máy các bài tập trong SGK mà Gv đã hướng dẫn.

	Hoạt động 3: Củng cố

	
	
	- Nhận xét từng bài làm của từng máy.
- Tham khảo bài 3 trước ở nhà.
	


Tiết: 13                                                                                 

Ngày Soạn: 24/9/2012
Tuần: 7                                                                              

Ngày dạy :  02/10/2012


I.MỤC TIÊU

   a, Kiến thức

- Biết cách nhập công thức;

- Biết chuyển từ biểu thức toán học thành công thức trên ô tính theo kí hiệu phép toán của bảng tính;

- Biết sử dụng địa chỉ ô tính trong công thức.

    b, Kĩ năng:

- Nhập đúng công thức
II.  PHƯƠNG PHÁP:
  - Giảng giải

III CHUẨN BỊ

· Giáo viên :SGK

· Học sinh: Sách giáo khoa, bút.

IV. HOẠT ĐỘNG DẠY HỌC

1. Ổn định tổ chức: Kiểm tra sĩ số lớp.

      2. Kiểm tra bài cũ: 5’
Câu 1: Hãy nhắc lại các thành phần chính của trang tính là gì?
Câu 2: Hãy cho biết các kiẻu dữ liệu số và kiểu dữ liệu kí tự được phân biệt bằng cách nào?

3. Giảng bài mới:
	TL
	Nội dung
	Hoạt động của Giáo viên
	Hoạt động của HS

	Hoạt động 1: Sử dụng công thức để tính toán

	
	-Khả năng tính toán là một điểm ưu việt của chương trình bảng tính.

[image: image14.emf]3

Bài 3. Thực hiện tính toán trên trang tính

1. Sử dụng công thức để tính toán

Phép toán

Cộng

Trừ

Nhân

Chia

Luỹ thừa

Phần trăm

Toán học

+

-



:

62

%

Chương trình bảng tính

+

-

*

/

6^2

%


- Khả năng ưu tiên các phép toán thực hiện trình tự như sau:

1. Các phép toán trong dấu ngoặc đơn “(“ và “)”.

2. Các phép nâng lên lũy thừa.

3. Các phép nhân và chia.

4. Các phép cộng và trừ.
	· - Gọi HS nhắc lại các phép toán trong toán học mà các em đã được học.
· - GV nhận xét và giới thiệu bài mới.

· +: phép cộng, ví dụ: =13+5

· -:  phép trừ, ví dụ: = 21-7

· *: phép nhân, ví dụ: =3*5

· /: phép chia, ví dụ: =18/2

· ^: phép lấy luỹ thừa, ví dụ: =6^2

· %: phép lấy phần trăm, ví dụ: =6%

(và): dùng để làm gộp các phép toán, ví dụ: =(5+7)/2 
	- Một số HS đứng dậy trả lời.

- Chú ý lắng nghe và quan sát.
- Xem hình 22 trong SGK và ghi vở.

	Hoạt động 2: Nhập công thức

	
	- Dấu = là dấu đầu tiên mà em cần gõ khi nhập công thức vào một ô.
* Các bước nhập công thức trong bảng tính:

B1: Chọn ô cần nhập công thức

B2: Gõ dấu =

B3: Nhập công thức muốn nhập

B4: Nhấn ENTER hoặc nháy chuột vào một ô bất kỳ khác hoặc sử dụng phím mũi tên để di chuyển sang ô khác trên trang tính.


[image: image15.emf]8

Bài 3. Thực hiện tính toán trên trang tính

Bảng dữ liệu của bạn Hoàng

Bảng dữ liệu của bạn Lan

2. Nhập công thức


	- Giới thiệu cách nhập công thức trên trang tính.

- Thực hiện các nhập một số công thức trên trang tính sau đó nháy chuột vào các ô.
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? Hãy quan sát MH và cho nhận xét về các thay đổi trong ô tính và thanh công thức.

- Kết luận lại các nhận xét của các HS.
	- Lắng nghe và quan sát trên MH.
- Quan sát các bước nhập một công thức trên trang tính và nhận xét.

- Ghi vở

- Quan sát MH và nhận xét.

	Hoạt động 3: Củng cố

	
	
	- Học nội dung đã học và đọc nội dụng còn lại trước ở nhà.
	


Tiết: 14                                                                                               
NgàySoạn:  24/9/2012
Tuần: 7                                                                                                
Ngày dạy :  04/10/2012


I.MỤC TIÊU

  a, Kiến thức

- Biết sử dụng địa chỉ ô tính trong công thức.

  b, Kĩ năng:

      - Nhập đúng công thức
II PHƯƠNG PHÁP:
· Giảng giải
III.  CHUẨN BỊ

· Giáo viên :SGK

· Học sinh: Sách giáo khoa, bút.
IV.  HOẠT ĐỘNG DẠY HỌC
1. Ổn định tổ chức: Kiểm tra sĩ số lớp.


2. Kiểm tra bài cũ: 

Câu 1: Hãy nêu các ký hiệu các phép toán trong công thức?

Câu 2: Nêu các bước của việc nhập công thức?


3. Giảng bài mới:
	TL
	Nội dung
	Hoạt động của Giáo viên
	Hoạt động của HS

	Hoạt động 1: Sử dụng địa chỉ trong công thức

	
	- Việc nhập công thức có chứa địa chỉ hoàn toàn giống như nhập các công thức bình thường.
	- Em đã biết địa chỉ của một ô là cặp tên cột và tên hàng mà ô đó nằm trên.
VD: A12, B30, B25

- Tiến hành sử dụng địa chỉ để nhập công thức trên máy chiếu.

? Hãy quan sát trên MH và cho nhận xét cách nhập CT bằng cách sử dụng địa chỉ với cách nhập thông thường.

- Ra một số bài tập và gọi một số HS lên thực hành trên máy của GV, HS còn lại quan sát trên MH.

- Kết luận các bài làm.
	- Lắng nghe và quan sát.
- Quan sát

- Trả lời câu hỏi
- Ghi vở
- Thực hiện, HS còn lại nhận xét bài làm của bạn trên máy.

	Hoạt động 2: Lợi ích của việc sử dụng địa chỉ ô tính trong công thức

	
	- Tự động cập nhật kết quả của phép toán trong công thức khi thay đổi DL các ô tính.
	- Nhập công thức theo 2 cách. Sau đó thay đổi DL trong các ô tính.
	- Quan sát và nhận xét.
- Ghi vở

	Hoạt động 3: Củng cố

	
	
	- Học bài cũ, làm BT 1,2,4 SGK.
- Xem bài mới
	


Tiết: 15 - 16

                                                    Ngày Soạn: 01/10/2012
Tuần: 8                                                                     

        Ngày dạy :  09/10/2012
Bài thực hành 3:
BẢNG ĐIỂM CỦA EM
I.  MỤC TIÊU:

    a, Kiến thức

   -Biết nhập và sử dụng công thức trên trang tính.

    b, Kĩ năng:
              - Nhập đúng, thành thạo khi sư dụng công thức.
II.  PHƯƠNG PHÁP:

              - Thảo luận nhóm thực hành.
III CHUẨN BỊ:

 GV:   - Các máy tính trong phòng máy chạy tốt.
           - SGK đầy đủ.
HS:    - Làm bài tập ở nhà.
IV.  HOẠT ĐỘNG DẠY  HỌC:

1. Ổn định tổ chức: Kiểm tra sĩ số lớp.


2. Kiểm tra bài cũ: ? Hãy nêu lợi ích của việc sử dụng địa chỉ ô tính trong công thức.

3. Giảng bài mới:

	TL
	Nội dung
	Hoạt động của Giáo viên
	Hoạt động của HS

	Hoạt động 1: Kiểm tra 15 phút

	
	- HS khoanh tròn vào câu trả lời đúng
	- GV phát đề .
	

	Hoạt động 2: Giới thiệu cách hiển thị dữ liệu số trong ô tính

	
	- Nếu độ rộng của cột quá nhỏ không hiển thị hết dãy số quá dài, em sẽ thấy các ký hiệu ### trong ô. 
	- Thực hiện nhập DL vào một ô tính cho HS nhận xét kết quả.

- Lúc này cần tăng độ rộng của ô để hiển thị hết các số, em cần điều chỉnh độ rộng cột (sẽ học trong bài sau)
- Điều chỉnh độ rộng của một ô or cột sao cho đủ rộng để hiển thị hết các số.
	- Quan sát và nhận xét kết quả.

	Hoạt động 2: Thực hành trên máy

	
	* Bài tập 1: Nhập công thức.
(SGK)

* Bài tập 2: Tạo trang tính và nhập công thức.

(SGK)

* Bài tập 3: Thực hành lập và sử dụng công thức.

(SGK)

* Bài tập 4: Thực hành lập bảng tính và sử dụng công thức.

(SGK)
	- GV cho lớp chia thành các nhóm

- Giao bài tập  cho các nhóm

- GV quan sát các nhóm thực hành.

- GV yêu cầu 1 nhóm trình bày kết quả của nhóm mình.

- Gọi nhóm khác nhận xét.

- GV viết lên bảng kết quả các công thức.

- Kết luận của GV


	- Thực hành theo nhóm, cá nhóm tự thảo luận và nhập các công thức, sử dụng công thức để tính toán các bài tập trong SGK.
- Sau khi làm xong các nhóm trình bày kq của nhóm mình, các nhóm khác nhận xét.

	Hoạt động 3: Củng cố
	
	

	
	
	- Ôn lại nội dung đã học và xem bài mới.
	


Tiết: 19                                                            


Ngày Soạn: 15/10/2012
Tuần: 10                                                                   

Ngày dạy :  23/10/2012


I.  MỤC TIÊU
   a. Kiến thức
- Biết ý nghĩa của các hàm AVERAGE, SUM, MAX, MIN

- Biết cách sử dụng hàm.

- Biết hai cách nhập hàm vô ô tính.

  b. Kĩ năng

- Viết đúng qui tắt các hàm.


- Sử dụng hàm để tính kết hợp các số và địa chỉ ô tính.


- Thực hiện được bốn hàm AVERAGE, SUM, MAX, MIN (chọn lệnh từ bảng chọn, gõ lệnh từ cửa  sổ lệnh)

 II. PHƯƠNG PHÁP: 


- Giảng giải và thao tác cho HS quan sát trên máy.
III. CHUẨN BỊ
    Giáo viên: 


- Giáo án, máy tính

- Các máy tính trong phòng dạy chạy tốt.

   Học sinh:     - SGK đầy đủ.

                        - Vở ghi chép

IV.   HOẠT ĐỘNG DẠY  HỌC:

1. Ổn định tổ chức: Kiểm tra sĩ số lớp.


2. Kiểm tra bài cũ: 


3. Giảng bài mới:
	TL
	Nội dung
	Hoạt động của Giáo viên
	Hoạt động của HS

	Hoạt động 1: Hàm trong chương trình bảng tính

	
	1. Hàm trong chương trình bảng tính:

- Hàm là công thức được định nghĩa từ trước.

- Hàm được sử dụng để thực hiện tính toán theo công thức với các giá trị dữ liệu cụ thể. Sử dụng hàm giúp việc tính toán dễ dàng và nhanh chóng hơn.
* Sử dụng công thức:

=(8+7+9)/3 hoặc
=(A1+B1+C1)/3

* Sử dụng hàm:

=AVERAGE(8,7,9) hoặc
=AVERAGE(A1+B1+C1)
	? Để tính trung bình cộng của 3 số a, b, c em thực hiện như thế nào.
? Trong chương trình bảng tính, em có biết cách nào khác nửa để có thể giải được bài toán trên. 

- Thực hiện vài ví dụ minh hoạ trên máy để HS quan sát.
	- Suy nghĩ và trả lời

->      =(a+b+c)/3

- Suy nghĩ và trả lời

-> sử dụng địa chỉ của các ô tính.
- Quan sát nội dung SGK
- Quan sát trên màn hình.

- Ghi vở



	Hoạt động 2: Cách sử dụng hàm

	
	2. Cách sử dụng hàm:
* Để nhập hàm vào một ô thực hiện như sau:

B1: Chọn ô cần nhập

B2: Gõ dấu =

B3: Gõ hàm theo đúng cú pháp của nó

B4: Nhấn Enter

* Chú ý: Khi nhập hàm vào một ô tính, giống như với công thức, dấu = ở đầu là kí tự bắt buộc.
	- GV thao tác minh hoạ, HS quan sát và nhận biết.

- GV gọi HS nêu lại cách sử dụng hàm qua thao tác GV vừa làm.
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? Để nhập hàm vào một ô em thực hiện như thế nào.

- GV giới thiệu thêm: Có hai cách nhập hàm vào ô tính:

+ Cách 1: Nhập hàm trực tiếp vào ô tính.

+ Cách 2: Sử dụng nút lệnh Insert Function 
[image: image18.png]



	- Lắng nghe và quan sát
- Suy nghĩ và trả lời

- Ghi vở



	Hoạt động 3: Củng cố

	
	
	- Về nhà học lại cách sử dụng hàm và tham khảo phần tiếp theo.
	


Tiết: 20                                                            


Ngày Soạn: 15/10/2012
Tuần: 10                                                                   

Ngày dạy :  27/10/2012


I.  MỤC TIÊU
   a. Kiến thức
- Biết ý nghĩa của các hàm AVERAGE, SUM, MAX, MIN

- Biết cách sử dụng hàm.

- Biết hai cách nhập hàm vô ô tính.

  b. Kĩ năng

- Viết đúng qui tắt các hàm.


- Sử dụng hàm để tính kết hợp các số và địa chỉ ô tính.


- Thực hiện được bốn hàm AVERAGE, SUM, MAX, MIN (chọn lệnh từ bảng chọn, gõ lệnh từ cửa  sổ lệnh)

 II. PHƯƠNG PHÁP: 


- Giảng giải và thao tác cho HS quan sát trên máy.

III. CHUẨN BỊ
    Giáo viên: 


- Giáo án, máy tính

- Các máy tính trong phòng dạy chạy tốt.

   Học sinh:     - SGK đầy đủ.

                        - Vở ghi chép

IV.   HOẠT ĐỘNG DẠY  HỌC:

1. Ổn định tổ chức: Kiểm tra sĩ số lớp.


2. Kiểm tra bài cũ: 


? Trong chương trình bảng tính, để nhập hàm vào một ô em thực hiện như thế nào.

3. Giảng bài mới:
	TL
	Nội dung
	Hoạt động của Giáo viên
	Hoạt động của HS

	Hoạt động 1: Một số hàm trong chương trình bảng tính

	10
10

10

10
	a) Hàm tính tổng: (SUM)
- Hàm tính tổng của một dãy các số có tên là SUM.
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=Average(C4:F4)
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=AVERAGE(C4,7,E4:F4)

Câu 1:

Để tính điểm tổng kết ở ô G4, thì cách nhập hàm nào sau đây là

không đúng?


- Hàm SUM được nhập vào ô tính như sau: =SUM(a,b,c,…)
Trong đó các biến a, b, c,…là các số hay địa chỉ của các ô tính được đặt cách nhau bởi dấu phẩy. Tên hàm không phân biệt chữ hoa hay chữ thường. Số lượng các biến là không hạn chế.
VD: =SUM(4,5,6) cho kết quả 15

=SUM(A2,D5)

b) Hàm tính trung bình cộng: (AVERAGE)

- Hàm tính trung bình cộng của một dãy các số có tên là AVERAGE.
- Hàm AVERAGE được nhập vào ô tính như sau: =AVERAGE(a,b,c,…)

Trong đó các biến a, b, c,… là các số hay địa chỉ của ô cần tính.

c) Hàm xác định giá trị lớn nhất: (MAX)

- Hàm xác định giá trị lớn nhất của một dãy số có tên là MAX.

- Hàm MAX được nhập vào ô tính như sau: =MAX(a,b,c,…)

Trong đó các biến a, b, c,… là các số hay địa chỉ của ô cần tính.

d) Hàm xác định giá trị nhỏ nhất: (MIN)
- Hàm xác định giá trị nhỏ nhất của một dãy số có tên là MIN.

- Hàm MIN được nhập vào ô tính như sau: =MIN(a,b,c,…)

Trong đó các biến a, b, c,… là các số hay địa chỉ của ô cần tính.
	? Nêu qui tắc sử dụng hàm tính tổng trong bảng tính?

GV nhận xét cách trình bày của các nhóm.

GV lưu ý cho HS: Các số hay địa chỉ của các ô cần tính liệt kê trong dấu () và cách nhau bởi dấu phẩy,  tên hàm không phân biệt chữ hoa hay chữ thường.

? Nêu qui tắc sử dụng hàm tính trung bình cộng trong bảng tính?

GV nhận xét cách trình bày của các nhóm.

? Nêu qui tắc sử dụng hàm tính xác định giá trị lớn nhất trong bảng tính?

GV nhận xét cách trình bày của các nhóm.

? Nêu qui tắc sử dụng hàm tính xác định giá trị nhỏ nhất trong bảng tính?

GV nhận xét cách trình bày của các nhóm.
	Nhóm 1: Đọc ví dụ 1 (SGK)

Nhóm 2: Đọc ví dụ 2 (SGK)

Nhóm 3: Đọc ví dụ 3 (SGK)

( Các nhóm trình bày qui tắc sử dụng hàm tính tổng trong bảng tính.

Nhóm 1: 

Đọc ví dụ 1 (SGK)

Nhóm2: 
Đọc ví dụ 2 (SGK)

( Các nhóm trình bày qui tắc sử dụng hàm tính trung bình cộng trong bảng tính.

Nhóm 3:
Đọc ví dụ 1 (SGK)

Nhóm 1:
Đọc ví dụ 2 (SGK)

( Các nhóm trình bày qui tắc sử dụng hàm xác định giá trị lớn nhất  bảng tính.

Nhóm 2:
Đọc ví dụ 1 (SGK)

Nhóm 3:
Đọc ví dụ 2 (SGK)

( Các nhóm trình bày qui tắc sử dụng hàm xác định giá trị nhỏ nhất  bảng tính.

	Hoạt động 2: Bài tập

	
	* Bài tập 1,2,3 SGK trang 31.
	Mục tiêu: Hệ thống kiến thức toàn bài 

Cách tiến hành: 

 HS thảo luận nhóm và trình bày kết quả, GV nhận xét kết quả trình bày của các nhóm.

Nhóm 1 Làm bài 1

Nhóm 2: Làm bài 2

Nhóm 3: Làm bài 3         
	HS thảo luận nhóm và trình bày kết quả

Câu 1: Đáp án: c

Câu 2: Đáp án: d

Câu 3: Đáp án:

a/ -1     b/2      c/-6

d/1       e/1       f/1

	Hoạt động 3: Củng cố

	
	
	- Về nhà học thuộc các hàm và cách sử dụng các hàm trong CT bảng tính.

- Xem nội dung thực hành bài số 4.
	


Tiết: 21                                                                     


 Ngày Soạn: 22/10/2012
Tuần: 11                                                                            
 
 Ngày dạy :  30/10/2012


I. MỤC ĐÍCH
a. Kiến thức:


Biết nhập các công thức và hàm vào ô tính.


Biết sử dụng các hàm SUM, AVERAGE, MAX, MIN

b. Kỹ năng:


Thực hiện thành thạo, chính xáII.  nhanh nhẹn công thức hoặc các hàm vào bài tập.

II. PHƯƠNG PHÁP:

- Thảo luận nhóm thực hành máy.

III.  CHUẨN BỊ:

1. Chuẩn bị của GV: 


- Giáo án, SGK. Máy tính (02 hs/ máy), Các máy tính đã nối mạng cục bộ.

2. Chuẩn bị của HS:


Kiến thức đã học ở tiết trướII.  tập, viết, SGK đầy đủ.

IV.  HOẠT ĐỘNG DẠY  HỌC:


	HOẠT ĐỘNG CỦA THẦY
	HOẠT ĐỘNG CỦA TRÒ
	NỘI DUNG

	                                             Hoạt động 1: Nhắc lại kiến thức cũ:

	Cách nhập công thức

Cách nhập hàm

Nhận xét,cho điểm

Gọi hs đọc tên hàm tính trung bình, xác định giá trị lớn nhất, giá trị nhỏ nhất.
	Hs trả lời

Hs trả lời 

Các nhóm còn lại theo dõi,nhận xét

Trả lời
	
[image: image20.emf]3

Bài thực hành 4: Bảng điểm của lớp em

Các cách nhập hàm nào sau đây là không đúng?

a. = SUM(5, A3, B1)

b. =Sum(5, A3, B1)

c. =sum(5, A3, B1)

d. =Sum    (5, A3, B1)

Để nhập hàm vào trong ô tinh thì:

2. Gõ dấu

=

3. Gõ hàm theo đúng cú pháp

4. Nhấn Enter

1. Chọn ô tính



	                                                             Hoạt động 2: Bài tập 1:

	Mở SGK và đọc yêu cầu của đề 

Yêu cầu các nhóm mở BT1 đã lưu ở bài thực hành trước và nhập vào các cột điểm như trong SGK

Sau khi nhập xong cho các nhóm tiến hành tự tìm cách làm câu b, II.  d

Chọn đại diện bài làm của một nhóm, trình chiếu kết quả cho các nhóm khác theo dõi

Nhận xét và ghi đểm bài làm của nhóm
	Các nhóm thực hiện yêu cầu

Các nhóm tiến hành hoạt động tìm kết quả

Theo dõi và nhận xét 

Ghi nhận
	Bài tập 1 (trang34): lập trang tính và sử dụng công thức.
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Bài thực hành 4: Bảng điểm của lớp em

Bài 1: Mở bảng tính “Bang diem lop em” (Bài thực hành 1) rồi làm theo yêu

cầu sau:

- Nhập điểm thi các môn như hình bên.

- Ghi bảng tính với tên: “Bang diem lop em”

- Tính điểm trung bình của từng bạn trong lớp.




	HĐ 3: Bài tập 2:

	Đọc và thực hiện yêu cầu bài tập 2

Quan sát và lại một nhóm bất kỳ yêu cầu một HS trong nhóm tính chiều cao trung bình

Nhận xét ghi điểm

Chọn đại diện bài làm của một nhóm, trình chiếu kết quả cho các nhóm khác theo dõi

Nhận xét và ghi đểm bài làm của nhóm
	HS thực hiện

Ghi nhận

Theo dõi và nhận xét cách

Ghi nhận
	Bài tập 2(trang 35)
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Bài thực hành 4: Bảng điểm của lớp em

Bài 2: Mở bảng tính “So theo doi the luc” đã được lưu trong bài tập 4, 

bài thực hành 2.

1.

Tính chiều cao trung bình

2.

Tính cân nặng trung bình

3.

Lưu trang tính




V. _DẶN DÒ


Xem lại bài tập 1,2


Chuẩn bị bài tập 3,4

Tiết: 22                                                                     


 Ngày Soạn: 22/10/2012
Tuần: 11                                                                            
 
 Ngày dạy :  30/10/2012


I. MỤC ĐÍCH
a. Kiến thức:


Biết nhập các công thức và hàm vào ô tính.


Biết sử dụng các hàm SUM, AVERAGE, MAX, MIN

b. Kỹ năng:


Thực hiện thành thạo, chính xáII.  nhanh nhẹn công thức hoặc các hàm vào bài tập.

II. PHƯƠNG PHÁP:

- Thảo luận nhóm thực hành máy.

III.  CHUẨN BỊ:

 GV: 


- Giáo án, SGK. Máy tính (02 hs/ máy), Các máy tính đã nối mạng cục bộ.

 HS:


Kiến thức đã học ở tiết trước.  tập, viết, SGK đầy đủ.

IV.  HOẠT ĐỘNG DẠY  HỌC:

	HOẠT ĐỘNG CỦA THẦY
	HOẠT ĐỘNG CỦA TRÒ
	NỘI DUNG

	                   Hoạt động 1: Bài tập 3:Đọc và thực hiện yêu cầu bài tập 3

	Quan sát các nhóm thực hành.

Lại một nhóm bất kỳ và yêu cầu 1 HS trong nhóm làm câu b).

Nhận xét ghi điểm

Chọn một HS nhóm khác làm câu c).

Nhận xét ghi điểm

Chọn đại diện bài làm của một nhóm, trình chiếu kết quả cho các nhóm khác theo dõi

Nhận xét và ghi đểm bài làm của nhóm


	Nhóm thực hiện

Nhóm thực hiện

HS thực hiện

Ghi nhận

HS thực hiện

Ghi nhận

Theo dõi và nhận xét 

Ghi nhận
	Bài 3 (trang 35): Sử dụng hàm

[image: image23.emf]8

Bài thực hành 4: Bảng điểm của lớp em

Bài 3: Sử dụng hàm AVERAGE, MIN, MAX

a. Sử dụng hàm tính lại điểm trung bình đã tính trong bài tập 1. So sánh với

cách tính bằng công thức.



[image: image24.emf]10

Bài thực hành 4: Bảng điểm của lớp em

Bài 3: Sử dụng hàm AVERAGE, MIN, MAX

Sử dụng hàm AVERAGE để tính điểm trung bình từng môn của cả

lớp trong dòng “Điểm trung bình các môn”




	                                                           Hoạt động 2: Bài tập 4:

	Đọc và nhập nội dung bài tập 4, sau đó lưu lại với tên “Gia tri san xuat”

Quan sát các nhóm thực hành.

Giải thích kỹ yêu cầu của đề.

Lại một nhóm bất kỳ và yêu cầu 1 HS trong nhóm tính Tổng giá trị sản xuất của vùng theo từng năm

Nhận xét ghi điểm

Chọn một HS nhóm khác tính trung bình cho ngành nông nghiệp

Nhận xét ghi điểm

Chọn đại diện bài làm của một nhóm, trình chiếu kết quả cho các nhóm khác theo dỡi

Nhận xét và ghi đểm bài làm của nhóm
	Nhóm thực hiện

Theo dõi

HS thực hiện

Ghi nhận

HS thực hiện

Ghi nhận

Theo dõi và nhận xét 

Ghi nhận
	Bài 4(trang 35):  Lập trang tính  và sử dụng hàm

[image: image25.emf]12

Bài thực hành 4: Bảng điểm của lớp em

Bài 4: Sử dụng hàm SUM.

Giả sử chúng ta có các số liệu thống kế sau.




V.  DẶN DÒ

- Về nhà học kỹ lại các hàm SUM, AVERAGE, MAX, MIN

- Làm lại bài tập trên giấy bằng tay.

Tiết: 23                                                                                               Ngày Soạn: 29/10/2012
Tuần: 12                                                                                             Ngày dạy :  06/11/2012


I.  MỤC TIÊU

a. Kiến thức
-  Hướng dẫn cho HS cách điều chỉnh độ rộng của cột và chiều cao của hàng, đồng thời giới thiệu khi nào thì  thêm cột, thêm hàng hoặc xoá cột, xoá hàng.

b. Kỹ Năng
-  HS biết cách điều chỉnh độ rộng của cột và chiều cao của hàng và biết thêm cột, thêm hàng hoặc xoá cột, xoá hàng.

II. PHƯƠNG PHÁP

- GV giải đáp, hướng dẫn.

III -  CHUẨN BỊ
1. Giáo viên: Giáo trình, phòng máy, bảng phụ.

2. Học sinh: Học và chuẩn bị bài ở nhà. 

  IV -  HOẠT ĐỘNG DẠY HỌC
	HOẠT ĐỘNG CỦA THẦY
	HOẠT ĐỘNG CỦA TRÒ
	NỘI DUNG

	Hoạt động 1:Điều chỉnh độ rộng của cột và độ cao của hàng

	GV: Đưa tình huống: khi nhập vào trang tính xuất hiện các trường hợp như hình minh hoạ. (GV treo bảng phụ).

  + Cột Họ Tên và cột điểm trung bình quá hẹp.

+ Dòng quá hẹp

- GV thao tác các tình huống vừa đưa ra và cách giải quyết.

- Yêu cầu HS tự tạo ra tình huống và thao tác nhiều lần.


	- HS quan sát trên bảng phụ.

- HS quan sát, ghi chép và thực hành trên máy.


	1. Điều chỉnh độ rộng của cột và độ cao của hàng
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- Đưa con trỏ vào vạch ngăn cách 2 cột hoặc hai dòng.

- Kéo thả sang phải, trái/lên, xuống để mở rộng hoặc thu hẹp độ rộng hoặc chiều cao theo ý muốn.

* Chú ý: Nháy đúp chuột trên vạch phân cách cột hoặc hàng sẽ điều chỉnh độ rộng 

cột, độ cao hàng vừa khít với dữ liệu có trong cột và hàng đó.

	
	
	

	                                        Hoạt động 2: Chèn thêm hoặc xoá cột và hàng

	- GV đưa ra tình huống cần phải chèn thêm cột hoặc hàng trên màn chiếu. (Chèn thêm cột Giới tính bên cạnh cột Họ tên)

- Chèn thêm một hành để tạo khoảng cách như hình minh hoạ.

- GV giới thiệu cách làm bằng menu lệnh hoặc dùng chuột, hoặc dùng bàn phím.

- Chú ý: Khi xoá cột hoặc xoá hàng, các cột bên phải được đẩy sang trái, các hàng phía dưới được đẩy lên trên.
	- HS ghi chép và thao tác trên máy tính của mình


	2. Chèn thêm hoặc xoá cột và hàng

a) Chèn thêm cột hoặc hàng
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+ Để chèn thêm cột:

- Chọn một cột

- Insert(Columns
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+ Để chèn thêm hàng:

- Chọn một hàng

- Insert( Rows

b) Xoá cột hoặc hàng

- Chọn cột hoặc hàng cần xoá
- Chuột phải ( Delete


V.  DẶN DÒ



- Thực hành trên máy nếu có điều kiện

- Làm bài tập 1, 2 SGK/Tr.44

Tiết: 24                                                                                               Ngày Soạn: 29/10/2012
Tuần: 12                                                                                             Ngày dạy :  06/11/2012


I -  MỤC TIÊU

a. Kiến thức
 
-  Hướng dẫn cho HS cách sao chép và di chuyển dữ liệu, sao chép công thức.

b. Kỹ Năng
-  HS biết làm và làm tốt các thao tác đối với các kiến thức trên.

II - PHƯƠNG PHÁP

-  GV giải đáp, hướng dẫn.

III -  CHẨN BỊ
 Giáo viên: Phòng máy, giáo trình.

 Học sinh: Học và chuẩn bị bài ở nhà.

IV -  HOẠT  ĐỘNG DẠY HỌC

	HOẠT ĐỘNG CỦA THẦY
	HOẠT ĐỘNG CỦA TRÒ
	        NỘI DUNG

	
                                 Hoạt động 1: Kiểm tra bài cũ:

	HS1. Nêu cách điều chỉnh độ rộng của cột và chiều cao của hàng? Thao tác cụ thể trên máy tính

HS2.  Nêu cách thêm, bớt 1 cột hoặc 1 hàng? Thao tác cụ thể trên máy tính

GV : nghe học sinh trình bày và cách thao tác trên máy tính ( Nhận xét và cho điểm.
	HS trả lời


	

	                                                               Hoạt động 2: 
Sao chÐp vµ di chuyÓn d÷ liÖu

	GV: Đưa tình huống cần sao chép dữ liệu trong một ô hoặc một khối ô. 
	- HS quan sát trên màn chiếu


	3, Sao chép và di chuyển dữ liệu

	- Chèn thêm một hành để tạo khoảng cách như hình minh hoạ.

- GV thao tác cụ thể cách sao chép nhiều lần cho HS quan sát.

- GV giới thiệu cách làm bằng menu lệnh hoặc dùng chuột, hoặc dùng bàn phím.

- Di chuyển nội dung của ô tính khác với sao chép nội dung của ô tính ( GV lấy VD cho HS quan sát sự khác nhau) ( Khi di chuyển nội dung thì đến ô tính khác thì nội dung ở ô ban đầu sẽ bị xoá
GV yêu cầu HS thao tác nhiều lần việc sao chép và di chuyển trên bảng tính.

- Chú ý: Khi xoá cột hoặc xoáhàng, các cột bên phải được đẩy sang trái, các hàng phía dưới được đẩy lên trên.


	- HS quan sát, ghi chép và thực hành trên máy.

- HS ghi chép và thao tác trên máy tính của mình

HS: Thực hành

theo cặp.
	a) Sao chép nội dung ô tính

(Sử dụng các nút lệnh: Copy, Cut, Paste)

- Chọn ô hoặc khối ô có thông tin cần sao chép.

- Nháy nút Copy trên thanh công cụ.

- Chọn ô cần đưa thông tin được sao chép vào.

- Nháy nút Paste trên thanh công cụ.

b) Di chuyển nội dung ô tính

- Chọn ô hoặc các ô thông tin cần chuyển.

- Nháy nút Cut trên thanh công cụ
- Chọn ô cần đưa thông tin di chuyển đến.

- Nháy nút Paste trên thanh công cụ.

	                                                      Hoạt động 3:  Sao chép công thức

	- Xét VD: (GV minh hoạ trên màn chiếu tương tự như hình bên)Ô A5 có số 200

Ô D1 có số 150

B3 có công thức = A5+D1


	
	4. Sao chép công thức

a) sao chép nội dung các ô có công thức



	-> Nếu sao chép công thức ở ô B3 và dán vào ô C6 ta thấy trong ô C6 có công thưc = B8+E4 ( Tức là công thức đã bị điều chỉnh)

Như vậy: 

+ ở hình 1, A1 và D5 được xác định quan hệ tương đối về vị trí của các địa chỉ trong công thức so với ô B3

+ Trong hình 2, ở ô đích C6, sau khi sao chép, quan hệ tương đối về vị trí này được giữ nguyên bằng việc điều chỉnh A5 thành B8 và D1 thành E4.
	HS: Thực hành theo hướng dẫn của GIV/

HS: Thực hành theo cặp.

HS: Thực hành theo hướng dẫn của giáo viên.
	[image: image29.png]E3 Microsoft Excel - Book1 =]l

i3] He gt vew st Fomat

Tools

Data

window

Help

HANEA NERE =R AR NN - R A RN R 1 )

B3 - £ =A5+D1

: el

.10 .\.1 U=

=58 %

5

Alel ¢

H

J

K L

M

200

1
2

3 350]
1
5
6
7
8

ES)

150

i« < » n\sheet1(Sheet2 { Shesta
Ready





[image: image30.png]B3 Microsoft Excel - Book1

Edt Vew Inset Fomat Took Data Window Hep Type aquestionforhel < = @ X

SRIVE| S DB S0 -0 8 = 8] F] M P 100%

Ele

&

A

350

500

1

2

3

4

5 200

| 600]
7
8

100

33
i< wh\sheet1 (sheetz { Shests I ] >
Roady o





- Khi sao chép một ô có nội dung là công thức chứa địa chỉ, các địa chỉ được điều chỉnh để giữ nguyên quan hệ tương đối về vị trí so với ô đích.

b) Di chuyển nội dung các ô có công thức

- Ta có thể di chuyển bằng các nút lệnh Cut và Paste và các địa chỉ trong công thức không bị điều chỉnh (công thức được sao chép y nguyên).




V.  DẶN DÒ

- Thực hành trên máy nếu có điều kiện

Tiết: 25                                                                         
              Ngày Soạn: 05/11/2012
Tuần: 13                                                                    
              Ngày dạy :  13/11/2012


I. MỤC TIÊU:

a. Kiến thức:

· Biết các thao tác điều chỉnh độ rộng của cột, độ cao của hàng, chèn xoá hàng,cột của trang tính.

b. Kỹ năng:

· Thực hiện được các thao tác điều chỉnh độ rộng của cột, độ cao của hàng, chèn xoá hàng,cột của trang tính.

· Thực hiện được các thao tác sao chép, di chuyển dữ liệu, công thức.

II. PHƯƠNG PHÁP

· Thực hành nhóm tên máy.

III.CHUẨN BỊ :

Gv: 

 - Gv chuẩn bị các tệp tin: Bảng điểm lớp em, sổ theo dõi thể lực trên máy tính. Máy chiếu

 Hs:

· Sgk, học kỹ nội dung bài lý thuyết “Trang tính của em”, Xem trước nội dung của bài thực hành .

IV.HOẠT ĐỘNG DẠY HỌC

· GV kết hợp lấy điểm 15 phút trong tiết thực hành

	HOAïT ĐỘNG CỦA THẦY
	HOAïT ĐỘNG CỦA TRÒ
	NỘI DUNG

	Hoạt động 1: Điều chỉnh độ rộng của cột, độ cao của hàng, chèn hàng,cột sao chép và di  chuyển dữ liệu.

	  Mục đích: Thực hiện được các thao tác điều chỉnh độ rộng của cột, độ cao của hàng, chèn hàng,cột, sao chép, di chuyển dữ liệu.

Cách thực hiện:

· Gv chia lớp thành các nhóm.

· Gv yêu cầu các nhóm thảo luận và thực hiện nội dung thực hành bài tập 1.

· Gv đánh giá, nhận xét cho 1 hoặc 2 nhóm.

Gv lưu ý cho Hs:
	
	Bài tập 1 (SGK)

a, Chèn them cột trống vào trước cột D

b, Chèn them hàng trống và điều chỉnh độ rộng cột, cao hàng



	· Ở câu b/ trang tính luôn chèn hàng mới lên phía trên của hàng được chọn.

· Khi sao chép có thể sử dụng lệnh Coppy trước mỗi lần dùng lệnh Paste hoặc Dùng Coppy một lần  rồi nháy lệnh Paste cho các ô đích.

· Việc di chuyển cột D (Tin học) thì dùng lệnh Cut và khi chuyển sang cột mới phải chọn ô tính đầu tiên của cột mới rồi nháy lệnh Paste (Nếu không máy sẽ báo lỗi). Nếu chỉ chọn nội dung (từ ô D6       D16) dùng lệnh Cut thì phải chọn ô cùng hàng 6 tại cột mới (VD:G6) rồi nháy lệnh Paste.


	-Hs làm việc theo nhóm: thảo luận, thực hành, nhận xét đánh giá.


	

	V.  DẶN DÒ

- Thực hành trên máy nếu có điều kiện

Tiết: 26                                                                         
              Ngày Soạn: 05/11/2012
Tuần: 13                                                                    
              Ngày dạy :  13/11/2012


I. MỤC TIÊU:

a. Kiến thức:

· Biết các thao tác sao chép, di chuyển dữ liệu, công thức.

b. Kỹ năng:

· Thực hiện được các thao tác điều chỉnh độ rộng của cột, độ cao của hàng, chèn xoá hàng,cột của trang tính.

· Thực hiện được các thao tác sao chép, di chuyển dữ liệu, công thức.

II. PHƯƠNG PHÁP

· Thực hành nhĩm tên máy.

III .  CHUẨN BỊ :

Gv: Gv chuẩn bị các tệp tin: Bảng điểm lớp em, sổ theo dõi thể lực trên máy tính.

Hs:Sgk, học kỹ nội dung bài lý thuyết “Trang tính của em”, Xem trước nội dung của bài thực hành .

IV HOẠT ĐỘNG DẠY HỌC

HOẠT ĐỘNG CỦA THẦY

HOẠT ĐỘNG CỦA TRỊ
NỘI DUNG

                  Hoạt động 1: Thực hành sao chép và di chuyển công thức và dư õliệu.

         Mục đích: Hs  thực hiện được các thao tác sao chép, di chuyển dữ liệu, công thức.

        Cách thực hiện: 

-Gv yêu cầu Hs của các nhóm thự hành bài tập 3 câu a, b, c và phát phiếu học tập cho mỗi nhóm.

-Gv thu các phiếu học tập và nhận xét chung.

          Hoạt động 3: Thực hành chèn và điều chỉnh độ rộng cột, độ cao hàng và nhập thêm dữ liệu vào cho cột vừa chèn thêm.

          Mục tiêu: Thực hiện được các thao tác điều chỉnh độ rộng của cột, độ cao của hàng, chèn hàng,cột, nhập dữ liệu vào cột mới chèn.

           Cách thực hiện: 

-Gv yêu cầu các 

nhóm thảo luận và thực hiện nội dung thực hành bài tập 1.

-Gv đánh giá, nhận xét cho các nhóm.

-Hs làm việc theo nhóm trên máy và trên phiếu học tập.

-Các nhóm nhận xét đánh giá lẫn nhau.

   - Hs làm việc theo nhóm: thảo luận, thực hành, nhận xét đánh giá.

Bài tập 3 (SGK) 

Thực hành sao chép và di chuyển cơng thức và dữ liệu

- Tạo trang tính như hình 50 SGK

        Nội dung phiếu học tập:

PHIẾU HỌC TẬP( Bài tập 3 Sgk trang 47)

1. Viết các hàm hoặc công thức thích hợp trong ô D1 để tính tổng các số trong các ô A1, B1, C1.

2. Sau khi sao chép công thức trong ô D1 vào các ô D2, E1, E2, và E3. Quan sát các kết quả nhận được và giải thích.

3. Sau khi di chuyển công thức trong ô D1 vào ô G1 và công thức trong ô D2 vào ô G2. Quan sát kết quả nhận được và rút ra nhận xét của em.

V .  DẶN DÒ
-Thực hành lại bài tập 1



	Tiết: 27                                                                           
              Ngày Soạn: 12/11/2012
Tuần: 14                                                                    
              Ngày dạy :  22/11/2012


I. MỤC TIÊU

a. Kiến thức
                -  Kiểm tra việc nắm bắnt kiến thức của học sinh và việc sử dụng các hàm để tính toán.

b. Kỹ Năng
               -  Thực hiện được các phép toán bằng cách sử dụng hàm, công thức.

II. PHƯƠNG PHÁP


                -Thực hành theo nhóm – GV giải đáp, hướng dẫn.

III -  CHUẨN BỊ
1. Giáo viên: Giáo trình, phòng máy, bảng phụ.

2. Học sinh: Học và chuẩn bị bài ở nhà.


IV -  HOẠT ĐỘNG  DẠY HỌC


       HOẠT ĐỘNG CUÛA THAÀY

HOẠT ĐỘNG CUÛA TROØ

NỘI DUNG

                                           Hoạt động 1: Sử dụng cụng thức (20 phút)
GV: Ra yêu cầu đề bài.

GV : Gọi 1 học sinh lên bảng, chuyển các côgn thức sang dạng bảng tính.

- Yêu cầu học sinh mở máy và làm bài.

GV: Đưa ra kết quả:

a) 56.12

b) .....57

c) -706

d) 4425.143 

HS : Ghi chép.

HS : Trả bài.

HS : Làm bài tập trên máy.

HS: So sánh kết quả, sửa nếu sai.

1. Bài 1

Sử dụng công thức tính các giá trị sau

a) 152 :4

b) (2 + 7)2: 7

c) (32 -   7)2 -  (6 + 5)3

d) (188 -   122) :7

                                               Hoạt động 2: Sử dụng hàm (20’)
GV: Ra yªu cÇu bµi 2 trªn b¶ng phô.

- H­íng dÉn häc sinh c¸c c¸ch lµm cña tõng phÇn yªu cÇu.

* Gîi ý:

HS sö dông c¸c hµm sau:

SUM 

AVERAGE

MAX

MIN

HS: Quan s¸t vµ l¾ng nghe h­íng dÉn.

-  Thùc hµnh trùc tiÕp trªn m¸y tÝnh.

2. Bµi 2

Cho b¶ng d÷ liÖu:

B¶ng ®iÓm líp 7A

2

Stt

Hä tªn

To¸n

Tin

NV

T§

§TB

3

1

An

8

7

8

?

?

4

2

B×nh

10

9

9

?

?

5

3

Kh¸nh

8

6

8

?

?

6

4

V©n

7

8

6

?

?

7

5

Hoa

9

9

9

?

?

a) Sö dông c¸c hµm ®Ó tÝnh T§, §TB cña c¸c häc sinh trªn.

b) Sö dông hµm Max, Min ®Ó tÝnh T§, §TB lín nhÊt, nhá nhÊt.

c) §iÒu chØnh ®é réng cña hµng vµ cét cho phï hîp.

d) Thª cét Lý vµ cho ®iÓm vµo. NhËn xÐt g× vÒ kÕt qu¶ tæng ®iÓm?

   V.   DẶN DÒ: (5’)
- Thực hành trên máy nếu có điều kiện.

- Chuẩn bị cho bài kiểm tra thực hành.




Tiết: 28                                                                           
              Ngày Soạn: 20/11/2012
Tuần: 14                                                                    
              Ngày dạy :  27/11/2012


I/ MỤC TIÊU:
· Đánh giá kiến thứ II.  kỹ năng của học sinh về: các thành phần cơ bản trên trang tính.Excel, cách thiết đặt các biểu thức tính toán, cách sử dụng các hàm.

II/ YÊU CẦU ĐỀ:
1. Kiến thức:
  Kiểm tra kiến thức học sinh về: 

Biết nhập liệu, di chuyển vào trang tính.

Biết nhập các công thức và hàm vào ô tính

Biết sử dụng các hàm: SUM, AVERAGE, MAX, MIN

2. Kỹ năng:

Thiết đặt công thức tính toán đúng, vận dụng các hàm cơ bản để tính toán.

Tiết: 29


                                                       Ngày Soạn: 26/11/2012
Tuần: 15                                                                   

Ngày dạy :  04/12/2012


I.  MỤC TIÊU
   a. Kiến thức
- Nhận biết và phân biệt được các màn hình chính và các chức năng chính của phần mềm.
  b. Kĩ năng

- Thực hiện được một số lệnh chính từ hộp thoại và từ dòng lệnh.

- Sử dụng một số tính năng của phần mềm học tập.

 II. PHƯƠNG PHÁP: 


- Giảng giải và thao tác cho HS quan sát trên máy.

III. CHUẨN BỊ
    Giáo viên: 


- Giáo án, máy tính, cài đặt phần mềm lên các máy tính trong phòng vi tính.
- Các máy tính trong phòng dạy chạy tốt.

   Học sinh:     

- SGK đầy đủ.

         - Vở ghi chép

IV.   HOẠT ĐỘNG DẠY  HỌC:

1. Ổn định tổ chức: Kiểm tra sĩ số lớp. (5 phút)

2. Kiểm tra bài cũ: 


3. Giảng bài mới:

	NỘI DUNG
	HOẠT ĐỘNG GV VÀ HS

	Hoạt động 1: Giới thiệu PM và cách khởi động PM (15 phút)

	1. Giới thiệu phần mềm:

- Toolkit Math (tên đầy đủ là Toolkit for Interactive Mathematics (TIM) – có nghĩa là công cụ tương tác học toán) là một phần mềm học toán đơn giản nhưng rất hữu ích cho học sinh ở các lớp cấp THCS. PM được thiết kế như một công cụ hỗ trợ giải bài tập, tính toán và vẽ đồ thị.

2. Khởi động phần mềm:

- Nháy đúp lên biểu tượng (TIM) trên màn hình nền.
- Nháy chuột vào ô giữa (ô công cụ Đại số) để bắt đầu làm việc với phần mềm.
	GV: Giới thiệu về PM Toolkit Math và ý nghĩa của PM.
HS: Lắng nghe

GV: Khởi động phần mềm TIM để HS quan sát.

? Để khởi động PM TIM ta thực hiện như thế nào.

HS: Qua qs Gv để nhận xét.

GV: Hướng dẫn MH làm việc của TIM và cách chọn mẫu thực hành để phục vụ cho tiết học.

GV: Gọi một số HS lên bảng khởi động và chọn ô như GV đã hướng dẫn.

HS: Thực hiện trên MT của GV

	Hoạt động 2: Giới thiệu màn hình làm việc của PM (20 phút)

	3. Màn hình làm việc của phần mềm:

a) Thanh bảng chọn: 

- Là nơi thực hiện các lệnh chính của phần mềm. Có nhiều bảng chọn khác nhau, trên mỗi bảng chọn có thể có nhiều mức.
b) Cửa sổ dòng lệnh:

- Dùng để gõ các dòng lệnh, gõ xong nhấn phím Enter để thực hiện lệnh này.

c) Cửa sổ làm việc chính:

- Là nơi thể hiện kết quả của các lệnh.

d) Cửa sổ vẽ đồ thị hàm số:

- Là nơi thể hiện kết quả của lệnh, nếu lệnh là vẽ đồ thị hoặc có liên quan đến đồ thị.
	GV: Giới thiệu về MH làm việc của PM trên MT.
HS: Lắng nghe và quan sát

HS: ghi vở

GV: Trong PM Excel để kết thúc việc nhập nội dung vào ô tính ta nhấn phím gì?

HS: Phím Enter
GV: Trong PM này để thực hiện lệnh ta nhấn phím gì?

HS: Phím Enter

HS: Chép vở

	Hoạt động 3: Củng cố (5 phút)

	
	- Về nhà tham khảo các phần tiếp theo


Tiết: 30


                                                       Ngày Soạn: 26/11/2012
Tuần: 15                                                                   

Ngày dạy :  04/12/2012


I.  MỤC TIÊU
   a. Kiến thức
- Nhận biết và phân biệt được các màn hình chính và các chức năng chính của phần mềm.

  b. Kĩ năng

- Thực hiện được một số lệnh chính từ hộp thoại và từ dòng lệnh.


- Sử dụng một số tính năng của phần mềm học tập.

 II. PHƯƠNG PHÁP: 


- Giảng giải và thao tác cho HS quan sát trên máy.

III. CHUẨN BỊ
    Giáo viên: 


- Giáo án, máy tính, cài đặt phần mềm lên các máy tính trong phòng vi tính.

- Các máy tính trong phòng dạy chạy tốt.

   Học sinh:     


- SGK đầy đủ.

         - Vở ghi chép

IV.   HOẠT ĐỘNG DẠY  HỌC:

1. Ổn định tổ chức: Kiểm tra sĩ số lớp. (5 phút)

2. Kiểm tra bài cũ: 


3. Giảng bài mới:

	NỘI DUNG
	HOẠT ĐỘNG GV VÀ HS

	Hoạt động 1: Giới thiệu các lệnh tính toán đơn giản (15 phút)

	4. Các câu lệnh tính toán đơn giản:
a) Tính toán các biểu thức đơn giản:
- Thực hiện các phép toán: +, -, *, /, ^

- VD: Hãy nhập dòng lệnh sau vào cửa sổ dòng lệnh:

Simplify 1/5 + 3/4

Kết quả trên MH: 


[image: image31.png]simplify 1/5+3/4
19

answer: —

20




- Cách chọn trên thanh bảng chọn: Vào Algebra -> Simplify xuất hiện bảng sau và gõ nội vào dòng Expression to..->Enter


[image: image32.png]Simplify ==
EreminSy Ty

19720 4172

| Name the result





b) Vẽ đồ thị đơn giản: Dùng dòng lệnh plot từ cửa sổ dòng lệnh.
VD: vẽ đồ thị hàm số y= 3x + 1

Ta gõ dòng lệnh sau: plot y=3*x+1


[image: image33.png]94
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	GV: Các phép toán trong công thức được ký hiệu như thế nào?
HS:  các phép toán: +, -, *, /, ^
GV: Nhận xét và đi vào vấn đề của mục 4

GV: Giới thiệu các lệnh tính toán đơn giản

HS: Lắng nghe

GV: Mỗi lệnh thì thực hiện trên máy tính để HS quan sát

GV: Thực hiện từng bước một để giúp HS ghi nhớ và hiểu rõ hơn.

HS: Lắng nghe và quan sát

GV: Xong 1 thao tác thì gọi 1 HS lên thực hiện thao tác đó.

	Hoạt động 2: Giới thiệu các câu lệnh tính toán nâng cao (20 phút)

	5. Các câu lệnh tính toán nâng cao:
a) Biểu thức đại số: 

- Lênh Simplify còn thực hiện các tính toán nâng cao khác. 
- VD: tính giá trị biểu thức:


[image: image34.wmf]20
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 em gõ dòng lệnh sau:

Simplify (3/2+5/4)/(2/3-1/5)+17/20

Kết quả trên MH:


[image: image35.png]Simplify (3/2+5/4)(2/3-1/5)+17120
236

answer: —

35




b) Tính toán với đa thức:
- Thực hiện các tính toán trên đơn thức và đa thức dùng lệnh Expand.
VD: Rút gọn một đơn thức:

Expand (2*x^2*y)*(9*x^3*y^2)

Kết quả trên MH:


[image: image36.png]Expand (Z'x"2'y)(9'x"3'y"2)

53
answer: 18-x -y




- lệnh Expand cũng có thể thực hiện trên thanh bảng chọn Algebra ->expand rồi gõ lệnh vào hộp thoại xuất hiện -> OK.
c) Giải phương trình đại số:

- Sử dụng lệnh Solve 

- Cú pháp: solve <phương trình> <tên biến>

VD: Tím nghiệm của đa thức 3x + 1

Nhập lệnh sau: solve 3*x + 1 = 0 x

Kết quả trên MH:


[image: image37.png]solve 3'x +1=0x





d) Định nghĩa đa thức và đồ thị hàm số:

- Sử dụng lệnh make

- Cú pháp: make <tên hàm> <đa thức>

VD: Định nghĩa đa thức P(x) = 3x – 2

Nhập lệnh sau: make P(x) 3*x – 2

- Khi một đa thức thực hiện ta dùng lệnh graph để vẽ đồ thị của hàm số
6. Các chức năng khác:
a) Làm việc trên cửa sổ dòng lệnh:

b) Lệnh xoá thông tin trên cửa sổ vẽ đồ thị:

- Dùng lệnh: Clear

c) Các lệnh đặt nét vẽ và màu sắc trên cửa sổ vẽ đồ thị:

- Đặt nét vẽ đồ thị dùng lệnh: Penwidth

- Đặt màu dùng lệnh: Pencolor

Bảng màu:

Tên màu T.Anh

Tiếng Việt

Blue

Xanh

Red

Đỏ

Black

Đen

Magenta

Hồng

Yellow

Vàng


	GV: Giới thiệu các lệnh tính toán nâng cao

HS: Lắng nghe

GV: Mỗi lệnh thì thực hiện trên máy tính để HS quan sát

GV: Thực hiện từng bước một để giúp HS ghi nhớ và hiểu rõ hơn.

HS: Lắng nghe và quan sát

GV: Xong 1 thao tác thì gọi 1 HS lên thực hiện thao tác đó.
GV: Làm một số ví dụ để HS thấy rõ những tiện lợi của PM TIM hơn

HS: Quan sát và rút ra nhận xét về phần mềm TIM.

GV: Ngoài những chức năng trên, TIM còn có chức năng vẽ màu cho đồ thị

GV: Thực hiện trên MT để HS thấy trực quan hơn.

HS: Lắng nghe và quan sát

GV: Gọi 1 số HS lên MT để thực hiện thao tác vừa rồi.

HS: Lên thực hiện

GV: Hãy nhận xét thao tác của bạn vừa rồi?

HS: Nhận xét

GV: Giới thiệu một số màu bằng T.Anh sang Tiếng Việt

GV: Gọi HS đọc lại những bảng màu đó



	Hoạt động 3: Củng cố (5 phút)

	
	- Về nhà học thuộc các lệnh để tiết sau thực hành trên máy.


Tiết: 31-32


                                                       Ngày Soạn: 26/11/2012
Tuần: 16                                                                   

Ngày dạy :  11/12/2012


I.  MỤC TIÊU
   a. Kiến thức
- Nhận biết và phân biệt được các màn hình chính và các chức năng chính của phần mềm.

  b. Kĩ năng

- Thực hiện được một số lệnh chính từ hộp thoại và từ dòng lệnh.


- Sử dụng một số tính năng của phần mềm học tập.

 II. PHƯƠNG PHÁP: 


- Giảng giải và thao tác cho HS quan sát trên máy.

III. CHUẨN BỊ
    Giáo viên: 


- Giáo án, máy tính, cài đặt phần mềm lên các máy tính trong phòng vi tính.

- Các máy tính trong phòng dạy chạy tốt.

   Học sinh:     


- SGK đầy đủ.

         - Vở ghi chép

IV.   HOẠT ĐỘNG DẠY  HỌC:

1. Ổn định tổ chức: Kiểm tra sĩ số lớp. (5 phút)

2. Kiểm tra bài cũ: 


3. Giảng bài mới:

	NỘI DUNG
	HOẠT ĐỘNG GV VÀ HS

	Hoạt động 1: Kiểm tra lại các lệnh vừa học và thực hành trên máy (80 phút)

	7. Thực hành:
Câu a, b, c/SGK/Trang 118
	GV: Kiểm tra một số lệnh đối với 1 số HS.
HS: Trả lời

GV: Cho HS thực hành theo nhóm

Mỗi nhóm từ 2-3 HS

HS: Thực hành các bài tập trong SGK/Trang 118.

GV: Nhận xét các bài thực hành của HS rồi cho điểm để biểu dương từng nhóm

	Hoạt động 3: Củng cố (5 phút)

	
	- Về nhà ôn tập để chuẩn bị kiểm tra học kỳ I


Tiết: 34-35


                                            Ngày Soạn: …../…../2012
Tuần: 16-17                                                                   
Ngày dạy :  …../…../2012


I/ MỤC TIÊU:

· Đánh giá kiến thứII.  kỹ năng của học sinh về: các thành phần cơ bản trên trng tính.Excel, cách thiết đặt các biểu thức tính toán, cách sử dụng các hàm.

II/ YÊU CẦU ĐỀ:

3. Kiến thức:
  Kiểm tra kiến thức học sinh về: 

Biết nhập liệu, di chuyển vào trang tính.

Biết nhập các công thức và hàm vào ô tính

Biết sử dụng các hàm: SUM, AVERAGE, MAX, MIN

4. Kỹ năng:

Thiết đặt công thức tính toán đúng, vận dụng các hàm cơ bản để tính toán.

III/ MA TRẬN ĐỀ:

	                           Bậc nhận thức

Nội dung
	Nhận biết
	Thông hiểu
	Vân dụng

	
	TN
	TN
	TN

	Làm quen với chương trình bảng tính và dữ liệu trên trang  tính.
	1,2,21,23


	5,7,8,28,17


	3,10,14



	Thực hiện các tính toán trên trang tính.
	3,24,25,29

      
	9,11,13,15,18,19

      
	4,27,30



	Phần mềm học tập
	22,26

                  
	                   
	                    







ĐỀ BÀI

  Phần I: Hãy khoanh tròn và ghi vào phần trả lời chữ cái trước câu trả lời đúng trong các câu hỏi sau:

1. Giao của hàng và cột được gọi là



A.Ô
B.   Trường  
C. Dữ liệu  
D.    Công thức

2. Cum từ “F5” trong hộp tên (     F5             ) có nghĩa là:


A.  phím chức năng F5

 B.  Phông cữ hiện thời là F5.

 
C. Ô ở hàng F cột 5.                             
 D.  ô ở cột F hàng 5

3.Trang tính có thể chứa dữ liệu thuộc kiể nào sau đây?


A. Kí tự 
 
B. Số   



C. Thời gian.               

D.  Tất cả các kiểu dữ liệu trên

4. Thông thường, dữ liệu kiểu kí tự trên trang tính được dùng là gì?


A. Thực hiện tính toán;                                   
B. Giúp phân biệt các thông tin trên trang tính;


C.  Báo cho máy biết ta định làm gì                 
D. Tất cả các mục đích trên

5. Khi gõ công thức vào một ô, kí tự đầu tiên phả là

A.  ô đầu tiên tham chiếu tới;  
 B. dấu ngoặc đơn;     


C.  dấu bằng   

D.  dấu nháy;  

6. Trong các chương trình bảng tính có công cụ để thực hiện tính toán theo công thức đựoc định nghĩa sẵn. Các công cụ đó chính là

A. hàm
B.  chú thích  
C.  định dạng   
D.   biểu thức

7. Trong các cách viết hàm sau cách  viết đúng là .


A. =average(“a1:a5”)
B.   =avegera (a1:a5);
C.  =everage(a1:a5);    
D.  =average(a1:a5)

8. Trong các cách viết hàm sau cách  viết đúng là:


A. =sum(“a1:a5”)
B.   =sum(a1:a5) 
C.  =sum(“a1+a5”);
D.  =sum(‘a1:a5’)

9.  Trong các cách viết hàm sau cách  viết đúng là:


A. =mac(a1:a5)    
B.   =max(‘a1:a5’);     
C.  =max(“a1+a5”); 
D.  =max(a1:a5)

10.  Trong các cách viết hàm sau  cách viết đúng là:


A. =mix(a1:a5)  
B.   =min(a1:a5) 
C.  =min(“a1+a5”); 
D.  =min(‘a1:a5’)

11. Cách viết địa chỉ của một khối đúng là

A.  5A:8B
B.   A5+B8
C.   A5;B8
D.  A5:B8

12. Thanh công thức dùng để

A.  Sắp xếp và lọc dữ liệu
B. Hiển thị dữ liệu hoặc công thức trong ô tính



C.  Được dùng để nhập dữ liệu  
D. Cả hai ý B và C.

13. Khi chiều dài dữ liệu kiểu số lớn hơn chiều rộng của ô thì Excel sẽ hiện thị trong ô kí tự

A.  %
B.  *
C.   #
D.  &

14. Giả sử cần tính tổng giá trị trong các ô C2 và D4, sau đó nhân với giá trị trong ô B2. Trong các công thức sau công thức nào đúng.


A.  =(C2+D4*B2)
B.   =(C2+D4)*B2
C.  =C2+D4*B2
D.  =(C2+D4)B2

15. Cách  nhập công thức để tính giá trị 144:6-3x5  trong Excel là

A.   =144:6-3x5
B.   =144/6-3*5
C.  =144:6-3*5
D.  =144/6-3x5

16.  Màn hình Excel có những công cụ đặc trưng cho bảng tính là:


A.   Thanh tiêu đề
B. Thanh bảng chọn
C.  Thanh công thức
D.  Thanh công cụ.

17. Để mở một bảng tính mới chúng ta nháy chuột vào nút.


A.  [image: image38.png]



B.  [image: image39.png]



C.   [image: image40.png]



D. [image: image41.png]


 

18.  Trên hính trang tính được kích hoạt là

A. Sheet 3
B.  Sheet 2


C.  Sheet 1
D.  Cả ba Sheet

19.  Trên hình ô tính được kích hoạt là

A.  A1
B.  1A


C.   A
D.  Tất cả các ô.

20.  Số  ô tính có trong vùng A1:C3 là

A.   2 ô
B.   9 ô

C.   6 ô
D.   3 ô  

21. Muốn nhập công tức vào bảng tính, cách nhậpnào là đúng?








A. =15^2 + 4/ 2                B. = 152 + 4 : 2               C. =2152 + 4 : 2

    D. tất cả đều đúng

 22: Phần mềm Typing Test gồm có mấy trò chơi luyện gõ bàn phím?

A.  7

 
B. 5 


C.  4


D.  6

 23 . Để tính tổng ta sử dụng hàm:

A. MAX                        B. AVERAGE.            
C. MIN
       D. SUM 

 24 : Trong bảng tính Excel, ở chế độ ngầm định.

A. Dữ liệu số luôn được canh thẳng lề trái trong ô dữ liệu.

B. Dữ liệu ký tự luôn được canh thẳng lề phải trong ô dữ liệu.

C. Cả hai ý a và b đều sai.

C. Cả hai ý a và b đúng.

25: Muốn tính tổng của các ô A2 và D2, sau đó lấy kết quả nhân với giá trị trong ô E2. 

A. = (A2 + D2) x E2





B. = A2 * E2 + D2 

C. = A2 + D2 * E2





D. = (A2 + D2)*E2

26 :Địa chỉ của một ô là:

A. Tên cột mà ô đó nằm trên đó

B. Cặp tên hàng và tên cột mà ô đó nằm trên đó

C. Tên hàng mà ô đó nằm trên đó 

D. Cặp tên cột và tên hàng mà ô đó nằm trên đó


27. Ô B5 là ô nằm ở vị trí: 

   
A. Hàng B cột 5


            B. Hàng 5 cột B 

   
C. Ô đó có chứa dữ liệu B5

 
D. Từ hàng 1 đến hàng 5 và cột A .

28. Để tính giá trị lớn nhất ta sử dụng hàm:

A MIN.                   B. SUM            C. MAX   
             D. AVERAGE

29. Khi bảng tính đã đựợc lưu ít nhất một lần ( đã có tên) ta muốn lưu với tên khác thì:

A. File\Save as

B.File\exit

C.File\ Save

D. File\Open 

30. Điền vào chỗ trống:

	Nút lệnh
	Tên
	Sử dụng để
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	New
	Mơ trang tính mới

	[image: image42.png]



	Save
	Lưu trang tính 

	
[image: image43.png]



	Open
	Mở trang tính dã có

	
[image: image44.png]



	Undo
	Trở lại thao tác trước

	[image: image45.bmp]
	Align left
	Căn thẳng lề trái

	[image: image46.bmp]
	Center
	Căn giữa

	[image: image47.bmp]
	Justify
	Căn đề hai lề

	[image: image140.png]



	Cut
	Di chuyển dữ liệu
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	Paste
	Dán


Phần II: Trả lời

	Câu
	1
	2
	3
	4
	5
	6
	7
	8
	9
	10
	11
	12
	13
	14
	15

	Đ.Án
	A
	D
	D
	D
	C
	A
	D
	B
	D
	B
	D
	D
	C
	B
	B

	Câu
	16
	17
	18
	19
	20
	21
	22
	23
	24
	25
	26
	27
	28
	29
	

	Đ.Án
	C
	D
	C
	A
	B
	A
	C
	D
	C
	D
	D
	B
	C
	A
	


Ngày soạn  :  …/…/2013
Ngày giảng : …/…/2013
Tiết: 37

(t1)
I -  MỤC TIÊU
a. Kiến thức

- Học sinh biết và phân biệt được các thành phần chính trên màn hình.

- Biết cách khởi động.

- Biết các công cụ và điều khiển hình.

- Biết cách mở, ghi tệp, thoát khỏi phần mềm.

b. Kỹ Năng

- Thực hiện thành thạo thao tác trên.

c. Phương pháp
- Thuyết trình và thực hành trên máy.

II -  CHUẨN BỊ

1. Giáo viên: Giáo trình, Phòng máy.

2. Học sinh: Nghiên cứu trước bài học ở nhà. 

III -  TIẾN TRÌNH DẠY HỌC 
	HOẠT ĐỘNG CỦA THẦY
	HOẠT ĐỘNG CỦA TRÒ
	NỘI DUNG

	Hoạt động 1: . Giíi thiÖu phÇn mÒm

	GV: Phần mềm Geoebra cho phép thiết kế các hình để học hình học trong chương trình môn Toán ở phổ thông…


	HS: Chú ý lắng nghe.


	1. Giới thiệu phần mềm



	                                         Hoạt động 2: Lµm quen víi phÇn mÒm

	GV: T­¬ng tù nh­ c¸c phÇn mÒm kh¸c em h·y thö nªu c¸ch khëi ®éng víi phÇn mÒm Geogebra?

-  Sau khi khëi ®éng phÇn mÒn th× mµn h×nh lµm viÖc chÝnh gåm nh÷ng thµnh phÇn g×?

GV: Treo b¶ng phô giíi thiÖu c¸c thµnh phÇn chÝnh cña phÇn mÒm Geogebra.

GV: Giíi thiÖu c¸c c«ng cô vÏ vµ ®iÒu khiÓn h×nh cã trong phÇn mÒm.

? §Ó chän mét c«ng cô ta lµm ntn?

GV: Chóng ta ®· biÕt, víi Word cã phÇn më réng lµ .doII.  Excel lµ .xls cßn víi Geogebra lµ .ggb. 

? C¸ch më vµ l­u víi tÖp Geogebra?

GV: §Ó tho¸t khái phÇn mÒm ta lµm ntn?


	HS: Suy nghÜ tr¶ lêi. (Nh¸y ®óp chuét vµo biÓu t­îng cña phÇn mÒm).

HS: Quan s¸t vµ tr¶ lêi.

HS: Ghi chÐp.

HS : Quan s¸t vµ ghi chÐp.

HS : Tr¶ lêi.

HS : Ghi chÐp.

HS: Suy nghÜ tr¶ lêi. 

HS : Suy nghÜ tr¶ lêi.

HS : Chó ý quan s¸t vµ nghe gi¶ng.
	2. Lµm quen víi phÇn mÒm

a) Khëi ®éng

- Nh¸y ®óp chuét biÓu t­îng cña Geogebra.

b) Giíi thiÖu mµn h×nh

- Thanh b¶ng chän.

- Thanh c«ng cô.

- Khu vùc trung t©m.

c) C¸c c«ng cô vÏ vµ ®iÒu khiÓn mµn h×nh

d) Më vµ ghi tÖp vÏ h×nh

- Më tÖp: File -> Open. Chän tÖp cÇn më -> Open.

- Ghi tÖp: File -> Save. Gâ tªn ë « File name -> Save.

e) Tho¸t khái phÇn mÒm

File -> Exit.




IV: DẶN DÒ
- Hướng dẫn HS đọc tiếp các phần còn lại bài học vẽ hình học động với Geogebra.

Ngày soạn  :  …/…/2013
Ngày giảng : …/…/2013
Tiết: 38

(t2)

I -  MỤC TIÊU
a. Kiến thức

- Biết các công cụ và điều khiển hình.

- Biết cách mở, ghi tệp, thoát khỏi phần mềm.

- Vẽ được hình.

b. Kỹ Năng

- Thực hiện thành thạo thao tác trên.

c. Phương pháp
- Thuyết trình và thực hành trên máy.

II -  CHUẨN BỊ

1. Giáo viên: Giáo trình, Phòng máy.

2. Học sinh: Nghiên cứu trước bài học ở nhà. 

III -  TIẾN TRÌNH DẠY HỌC 
	HOẠT ĐỘNG CỦA THẦY
	HOẠT ĐỘNG CỦA TRÒ
	NỘI DUNG

	Hoạt động 1: kiểm tra bài cũ

	- Phần mềm Geogebra dung để làm gi?

- Nêu cách khởi động phàn mềm và một số thành phần chính có trên cửa sổ Geogebra ?
	- Phần mềm Geoebra cho phép thiết kế các hình để học hình học trong chương trình môn Toán ở phổ thông 

- Nh¸y ®óp chuét biÓu t­îng cña Geogebra

- Thanh b¶ng chän.

- Thanh c«ng cô.

- Khu vùc trung t©m.
	

	Hoạt động 2: Vẽ hình đầu tiên: Tam giác ABC

	GV: H­íng dÉn HS c¸ch vÏ tam gi¸c ABC.

GV: Yªu cÇu HS khëi ®éng phÇn mÒm Geo vµ tõng HS thùc hiÖn thao t¸c vÏ tam gi¸c trªn m¸y tÝnh.

? §Ó thùc hiÖn thao t¸c di chuyÓn ta sö dông nót lÖnh nµo?

GV: Yªu cÇu HS thùc hiÖn di chuyÓn c¸c ®iÓm A, B, C.

GV: Yªu cÇu HS l­u l¹i c¸c tÖp h×nh ®· vÏ.

GV: Yªu cÇu HS më l¹i c¸c tÖp ®· l­u.

? §Ó tho¸t khëi phÇn mÒm ta lµm ntn?

GV: Yªu cÇu HS tho¸t khái phÇn mÒm Geo.
	HS: Thùc hµnh vÏ theu yªu cÇu cña GIV/

HS: Suy nghÜ tr¶ lêi.

HS: Thùc hiÖn di chuyÓn ®iÓm.

HS: Thùc hiÖn l­u tÖp.

HS: Thùc hiÖn më tÖp ®· cã.

HS: Tr¶ lêi vµ tiÕn hµnh thao t¸c tho¸t khái phÇn mÒm.
	3. VÏ h×nh ®Çu tiªn: Tam gi¸c ABC

a) L­u tÖp

b) Më tÖp

c) Tho¸t khái phÇn mÒm


IV - DẶN DÒ

- Hướng dẫn HS đọc tiếp các phần còn lại bài học vẽ hình học động với Geogebra.

Ngày soạn  :  …/…/2013
Ngày giảng : …/…/2013
Tiết: 39

(t3

I -  MỤC TIÊU

a. Kiến thức

- Học sinh bước đầu hiểu được các đối tượng hình học cơ bản của phần mềm và quan hệ giữa chúng.

- Học sinh biết và hiểu các ứng dụng của phần mềm trong việc vẽ và minh hoạ hình học trong chương trình môn Toán.

b. Kỹ Năng

- Thực hiện thành thạo tất cả các thao tác với Geogebra.

c. Phương pháp
- Thuyết trình và thực hành trên máy.

II -  CHUẨN BỊ

1. Giáo viên: Giáo trình, Phòng máy.

2. Học sinh: Nghiên cứu trước bài học ở nhà. 

III -  TIẾN TRÌNH DẠY HỌC 
	HOẠT ĐỘNG CỦA THẦY
	HOẠT ĐỘNG CỦA TRÒ
	NỘI DUNG

	Hoạt động 1: Kiểm ra bài cũ

	? Em hãy nêu cách khởi động phần mềm và các thành phần chính của màn hình làm việc với phần mềm Geogebra
	- Nháy đúp chuột trên biểu tượng của phần mềm.

 -Thanh bảng chọn.

- Thanh công cụ.

- Khu vực trung tâm.
	

	Hoạt động 2: Quan  hệ  giữa  các  đối  tượng  hình  học

	GV: Em hãy kể tên các quan hệ giữa các đối tượng hình học đã học trong môm toán Hình.

GV: Treo bảng phụ giới thiệu một số quan hệ và cách thiết lập trong phần mềm.


	HS: Suy nghĩ trả lời.

HS: Quan sát, chú ý lắng nghe và ghi chép.


	4. Quan  hệ  giữa  các  đối  t ượng  hình  học

(HS nghiên cứu thêm SGK)



	Hoạt động 3: Một số lệnh hay dùng

	GV: Giới thiệu các lệnh thường dùng trong Geogebra.

GV: Giới thiệu thao tác di chuyển nhãn của đối tượng.

GV: Giới thiệu thao tác làm ẩn 1 đối tượng hình.

GV: Giới thiệu thao tác làm ẩn/hiện nhãn 1 đối tượng hình.

.
	HS: Chú ý lắng nghe và ghi chép.

HS: Chú ý quan sát.

HS: Chú ý quan sát.

HS: Chú ý quan sát.

HS: Quan sát và ghi chép.

HS: Quan sát và ghi chép.


	5. Một số lệnh hay dùng

a) Dịch chuyển nhãn của đối tượng

-  Dùng công cụ chọn và thực hiện thao tác kéo thả chuột xung quanh đối tượng đến vị trí mới. 

b) Làm ẩn một đối tượng hình học

- Nháy chuột phải lên đối tượng và chọn Show Object.

c) Làm ẩn/hiện nhãn của đối tượng

- Nháy chuột phải lên đối tượng và chọn Show label.




IV - DẶN DÒ

- Giáo viên nhắc lại tất cả các thao tác với phần mềm Geogebra.

- Nhận xét giờ họII.  ý thức làm bài và kết quả bài làm của HS. 

Ngày soạn  :  …/…/2013
Ngày giảng : …/…/2013
Tiết: 40

(t4

I -  MỤC TIÊU

a. Kiến thức

- Học sinh biết và hiểu các ứng dụng của phần mềm trong việc vẽ và minh hoạ hình học trong chương trình môn Toán.

- Củng cố lại các cách vẽ các hình cơ bản. Tạo được giao điểm 3 đường cao, 3 đường trung tuyến, 3 đường phân giác... 

b. Kỹ Năng

- Thực hiện thành thạo tất cả các thao tác với Geogebra.

c. Phương pháp
- Thuyết trình và thực hành trên máy.

II -  CHUẨN BỊ

1. Giáo viên: Giáo trình, Phòng máy.

2. Học sinh: Nghiên cứu trước bài học ở nhà. 

III -  TIẾN TRÌNH DẠY HỌC 
	HOẠT ĐỘNG CỦA THẦY
	HOẠT ĐỘNG CỦA TRÒ
	NỘI DUNG

	Hoạt động 1: Một số lệnh hay dùng

	GV: Giới thiệu thao tác xoá 1 đối tượng hình.

GV: Giới thiệu thao tác đổi tên, nhãn đối tượng hình.

GV: Giới thiệu thao tác phóng to, thu nhỏ đối tượng hình.

GV: Giới thiệu thao tác di chuyển đối tượng hình.

GV: Yêu cầu học sinh lần lượt làm lại tất cả các thau tác đã học.


	HS: Quan sát và ghi chép.

HS: Quan sát và ghi chép.

HS: Thực hiện lại các thao tác.


	5. Một số lệnh hay dùng

d) Xoá một đối tượng

C1 : Nháy chọn đối tượng và nhấn phím Delete.

C2: Nháy chuột phải lên đối tượng và chọn Delete.

e) Thay đổi tên, nhãn của đối tượng

- Nháy chuột phải lên đối tượng và chọn Rename. Gõ tên mới -> Apply.

g) Phóng to, thu nhỏ các đối tượng trên màn hình

- Nháy chuột phải lên đối tượng và chọn Room. 
h) Di chuyển toàn bộ các đối tượng hình học trên màn hình

- Giữ Ctrl + Chuột trái và thao tác kéo thả chuột.



	                                                      Hoạt động 2: Bài tập thực hành

	GV: Yêu cầu học sinh làm các bài tập SGK trang 125.

GV: Chú ý đi xung quanh hướng dẫn HS các thao tác khó. 

- Kiểm tra việc thực hành của học sinh. Sửa sai và cho điểm.
	HS: Làm bài tập thực hành.


	6. Bài tập thực hành

(Trang 125 SGK)


V - DẶN DÒ

- Giáo viên nhắc lại tất cả các thao tác với phần mềm Geogebra.

- Nhận xét giờ họII.  ý thức làm bài và kết quả bài làm của HS. 

- Chuẩn bị bài TH số 10

Ngày soạn  :  …/…/2013
Ngày giảng : …/…/2013
Tiết: 41


I/- MỤC TIÊU:

a- Kiến thức:

· Định dạng trang tính.

· Thực hiện định dạng phông chữ, cỡ chữ, kiểu chữ .

· Căn lề trong ô tính.

b- Kỹ năng:


Rèn luyện thao tác định dạng trang tính với kiến thức đã học ở Microsoft Word vận  dụng vào bảng tính Excel.

II/- PHƯƠNG PHÁP

      - Hoạt động nhóm, diễn giảng

III/- ĐỒ DÙNG DẠY HỌC:

 Chuẩn bị của GV: Giáo án

 Chuẩn bị của HS: Đọc tài liệu trước ở nhà, SGK.

IV/- HOẠT ĐỘNG DẠY HỌC: 

	HOẠT ĐỘNG CỦA THẦY
	HOẠT ĐỘNG CỦA TRÒ
	NỘI DUNG

	Hoạt động 1: §Þnh d¹ng ph«ng ch÷, cì ch÷ vµ kiÓu ch÷

	GV : Thuyết trình và giải thích cho học sinh hiểu thế nào là định dạng trong trang tính.

GV: Giới thiệu các nút lệnh trên thanh công cụ dùng để dịnh dạng phông chữ, cỡ chữ và kiểu chữ.

GV: Sử dụng máy chiếu tr×nh bµy c¸c b­íc ®Ó thay ®æi ph«ng ch÷ trong Excel.


	HS: Chó ý l¾ng nghe.

HS: Quan s¸t vµ ghi chÐp.

HS : Quan s¸t tranh vµ ghi chÐp.

HS : Quan s¸t tranh vµ ghi chÐp.


	1. §Þnh d¹ng ph«ng ch÷, cì ch÷ vµ kiÓu ch÷
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.Vntime: Chän ph«ng ch÷.

12: Chän cì c÷.

B: Chän ch÷ ®Ëm

I: chän ch÷ nghiªng.

U: Chän ch÷ g¹ch ch©n.

a) Thay ®æi ph«ng ch÷

-  B­íc 1: Chän « hoÆc c¸c « cÇn ®Þnh d¹ng.

-  B­íc 2: Nh¸y mòi tªn ë « Font

-  B­íc 3 : Chän ph«ng ch÷ thÝch hîp.

	GV: Sử dụng mỏy chiếu trình bày các bước để thay đổi cỡ chữ trong Excel.

GV Sử dụng mỏy chiếu trình bày các bước để thay đổi cỡ chữ trong Excel.

GV: Giới thiệu cách chọn màu phông.

GV: Giới thiệu cách căn lề trong ô tính.
	HS : Quan sát tranh và ghi chép.

HS : Quan sát và ghi chép.

HS : Quan sát và ghi chép.
	b) Thay đổi cỡ chữ
- Bước 1: Chọn ụ hoặc cỏc ụ cần định dạng.

-  Bước 2: Nhỏy mũi tờn ở ụ Size.

-  Bước 3 : Chọn cỡ chữ thớch hợp.

c) Thay đổi kiểu chữ
- Bước 1: Chọn ụ hoặc cỏc ụ cần định dạng.

-  Bước 2: Nhỏy nỳt Bold để chọn chữ đậm, nỳt I để chọn chữ nghiờng, nỳt U để chọn chữ gạch chõn.

* Chỳ ý : Cú thể sử dụng đồng thời cỏc nỳt để cú cỏc kiểu chữ thớch hợp.

2. Chọn màu phụng

- Bước 1: Chọn ụ hoặc cỏc ụ cần định dạng.

-  Bước 2: Nhỏy nỳt Font Color.

-  Bước 3 : Chọn màu chữ thớch hợp.

3. Căn lề trong ụ tớnh

- Bước 1: Chọn ụ hoặc cỏc ụ cần định dạng.

-  Bước 2: Nhỏy nỳt Center để căn thẳng giữa ụ tớnh, nỳt Right để căn lề phải, nỳt Left để căn lề trỏi cho ụ tớnh.


V. DẶN DÒ:
     - Học kỹ bài

     - Chuẩn bị phần còn lại

Ngày soạn  :  …/…/2013
Ngày giảng : …/…/2013
Tiết: 42

 (t2)

I/- MỤC TIÊU:

a- Kiến thức:

· Định dạng trang tính.

· Thực hiện định dạng phông chữ, cỡ chữ, kiểu chữ .

· Căn lề trong ô tính.

b- Kỹ năng:


Rèn luyện thao tác định dạng trang tính với kiến thức đã học ở Microsoft Word vận  dụng vào bảng tính Excel.

II/- PHƯƠNG PHÁP

      - Hoạt động nhóm, diễn giảng

III/- ĐỒ DÙNG DẠY HỌC:

 Chuẩn bị của GV: Giáo án

 Chuẩn bị của HS: Đọc tài liệu trước ở nhà, SGK.

IV/- HOẠT ĐỘNG DẠY HỌC: 

	HOẠT ĐỘNG CỦA THẦY
	HOẠT ĐỘNG CỦA TRÒ
	NỘI DUNG

	Hoạt đông  1 : T¨ng hoÆc gi¶m sè ch÷ sè thËp ph©n cña d÷ liÖu sè

	GV: Giới thiệu với HS một số trường hợp cần sử dụng chữ số thập phân trong trang tính.

GV: Giới thiệu 2 nút lệnh để tăng và giảm số chữ số thập phân trong trang tính.

GV: Đưa ra các bước để tăng hoặc giảm số chữ số thập phân của dữ liệu số trong trang tính.



	HS: Chú ý lắng nghe.

HS: Quan sát và ghi chép.

HS : Nghe và ghi chép.


	4. Tăng hoặc giảm số chữ số thập phân của dữ liệu số

· Tăng thêm một chữ số thập phân.

· Giảm bớt một chữ số thập phân.

* Chú ý

Khi giảm bớt một chữ số thập phân, chương trình sẽ thực hiện quy tắc làm tròn số. 

-  Bước 1: Chọn ô (hoặc các ô) cần giảm hoặc tăng số chữ số thập phân.

-  Bước 2: Nháy vào nút [image: image50.png]


 để giảm số chữ số thập phân hoặc nút [image: image51.png]


 để tăng số chữ số thập phân.

	Hoạt động 2: T« mµu nÒn vµ kÎ ®­êng biªn cña c¸c « tÝnh

	GV: Chiếu bảng tính Excel đã được trang trí màu nền và đường biên để học sinh quan sát và hỏi học sinh so sánh khi quan sát với một trang tính chưa được trang trí như vậy.

GV: Đưa ra các bước tô màu nền trong trang tính.

GV : Đưa ra các bước kẻ đường biên trong trang tính.
	HS: Quan sát tranh và trả lời câu hỏi.

HS: Quan sát và ghi chép.

HS: Quan sát và ghi chép.
	5. Tô màu nền và kẻ đường biên của các ô tính

-  Màu nền của các ô tính giúp ta dễ dàng phân biệt và so sánh các miền dữ liệu khác nhau trên trang tính.

* Các bước tô màu nền
- Bước 1: Chọn ô hoặc các ô cần tô màu nền.

- Bước 2: Nháy vào nút Fill Colors để chon màu nền.

- Bước 3 : Nháy chọn màu nền.

* Các bước kẻ đường biên

- Bước 1: Chọn các ô cần kẻ đường biên.

- Bước 2: Nháy nút Border để chọn kiểu vẽ đường biên.

- Bước 3: Nháy chọn kiểu kẻ đường biên. 


V. DẶN DÒ

     - Học kỹ bài

     - Chuẩn bị bài thực hành 6

Ngày soạn  :  …/…/2013
Ngày giảng : …/…/2013
Tiết: 43

 

I -  MỤC TIÊU

a. Kiến thức


                -  Học sinh hiểu được tầm quan trọng của tính toán trong trang tính.

                -  Tác dụng của việc trang trí phù hợp cho một trang tính.

b. Kỹ Năng

                -  HS thực hiện được các thao tác căn chỉnh dữ liệu và định dạng trang tính.

II - PHƯƠNG PHÁP
                -   Thực hành theo nhóm – GV giải đáp, hướng dẫn.

III -  CHUẨN BỊ
1. Giáo viên: Giáo  an, phòng máy.

2. Học sinh: Đọc trước bài ở nhà.

IV - HOẠT ĐỘNG DẠY HỌC
	HOẠT ĐỘNG CỦA THẦY
	HOẠT ĐỘNG CỦA TRÒ
	NỘI DUNG

	GV: Ra yêu cầu bài thực hành.

GV : Kiểm tra và lấy điểm.


	HS: Nhận bài và làm trực tiếp trên máy tính.

HS : Trả bài.


	Bài 1. Thực hành định dạng văn bản và số, căn chỉnh dữ liệu, tô màu văn bản, kẻ đường biên và tô màu nền.
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- Mở bảng tính Bảng điểm lớp em đã được lưu trong bài thực hành 4. Thực hiện các điều chỉnh và định dạng thích hợp để có trang tính như hình dưới đây. Cuối cùng lưu bảng tính.

Yêu cầu: Thực hịên định dạng với phông chữ, cỡ chữ, màu sắc khác nhau; dữ liệu số được căn giữa.

- Hàng 1 có các ô từ A1 đến G1 được gộp thành mô ô và nội dung được căn giữa bảng.

Các cột và các hàng được tô các màu nền và kẻ đường biên để dễ phân biệt.




V. DẶN DÒ

     - Học kỹ bài

Ngày soạn  :  …/…/2013
Ngày giảng : …/…/2013
Tiết: 44


I -  MỤC TIÊU:
a. Kiến thức


                -  Học sinh hiểu được tầm quan trọng của tính toán trong trang tính.

                -  Tác dụng của việc trang trí phù hợp cho một trang tính.

b. Kỹ Năng

                -  HS thực hiện được các thao tác căn chỉnh dữ liệu và định dạng trang tính.

II -  PHƯƠNG PHÁP


  -   Thực hành theo nhóm – GV giải đáp, hướng dẫn

III -  CHUẨN BỊ
1. Giáo viên: Giáo  an, phòng máy.

2. Học sinh: Đọc trước bài ở nhà.

IV: HOẠT ĐỘNG DẠY HỌC:

	HOẠT ĐỘNG CỦA THẦY
	HOẠT ĐỘNG CỦA TRÒ
	NỘI DUNG

	Hoạt động 1: Lập trang tinh, sử dụng cụng thức.  định dạng, căn chỉnh DL

	GV: Ra yêu cầu bài thực hành.

GV : Kiểm tra và lấy điểm.


	HS: Nhận bài và làm trực tiếp trên máy tính.

HS : Trả bài.


	Thực hành lập trang tính, sử dụng công thức.  định dạng, căn chỉnh dữ liệu ô và tô màu.

Khởi động chương trình bảng tính Excel.

a) Lập trang tính với  dữ liệu các nước trong khu vực Đông Nam  á như hình dưới đây (Tên các nước trong côt B được nhập theo thứ tự bảng chữ cái)
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	GV: Ra yêu cầu bài thực hành.

GV : Kiểm tra và lấy điểm.


	HS: Nhận bài và làm trực tiếp trên máy tính.

HS : Trả bài.


	b) Lập công thức để tính mật độ dân số (người/Km2) của Bru – nây trong ô E5. Sao chép công thức vào các ô tương ứng của cột E để tính mật độ dân số của các nước còn lại.

c) Chèn thêm các hàng trống cần thiết, điều chỉnh hàng, cột và thực hiện các thao tác định dạng văn bản, định dạng số để có trang tính tương tự như hình dưới đây.


V. DẶN DÒ
     - Học kỹ bài

     - Chuẩn bị bài 7: Trình bày và in trang tính

Ngày soạn  :  …/…/2013
Ngày giảng : …/…/2013
Tiết: 45


I -  MỤC TIÊU

a. Kiến thức

- Học sinh được học và sử dụng lệnh xem trước khi in trang tính, học các thao tác định dạng trang in, giấy in..

b. Kỹ Năng

- Học sinh biết cách định dạng trang in, biết xem trang in trước khi cho in ra máy.

II – PHƯƠNG PHÁP

- Hướng dẫn
III -  CHUẨN BỊ
-GV: B ài gi ảng 

- HS: Đọc trước bài ở nhà. but vở


IV -  HOẠT ĐỘNG DẠY HỌC
	HOẠT ĐỘNG CỦA THẦY
	HOẠT ĐỘNG CỦA TRÒ
	NỘI DUNG

	                                                 Hoạt động 1:  Xem trước khi in

	GV: Thuyết trình và minh hoạ bằng em trước khi in.

tranh cho học sinh thấy hình ảnh 

GV: Giới thiệu 1 vài nút lệnh chuyên dụng. (Next, Previous..)


	HS : Nghe và quan sát.

HS : Thực hiện trên máy tính cá nhân.


	1. Xem trước khi in

- Nháy vào nút Print Preview (xem trước khi in) trên thanh công cụ.
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	Hoạt đ ộng 2: Điều chỉnh ngắt trang

	GV: Chương trình bảng tự động phân trang tuỳ theo kích cỡ của trang tính.

GV: Để tự điều chỉnh cách ngắt trang theo ý mình ta làm như sau:

- Các đường viền xanh là các dấu ngắt trang. Chúng cho biết các trang in được phân chia như thế nào.
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GV: Thao tác trên máy chiếu cho học sinh quan sát.
	
	2. Điều chỉnh ngắt trang

- Để Điều chỉnh ngắt trang ta sử dụng lệnh Page Break Preview (xem ngắt trang) trong bảng chọn View.
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- Hiển thị trang tính trong  chế độ
Page Break Preview

- Đưa con trỏ vào đường kẻ xanh để phân chia.

- kéo thả đường xanh đến vị trí tuỳ ý muốn.
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	HS : Thực hiện trên máy tính cá nhân.


	


V. DẶN DÒ

     - Học kỹ bài

     - Chuẩn bị phần tiếp theo bài 7: Trình bày và in trang tính

Ngày soạn  :  …/…/2013
Ngày giảng : …/…/2013
Tiết: 46

(t2)
I -  MỤC TIÊU

a. Kiến thức

- Học sinh được học và sử dụng lệnh xem trước khi in trang tính, học các thao tác định dạng trang in, giấy in..

b. Kỹ Năng

- Học sinh biết cách định dạng trang in, biết xem trang in trước khi cho in ra máy.

II – PHƯƠNG PHÁP

- Hướng dẫn
III -  CHUẨN BỊ
-GV: Bài giảng 

- HS: Đọc trước bài ở nhà. bút vở


IV -  HOẠT ĐỘNG DẠY HỌC
	HOẠT ĐỘNG CỦA THẦY
	HOẠT ĐỘNG CỦA TRÒ
	NỘI DUNG

	Hoạt động 1: Đặt lề và hướng giấy in

	GV: Thông thường các trang in được đặt kích thước lề mặc định và hướng giấy in là hướng đứng.
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	HS: Quan sát trên máy tính theo chỉ dẫn của giáo viên.

HS: Thực hiện trên máy tính cá nhân.


	3. Đặt lề và hướng giấy in

- Nháy chuột tại bảng chọn File -> Page Setup (hình vẽ)
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	GV: Ta có thể thực hiện việc thay đổi các lề và hướng giấy in cho phù hợp với yêu cầu của mình.

GV: Hướng dẫn học sinh cách để in một trang tính ra giấy. Làm mẫu trực tiếp trên máy. 
	HS : Thực hiện trên máy tính.

HS : Quan sát và ghi chép
	- Nháy chuột để mở trang Margins. Các lề hiện tại được liệt kê trong các ô Top, Bottom. Right, Left.

- Thay đổi các thông sô trong các ô Top, Bottom. Right, Left  để thiết đặt lề.

* Để thay đổi hướng giấy:

- Nháy chuột mở trang Page 

- Chọn Potrait cho hướng giấy đứng hoặc Landscape cho hướng giấy nằm.



	                                                        Hoạt  động  2:  In trang tính

	- GV hướng dẫn và thao tác trên máy chiếu.
	- HS quan sát vả thực hiện.
	1. In trang tính

- Nháy chuột vào nút Print  trên thanh công cụ để in trang tính. (hoặc sử dụng bảng chọn)


Ngày soạn  :  …/…/2013
Ngày giảng : …/…/2013
Tiết: 47


I - MỤC TIÊU
a. Kiến thức

- Học sinh biết vận dụng lệnh xem trước khi in trang tính, các thao tác định dạng trang in, giấy in..

b. Kỹ Năng

- Biết kiểm tra trang tính trước khi in.

- Thiết lập lề và hướng giấy cho trang in

- Biết điều chỉnh các dấu ngắt trang phù hợp với yêu cầu in.

II -  PHƯƠNG PHÁP
Thực hành trực tiếp trên máy.

III -  CHUẨN BỊ
1. Giáo viên: Giáo trình, Phòng máy.

2. Học sinh: Chuẩn bị bài ở nhà. 

IV -  HOẠT ĐỘNG DẠY HỌC
	HOẠT ĐỘNG CỦA THẦY
	HOẠT ĐỘNG CỦA TRÒ
	NỘI DUNG

	                                             Hoạt động 1:  Kiểm ta bài cũ

	GV nêu câu hỏi:

HS1: Làm cách nào để có thể điều chỉnh trang in hợp lý?

HS2. Làm thế nào để có thể thay đổi hướng của giấy in?


	HS1: Để điều chỉnh trang in hợp lý ta dùng bảng chọn File( Print prewiew

HS2: Để thay đổi hướng giấy in ta vào bảng chọn File ( Page Setup.
	

	                                      Hoạt động 2: Bµi tËp 1. KiÓm tra trang tÝnh tr­íc khi in

	GV: Yêu cầu HS mở bảng tính Bảng điểm lớp em (đã lưu trong bài thực hành 6).

Ngoài nút lệnh Next  và Previous trên thanh công cụ Print Preview  còn có các nút lệnh khác vói những chức năng để phóng to/Thu nhỏ trang in, mở hộp thoại Page Setup để thiết đặt trang in, xem chi tiết các lề của trang in, chuyển sang chế độ xem trang in với các dấu ngắt trang và đóng chế độ xem trước khi in, trở về chế độ bình thường.

	HS: Quan sát trên màn chiếu và thực hiện theo các yêu cầu của giáo viên

HS: Thực hành trên máy cá nhân.


	Bài tập 1. Kiểm tra trang tính trước khi in

a) Sử dụng công cụ Print Preview để xem trang tính trước khi in.
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Bài thực hành 7: In danh sách lớp em

Hoạt động 1: Thực hành kiểm tra trang tính trước khi in

Mở bảng tính Bang diem lop em

Câu1:

Hãy nêu những thay đổi của màn hình, của trang tính khi ở chế độ

bình thường và ở chế độ

Print Preview

?

So sánh hai vùng làm việc

Chế độ

Print Preview

Chế độ bình thường


b) Tìm hiểu chức năng của các nút lệnh khác trên thanh công cụ Print Preview
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c) Sử dụng nút lệnh để xem các dấu ngắt trang.

d) Ghi nhận các khiếm khuyết về ngắt trang trên các trang in; liệt kê những hướng khắc phục khuyết điểm đó.

	    Hoạt động 3 : Bµi tËp 2. ThiÕt ®Æt lÒ trang in, h­íng giÊy vµ ®iÒu chØnh c¸c dÊu ng¾t trang.

	GV: Yªu cÇu HS tiÕp tôc sö dông b¶ng tÝnh B¶ng ®iÓm líp em.

a) Më hép tho¹i Page Setup. Trªn trang Margins cña hép tho¹i, quan s¸t vµ ghi nhËn c¸c th«ng sè ngÇm ®Þnh trong c¸c « Top, Bottom, Left  vµ Right,  sau ®ã thay ®æi c¸c th«ng sè nµy. Nh¸y OK sau mçi lÇn thay ®æi th«ng sè ®Ó thÊy t¸c dông trªn trang in. Cuèi cïng ®Æt c¸c th«ng sè nµy t­¬ng øng lµ 2; 1.5; 1.5 vµ 2.

b) trªn trang Page cña hép tho¹i  Page Setup , quan s¸t vµ ghi nhËn c¸c thiÕt ®Æt ngÇm ®Þnh Portrait ( ®øng ). §¸nh dÊu chän trong «  Landscape vµ quan s¸t t¸c dông. Cuèi cïng ®Æt l¹i h­íng giÊy ®øng.

c) Trë l¹i víi c¸c thiÕt ®Æt trang ®øng vµ kh«ng cã tû lÖ, kiÓm tra c¸c trang b»ng chÕ ®é hiÓn thÞ Page Break Preview. KÐo th¶ chuét ®Ó ®iÒu chØnh l¹i sao cho c¸c cét ®­îc in hÕt trªn mét trang, mçi trang in kho¶ng 25 hµng (h×nh)


	HS: Sö dông b¶ng tÝnh B¶ng ®iÓm líp em vµ thùc hµnh theo yªu cÇu cûa gi¸o viªn.

HS: Quan s¸t trªn mµn h×nh gi¸o viªn vµ thùc hiÖn theo c¸c yªu cÇu cña gi¸o viªn.

HS: Quan s¸t trªn mµn h×nh gi¸o viªn vµ thùc hiÖn theo c¸c yªu cÇu cña gi¸o viªn.
	Bµi tËp 2. ThiÕt ®Æt lÒ trang in, h­íng giÊy vµ ®iÒu chØnh c¸c dÊu ng¾t trang.
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V - DẶN DÒ
- Xem lại các nội dung thực hành trong SGK.

- Thực hành lại ở nhà nếu có điều kiện

Ngày soạn  :  …/…/2013
Ngày giảng : …/…/2013
Tiết: 48


I - MỤC TIÊU

a. Kiến thức

- Học sinh biết vận dụng lệnh xem trước khi in trang tính, các thao tác định dạng trang in, giấy in..

b. Kỹ Năng

- Biết kiểm tra trang tính trước khi in.

- Thiết lập lề và hướng giấy cho trang in

- Biết điều chỉnh các dấu ngắt trang phù hợp với yêu cầu in.

II - PHƯƠNG PHÁP
Thực hành trực tiếp trên máy.

III -  CHUẨN BỊ

1. Giáo viên: Giáo trình, Phòng máy.

2. Học sinh: Chuẩn bị bài ở nhà. 

IV -  HOẠT ĐỘNG DẠY HỌC

	HOẠT ĐỘNG CỦA THẦY
	HOẠT ĐỘNG CỦA TRÒ
	NỘI DUNG

	                                    Hoạt động 1:  Ôn lại các thao tác đã thực hiện

	- Kiểm tra trang tính trước khi in

- Thiết đặt lề trang in, hướng giấy và điều chỉnh các dấu ngắt trang.


	HS: Thực hiện theo yờu cầu của GV
	

	                                      Hoạt động 2: Bµi tËp 3: §Þnh d¹ng vµ tr×nh bµy trang tÝnh.

	- Yêu cầu: Dữ liệu trong hàng tiêu đề ( hàng 3) được căn giữa với kiểu chữ đậm và cỡ chữ to hơn.

- Dữ liệu trong các cột Stt, chiều cao, cân nặng được căn giữa; trong các cột Họ và tên, Địa chỉ, Điện thoại – căn tráI; trong cột  Ngày sinh – căn phải.

- Dữ liệu trong cột chiêu cao được định dạng với hai chữ số thập phân.

- Các hàng được tô màu nền phân biệt để dễ tra cứu.
	HS: Quan sát trên màn hình giáo viên và thực hiện theo các yêu cầu của giáo viên.

HS: Quan sát trên màn hình giáo viên và thực hiện theo các yêu cầu của giáo viên.


	Bài tập 3: Định dạng và trình bày trang tính.

a) Thực hiện các định dạng cần thiết để có trang tính tương tự hình 81 ( sgk).
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Bài thực hành 7: In danh sách lớp em

Bài tập 3: Thực hành định dạng và trình bày trang tính.



Mở bảng tính “

So theo doi the luc

” của bài thực hành 5, hãy thực hiện các thao tác định

dạng, căn chỉnh theo các yêu cầu dưới đây:


b) Xem trước trang in, kiểm tra các dấu ngắt trang và thiết đặt hướng trang nằm ngang để in hết các cột trên một trang, thiết đặt lề thích hợp và lựa chọn để in nội dung giữa trang giấy theo chiều ngang.

c) Lưu bảng tính và thực hiện lệnh in.

	                                                        Hoạt động 3 : Củng cố

	Xem l¹i c¸c néi dung trong tiÕt võa thùc hµnh
	
	


V - DẶN DÒ

- Xem lại các nội dung thực hành trong SGK.

- Thực hành lại ở nhà nếu có điều kiện

- Xem trước bài 8
Ngày soạn  :  …/…/2013
Ngày giảng : …/…/2013
Tiết: 49


I - MỤC TIÊU
a. Kiến thức

- Học sinh được trang bị kiến thức về sắp xếp và lọc dữ liệu trang tính..

b. Kỹ Năng

- Biết sắp xếp dữ liệu trong trang tính.

- Từ việc sắp xếp dữ liệu, học sinh có thể so sánh dữ liệu trong cùng một bảng tính.

II - PHƯƠNG PHÁP
Thuyết trình -  vấn đáp - Thực hành.
III -  CHUẨN BỊ
1. Giáo viên: Giáo trình, phòng máy.
2. Học sinh: Chuẩn bị bài ở nhà. 

IV -  HOẠT ĐỘNG DẠY HỌC
	HOẠT ĐỘNG CỦA THẦY
	HOẠT ĐỘNG CỦA TRÒ
	NỘI DUNG

	Hoạt động 1: kiểm tra bài cũ

	? Mở một bảng tính bất kỳ. Thực hiện thao tác thay đổi hướng của giấy in?


	TL: HS thực hiện trên máy tính cá nhân ( Giáo viên quan sát, nhận xét và cho điểm.
	

	                                                        Hoạt động 2: S¾p xÕp d÷ liÖu

	GV: Sắp xếp dữ liệu là hoán đổi vị trí các hàng để giá trị dữ liệu trong một hay nhiều cột được sắp xếp theo thứ tự tăng dần hoặc giảm dần.

GV: Thực hiện trên máy chiếu vµ cho HS quan s¸t.

GV: §Ó s¾p xÕp thø h¹ng cña HS theo ®iÓm Trung b×nh ta thùc hiÖn nh­ sau:

1. Nh¸y chuét chän mét « trong cét ®iÓm trung b×nh
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2. Nh¸y nót      trªn thanh c«ng cô

Ta sÏ nhËn ®­îc kÕt qu¶ t­¬ng tù nh­ h×nh minh ho¹.


	HS: Quan s¸t trªn máy chiếu vµ thùc hiÖn trªn m¸y tÝnh c¸ nh©n.
	1. Sắp xếp dữ liệu
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1. Sắp xếp dữ liệu


Ví dụ: Trang tính dưới đây là kết quả học tập của  một số HS lớp 7a.
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Sau khi sắp xếp được kết quả:
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V -  DẶN DÒ

- Xem lại các thao tác để sắp xếp dữ liệu trong bảng tính.

- Thực hành nếu có điều kiện.

Ngày soạn  :  …/…/2013
Ngày giảng : …/…/2013
Tiết: 50

(t2)
I - MỤC TIÊU

a. Kiến thức

- Học sinh được trang bị kiến thức về sắp xếp và lọc dữ liệu trang tính..

b. Kỹ Năng

- Biết lọc dữ liệu theo yêu cầu cụ thể.

II - PHƯƠNG PHÁP

Thuyết trình -  vấn đáp - Thực hành.

III -  CHUẨN BỊ

1. Giáo viên: Giáo trình, phòng máy.
2. Học sinh: Chuẩn bị bài ở nhà. 

IV -  HOẠT ĐỘNG DẠY HỌC
	HOẠT ĐỘNG CỦA THẦY
	HOẠT ĐỘNG CỦA TRÒ
	NỘI DUNG

	GV: Lọc dữ liệu là chọn và chỉ hiện thị các hàng thoả mãn các tiêu chuẩn nhất định nào đó.

-  Ví dụ: Lọc ra các học sinh có điểm trung bình tà 8.8 trở lên (hình minh hoạ)
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GV: Hướng dẫn học sinh thao tác trên máy tính.

GV: Hướng dẫn học sinh cách lọc hàng có giá trị lớn nhất hay nhỏ nhất.


	HS: Quan sát trên màn chiếu và thực hiện trên máy tính cá nhân.

HS: Quan sát và thực hiện trên máy tính cá nhân.

HS: Quan sát và thực hành.
	2. Lọc dữ liệu

Thực hiện các thao tác sau:

Bước 1. Chuẩn bị:
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Bước 1: Chuẩn bị

Yêu cầu: 

Lọc ra những bạn có số phiếu tổng kết là 60
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2. Lọc dữ liệu


sẽ xuất hiện các mũi tên như bảng sau:


Bước 2. Lọc:
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Bước 2: Lọc dữ liệu
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2. Lọc dữ liệu
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- Kết thúc lọc: Chọn Data ( Filter ( Show All (Hiển thị tất cả).

3. Lọc các hàng có giá trị lớn nhất hay nhỏ nhất
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VD: Chọn 3 học sinh có ĐTB lớn nhất: Chọn Top 10 ( Chọn ô thứ 2 có giá trị là 3 ( OK.


V -  DẶN DÒ

- Xem lại các thao tác để sắp xếp và lọc dữ liệu trong bảng tính.

- Thực hành nếu có điều kiện.

- Chuẩn bị trước bài thực hành 8: Ai là người học giỏi

Ngày soạn  :  …/…/2013
Ngày giảng : …/…/2013
Tiết: 51

(t1)
I - MỤC TIÊU
a. Kiến thức

-  Biết được các thao tác sắp xếp dữ liệu.

-  Biết khái niệm lọc dữ liệu.

b. Kỹ năng

- Thực hiện được thao tác sắp xếp dữ liệu trong trang tính.

- Biết cách lọc dữ liệu theo yêu cầu cụ thể.

- Từ việc sắp xếp dữ liệu, học sinh có thể so sánh dữ liệu trong cùng một bảng tính.

II – PHƯƠNG PHÁP

- Thực hành trên máy
III -  CHUẨN BỊ
1. Giáo viên: Giáo trình, Phòng máy.

2. Học sinh: Chuẩn bị bài ở nhà. 

IV -  HOẠT ĐỘNG DẠY HỌC
	HOẠT ĐỘNG CỦA THẦY
	HOẠT ĐỘNG CỦA TRÒ
	NỘI DUNG

	Hoạt động 1: Kiểm tra bài cũ

	?1 : Sắp xếp dữ liệu là gì ? Nêu các bước sắp xếp dữ liệu.
?2 : Lọc dữ liệu là gì ? Nêu các bước lọc dữ liệu.
	HS: Trả lời

HS: Trả lời
	

	Hoạt động 2: Bài tập 1

	GV : Yêu cầu học sinh khởi ffộng chương trình bảng tính Excel, mở bài Bang diem lop em và thực hành theo yêu cầu.

GV : Hướng dẫn sơ bộ học sinh cách thực hiện bài.


	HS: Nhận yêu cầu bài tập của giáo viên và thực hành. 

HS: Nghe chỉ dẫn và làm bài.

HS: Nhận đề bài, nghe hướng dẫn và làm bài thực hành
	Bài 1

a) Thực hiện các thao tác sắp xếp theo điểm các môn học và diẻm trung bình.

b) Thực hiện các thao tác lọc dữ liệu để chọn các bạn có điểm 10 môn Tin học.

c) Lọc ra các bạn có điểm trung bình cả năm là hai điểm thấp nhất.

	Hoạt đông 3: Bài tập 2

	GV : Giới thiệu bài tập 2 trang 77 SGK và ra yêu cầu của bài.

GV : Hướng dẫn học sinh cách làm bài.


	.

 
	Bài 2

a) Mở bảng tình Cac nuoc DNA đã có trong Bài thuc hanh 6.

b) Hãy sắp xếp các nước theo.

- Diện tích tăng dần hoặc giảm dần.

- Dân số tăng dần hặc giảm dần.

- Mật độ dân số tăng dần hặc giảm dần.

- Tỉ lệ dân số thành thị tăng dần hặc giảm dần. 




V - DẶN DÒ

- Đọc trước phần còn lại
Rút Kinh Nghiệm

……………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………….........................
Ngày soạn  :  …/…/2013
Ngày giảng : …/…/2013
Tiết: 52

(t2)
I - MỤC TIÊU

a. Kiến thức

-  Biết được các thao tác sắp xếp dữ liệu.

-  Biết khái niệm lọc dữ liệu.

b. Kỹ năng

- Thực hiện được thao tác sắp xếp dữ liệu trong trang tính.

- Biết cách lọc dữ liệu theo yêu cầu cụ thể.

- Từ việc sắp xếp dữ liệu, học sinh có thể so sánh dữ liệu trong cùng một bảng tính.

II – PHƯƠNG PHÁP

- Thực hành trên máy

III -  CHUẨN BỊ

1. Giáo viên: Giáo trình, Phòng máy.

2. Học sinh: Chuẩn bị bài ở nhà. 

IV -  HOẠT ĐỘNG DẠY HỌC
	HOẠT ĐỘNG CỦA THẦY
	HOẠT ĐỘNG CỦA TRÒ
	NỘI DUNG

	Hoạt động 1: Bài tập 2

	GV : Giới thiệu bài tập 2 trang 77 SGK và ra yêu cầu của bài.

GV : Hướng dẫn học sinh cách làm bài.

GV: Nhắc lại kiến thức về sắp xếp như đã thực hành ở tiết trước và ra tiếp bài yêu cầu học sinh thực hành với công cụ là lọc dữ liệu. 


	HS: Nhận yêu cầu bài tập của giáo viên và thực hành. 

HS: Nghe chỉ dẫn và làm bài.

HS: Nhận đề bài, nghe hướng dẫn và làm bài thực hành

HS: Nghe chỉ dẫn của giáo viên, nhận đề bài và thực hành. 


	Bài 2 (tiếp)

c) Sử dụng công cụ để lọc

- Lọc ra các nước có diện tích là năm diện tích lớn nhất.

- Lọc ra các nước có số dân là ba số dân ít nhất.

- Lọc ra các nước có mật ssộ dân số la ban mật độ dân số cao nhất.

	Hoạt đông 2: Bài tập 3

	GV: Hướng dẫn học sinh quan sát bài tập 3 – SGK trang 78.

- Đưa ra một số chỉ dẫn để các em hiểu và có khả năng thực hành được bài 

* Chú ý: Trong quá trình học sinh làm bài giáo viên đi lại quan sát và có thể gợi ý khi các em gặp vướng mắc.
	.

HS: Xem SGK và chú ý nghe hướng dẫn của giáo viên và thực hiện làm bài.

HS: Thực hiện làm bài và trả bài khi xong. 
	Bài 3

Tìm hiểu thêm về sắp xếp và lọc sữ liệu

(SGK trang 78)


V -  DẶN DÒ
- Ôn lại các kiến thức từ bài 6 để chuẩn bị cho kiểm tra một tiết.

Rút Kinh Nghiệm

……………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………….
Ngày soạn  :  …/…/2013
Ngày giảng : …/…/2013
Tiết: 53


I - MỤC TIÊU
a. Kiến thức 

- Kiểm tra việc nắm bắt kiến thức của học sinh về định dạng, trình bày, in ấn… để có phương pháp điều chỉnh về việc học của học sinh cũng như việc dạy của giáo viên.

b. Kỹ Năng

- Có kỹ năng làm một bài kiểm tra.

II – PHƯƠNG PHÁP

- Hoạt động cá nhân.

III.  CHUẨN BỊ
1. Giáo viên: Giáo trình, đề bài.

2. Học sinh: Chuẩn bị kiến thức các bài 6, 7, 8.

IV - TIẾN TRÌNH DẠY HỌC
Giáo viên phát đề bài, giám sát việc làm bài của học sinh.

                                                                   MA TRẬN ĐỀ:

	                    Mức độ

Nội dung
	         Hiểu
	              Biết
	    Vận dụng

	
	TN
	TL
	TN
	TL
	TN
	TL

	Đ ịnh d ạng trang t ính
	
	
	1,7,8,12,13,17,18,19,24,25,26,27,28,30
	
	
	

	Tr ình b ày v à in trang t ính
	
	
	21,22,23
	
	
	

	Sắp xếp và lọc dữ liệu
	14
	
	15,16
	
	
	

	Trình bày dữ liệu bằng biểu  đồ
	
	
	
	
	
	

	Sử dụng công thức và hàm
	2,4,6,

20
	
	3,5,....,29
	
	
	1,2,3

	Phần mềm học tập
	
	
	9,10
	
	
	


Đề bài
I. Trắc nghiệm (7,5đ)

Câu 1: Để lưu 1 trang trính ta cần sử dụng lệnh nào sau đây?

a. File/Open


b. File/Save

c. File/Exit

d. File/Print

Câu 2. Giả sử cần tính tổng các giá trị trong các ô C2 và D4, sau đó nhân với giá trị trong ô B2. Công thức nào sau đây là đúng?

a.   (C2+D4)*B2;

b. = C2+D4* B2;        
 c. =(C2+D4)*B2;

d. =(C2+D4)B2;

Câu 3: Địa chỉ ô C3 nằm ở :

a.  Cột II.  dòng 3

b.  Dòng II.  cột 3
 c.  Dòng II.  Dòng 3

d. Cột II.  cột 3

Câu 4: Cho dữ liệu trong các ô sau A1= 19; A2 = 12; A3 = 5.    = SUM (A1: A3) có kết quả là: 

a. 47



b. 25           

 c. 21


 
d. 36

Câu 5:  Nếu trong 1 ô tính có các ký hiệu ########, điều đó có nghĩa là?

a. Công thức nhập sai và bảng tính thông báo lỗi

b. Dòng chứa ô đó có độ cao thấp nên không hiển thị hết chữ số

c.Ô tính đó có độ rộng hẹp nên không hiển thị hết chữ số

d. Nhập sai dữ liệu.

Câu 6: Trong các công thức hàm sau công thức nào đúng?

    a. Sum (A1:A6)

b. Max(A1:A6)      
c. =Sum (A1; A6)

d. =Max(A1:A6).

Câu 7 : Nút sắp xếp tăng


a

[image: image71.png]




b

[image: image72.png]




c

[image: image73.png]|






d

[image: image74.png]|




Câu 8: Để sắp xếp điểm của một môn học (vd Tin học), bước đầu tiên là.

a. Bấm vào nút 
[image: image75.png]|




 


  
b. Ckck chuột vào cột Tin học

c. Tô đen hết vùng dữ liệu



c. Bấm vào nút 
[image: image76.png]





Câu 9 Để làm phép toán 3/4 + 7/9, ta dùng lệnh

a.  solve


b.  plot


c.  expand


d.  simplify

Câu 10 Để vẽ biểu đồ y=9*x + 3


a.  simplify


b.  expand

c.  solve


d.  plot

Câu ....: Hãy chọn câu đúng.

a. Mỗi ô có thể có nhiều địa chỉ khác nhau
b. Dấu = là dấu cuối cùng cần gõ khi nhập công thức vào ô

c. Thanh công thức và ô tính bao giở cũng giống nhau


d. Tất cả đều sai

Câu 12: Để chỉnh độ rộng của cột vừa khích với dữ liệu đã có trong cột cần thực hiện thao tác nào sau đây?

a. Nháy chuột trên vạch phân cách cột.

b. Nháy đúp chuột trên vạch phân cách cột.

c. Nháy chuột trên vạch phân cách dòng.

d. Cả 3 câu trên đều sai.

Câu 13: Để chèn thêm hàng em thực hiện các thao tác nào sau đây:

a. Click phải tại hàng chọn Insert.


b. Chọn hàng vào Insert chọn Rows.

c. Chọn hàng vào Insert chọn Columns.

d. Cả 2 câu a và b dều đúng.

Câu 14: Câu nào sau đây đúng?

    a.  Sắp xếp dữ liệu là hoán đổi vị trí của các hàng với nhau.
   



    b.  Sắp xếp dữ liệu là hoán đổi vị trí của các cột với nhau.

    c.  Sắp xếp dữ liệu là chỉ chọn và hiển thị những hàng thoả mãn các tiêu chuẩn nhất định nào đó.

    d.  Sắp xếp dữ liệu là chỉ chọn và hiển thị những cột thoả mãn các tiêu chuẩn nhất định nào đó.

Câu 15: Để lọc dữ liệu thực hiện lệnh

a.  Data. Filter/Show All;
                                  b.  Data. Filter/Advanced Filter;


c.  Data. Filter/AutoFilter;
                                  d.  Data. Filter/AutoFillter.

Câu 16: Tiêu chuẩn lọc Top 10 là tiêu chuẩn lọc:

a.  Hàng có giá trị cao nhất;



 b.  Hàng có giá trị thấp nhất;


c.  Cột có giá trị cao nhất hoặc thấp nhất;

 d.  Hàng có giá trị cao nhất hoặc thấp nhất.

Câu 17: Để gộp nhiều ô của trang tính thành một ô và thực hiện canh giữa dữ liệu chọn nút lệnh

a.  [image: image77.bmp];



b.   [image: image78.bmp]; 



c.  [image: image79.bmp];


d.  [image: image80.bmp] 

Câu 18:  Nút lệnh Sort Descending dùng để sắp xếp theo thứ tự :
a.  Tăng dần


b.  Giảmdần 

 c.  Theo thứ tự từ nhỏ đến lớn

d.  b và c đúng
Câu 19: Để thực hiện việc in văn bản sử dụng nút lệnh

   a.  [image: image81.bmp]
b.  [image: image82.bmp]
c.  [image: image83.bmp]

d.  b và c đúng

Câu 20: Hàm=Average(4,10,16) sẽ cho kết quả là bao nhiêu?

a. 30



b.10             

 c. 16



d. 4    

Câu 21: Tác dụng của nút lệnh Setup... trên thanh công cụ Print Preview dùng để
    a.  Xem trang trước




b.  Canh lề cho văn bản


    c.  Thay đổi hướng giấy



d.  Thiết đặt lề và hướng giấy

Câu 22: Tác dụng của nút lệnh Previous trên thanh công cụ Print Preview dùng để 

    a.  Xem trang kế tiếp



 
b.  Điều chỉnh chế độ ngắt trang


    c.  Xem trang trước




d.  Điều chỉnh hướng giấy 

Câu 23: Để thay đổi lề của trang in sử dụng lệnh sử dụng lệnh                       

    a.  File/Page Setup/chọn trang Magins

b.  File/Page Setup/chọn trang Sheet

    c.  File/Page Setup/chọn trang Page


d.  Cả a, b, c đều đúng

Câu 24: Để định dạng kiểu chữ đậm sử dụng nút lệnh trên thanh công cụ định dạng

    a.  [image: image84.bmp]


b.  [image: image85.bmp]



c.  [image: image86.bmp]



d.  a và c đúng

Câu 25: Nút lệnh  [image: image87.bmp]  dùng để canh dữ liệu theo:


    a.  Lề trái 

b.  Lề phải.



c. Canh giữa.


d.  Cả a,b,c.

Câu 26: Để định dạng màu chữ cho văn bản sử dụng nút nút lệnh:

    a.  Fill Color 
b.  Color Font.



c. Font Color.


d.  Color Fill.

Câu 27: Nút lệnh Fill Color dùng để
    a. Tô màu chư;õ
b.  Tô màu đường viền;
c.  Tô màu nền;


d.   a,b,c đều sai.

Câu 28: Để thiết đặt lề trên cho trang in chọn

    a.  Left;


b.  Bottom;


c.  Top;

          

d.  Right.

Câu 29: Ô A1 của trang tính có số 5.25 và ô B1 có số 6.24. Số trong ô C1 được định dạng là số nguyên. Nếu trong ô C1 có công thức =A1+B1, em nhận được kết quả là:

    a. 11
b. 15
c. 12


d. 11.49

Câu 30: Ô A1 có nền màu xanh chữ màu trắng. Ô A3 có nền trắng chữ đen. Nếu sao chép nội dung ô A1 vào ô A3 thì sẽ nhận được :

    a.  Nền màu trắng chữ màu xanh;


b.  Nền màu xanh chữ màu trắng; 



    c.  Nền màu đen chữ màu trắng;


d.  Nền màu trắng chữ màu đen.

II.  Tự Luận (2,5đ)

    Cho bảng tính sau:

	
	A
	B
	C
	D
	E
	F
	G
	H

	1
	STT
	Họ và Tên
	Miệng
	15 phút
	15 phút
	1 tiết
	Thi HK
	Điểm TB

	2
	1
	Lê Vân Anh
	6
	6
	5
	5
	8.3
	

	3
	2
	Trần Lê Bình
	7
	7
	7
	9
	7
	

	4
	3
	Nguyễn Hoàng Chinh
	6
	3
	5
	7
	6.5
	

	5
	4
	Trương Thị Hiền
	8
	6
	8
	6
	8
	

	6
	5
	Nguyễn Thành Lâm
	9
	8
	7
	7
	6
	

	7
	6
	Lê Văn Quyết
	6
	9
	8
	9
	7.3
	

	8
	7
	Lê Thu Thảo
	8
	5
	8
	5
	6
	


Câu hỏi:

1.Tính điểm trung bình của các học sinh sau biết: Điểm Miệng và 15 phút hệ số 1, 1 Tiết Hệ số 2, Điểm thi hệ số 3. (Chỉ cần Ghi công thức tính điểm Trung bình cho học sinh đầu tiên).  ( 1đ)

2. Viết công thức Tìm điểm trung bình cao nhất.  (0,75đ)

3. Viết công thức tính điểm trung bình thấp nhất. (0,75đ)








 ĐÁP ÁN
I. Ch ọn c âu tr ả lời đúng

	C âu
	1
	2
	3
	4
	5
	6
	7
	8
	9
	10
	11
	12
	13
	14
	15
	16
	17
	18
	19
	20

	Đ. Án
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	

	C âu 
	21
	22
	23
	24
	25
	26
	27
	28
	29
	30
	
	
	
	
	
	
	
	
	
	

	Đ. Án
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	


II. Tự luận

1. = C2+D2+E2+F2*2+G2*2      

2. = MAX(H2:H8)

3. =MIN(H2:H8)

Ngày soạn  :  …/…/2013
Ngày giảng : …/…/2013
Tiết: 54

(t1)
I -  MỤC TIÊU
a. Kiến thức

- Biết mục đích của việc sử dụng biểu đồ.

- Một số dạng biểu đồ thông thường.

-  Các bước cần thiết để tạo một biểu đồ từ bảng dữ liệu.

-  Thay đổi dạng biểu đồ đã tạo, xoá, sao chép biểu đồ vào văn bản Word.

b. Kỹ Năng

- Thực hiện thành thạo các thao tác với biểu đồ.

II – PHƯƠNG PHÁP

- Thuyết trình và thực hành trên máy.
III -  CHUẨN BỊ
1. Giáo viên: Giáo trình, Máy chiếu.

2. Học sinh: Nghiên cứu trước bài học ở nhà. 

IV -  HOẠT ĐỘNG DẠY HỌC
	HOẠT ĐỘNG CỦA THẦY
	HOẠT ĐỘNG CỦA TRÒ
	NỘI DUNG

	                                         Hoạt động 1: Minh ho¹ sè liÖu b»ng biÓu ®å

	GV: Chiếu một vài ví dụ lên máy chiếu cho thấy sự khác nhau khi biểu diễn bằng số liệu trên bảng tính và bằng biểu đồ.

GV: Theo em t¹i sao mét sè lo¹i d÷ liÖu l¹i ®­îc biÓu diÔn d­íi d¹ng biÓu ®å?


	HS: Suy nghÜ tr¶ lêi.


	1. Minh ho¹ sè liÖu b»ng biÓu ®å


[image: image88.emf]3

Bài 9. Trình bày dữ liệu bằng biểu đồ

Em hãy quan sát biểu đồ và

đưa ra nhận xét so sánh số

lượng học sinh giỏi của từng

lớp trong khối 7



Biểu đồ là cách minh hoạ dữ liệu sinh động và

trực quan.



Dễ so sánh dữ liệu hơn, dễ dự đoán xu thế

tăng hay giảm của dữ liệu.

1. Minh họa bằng biểu đồ

.



	                                                      Hoạt động 2: Mét sè d¹ng biÓu ®å

	? Trong ch­¬ng tr×nh phæ th«ng em ®· ®­îc häc c¸c lo¹i biÓu ®å nµo? 

- GV: Chiếu một số loại biểu đồ lên máy chiếu cho học sinh quan sát
 - Em cã biÕt t¸c dông riªng cña mçi lo¹i biÓu ®å Êy kh«ng?


	HS: Nhí l¹i vµ tr¶ lêi.

- HS quan sát và trả lời câu hỏi
	2. Mét sè d¹ng biÓu ®å


[image: image89.emf]4

Bài 9. Trình bày dữ liệu bằng biểu đồ

2. Một số loại biểu đồ

Bi

ể

u đ

ồ

c

ộ

t Bi

ể

u đ

ồ

đư

ờ

ng g

ấ

p khúc Bi

ể

u đ

ồ

hình tròn

Dùng để so sánh dữ liệu

có trong nhiều cột của

bảng dữ liệu.

Dùng để so sánh dữ liệu

và dự đoán xu thế tăng

hay giảm của dữ liệu.

Dùng để mô tả tỷ lệ

của từng dữ liệu

so với tổng các dữ liệu.



	Hoạt động 3: Tạo biểu đồ

	GV: Giới thiệu cách tạo biểu đồ trên chương trình bảng tính Excel.

GV: Hướng dẫn HS cách chọn biểu đồ phù hợp với nội dung dữ liệu.

- Hướng dẫn HS cách kiển tra miền dữ liệu.

GV: Giải thích cho HS các thông tin trong biểu đồ khi tạo.

GV: Khi tạo biểu đồ các em cần biết vị trí nơi đặt của biểu đồ.


	HS: Quan sát và ghi chép.

- Chú ý quan sát.

- Quan sát và thực hiện.

HS: Chú ý lắng nghe và ghi chép.

HS: Quan sát và ghi chép nội dung cần thiết.


	
[image: image90.emf]5

Bài 9. Trình bày dữ liệu bằng biểu đồ

3. Tạo biểu đồ

Để tạo một biểu đồ, em thực hiện các thao tác sau đây:

–

Chọn một ô trong bảng dữ liệu cần vẽ biểu đồ. 

–

Nháy nút

Chart Wizard      

trên thanh công cụ.

–

Nháy liên tiếp nút

Next

trên các hộp thoại và nháy nút

Finish 

trên hộp thoại

cuối cùng (khi nút

Next

bị mờ đi). Kết quả được biểu đồ sau:

.


[image: image91.emf]6

Bài 9. Trình bày dữ liệu bằng biểu đồ



Bước 1 

– Chọn dạng biểu đồ

3. Tạo biểu đồ



[image: image92.emf]8

Bài 9. Trình bày dữ liệu bằng biểu đồ



Bước 2

– Xác định miền dữ liệu để vẽ biểu đồ

3. Tạo biểu đồ

.


[image: image93.emf]9

Bài 9. Trình bày dữ liệu bằng biểu đồ



Bước 3

– Các thông tin giải thích biểu đồ

Hiển thị hay 

ẩn các trục

Hiển thị các

đường lưới

Hiển thị hay ẩn chú thích; 

chọn các vị trí thích hợp

cho chú thích

3. Tạo biểu đồ



[image: image94.emf]10

Bài 9. Trình bày dữ liệu bằng biểu đồ



Bước 4

– Chọn vị trí đặt biểu đồ



As object in

: chèn biểu đồ vào trang tính chứa danh sách dữ liệu.



As new sheet

: một trang tính mới được tạo ra và biểu đồ được chèn vào trang

đó.

3. Tạo biểu đồ




V - DẶN DÒ
- Hướng dẫn HS về ôn bài, đọc trước phần còn lại.
Rút kinh nghiệm

.............................................................................................................................................................................................................................................................................................................................................................................................................................................................................. ………………..
Ngày soạn  :  …/…/2013
Ngày giảng : …/…/2013
Tiết: 55

(t2)
I -  MỤC TIÊU
a. Kiến thức

- Biết mục đích của việc sử dụng biểu đồ.

- Một số dạng biểu đồ thông thường.

-  Các bước cần thiết để tạo một biểu đồ từ bảng dữ liệu.

-  Thay đổi dạng biểu đồ đã tạo, xoá, sao chép biểu đồ vào văn bản Word.

b. Kỹ Năng

- Thực hiện thành thạo các thao tác với biểu đồ.

II – PHƯƠNG PHÁP

- Thuyết trình và thực hành trên máy.

III -  CHUẨN BỊ
1. Giáo viên: Giáo trình, Máy chiếu.

2. Học sinh: Nghiên cứu trước bài học ở nhà. 

IV -  HOẠT ĐỘNG DẠY HỌC

	HOẠT ĐỘNG CỦA THẦY
	HOẠT ĐỘNG CỦA TRÒ
	NỘI DUNG

	                                         Hoạt động 1: ChØnh söa biÓu ®å

	GV: Hướng dẫn HS các cách chỉnh sửa biểu đồ:

-  Thay đổi vị trí.

-  Thay đổi dạng biểu đồ.

-  Xoá biểu đồ.

- Sao chép biểu đồ vào văn bản Word.
	-  Thưc hành lại các thao tác dưới sự hướng dẫn của GIV/

	
[image: image95.emf]12

Bài 9. Trình bày dữ liệu bằng biểu đồ

4. Chỉnh sửa biểu đồ

a. Thay đổi vị trí của biểu đồ

- Để thay đổi vị trí của biểu đồ, em hãy nháy chuột trên biểu đồ để

chọn và kéo thả đến vị trí mới.

b. Thay đổi dạng biểu đồ



[image: image96.emf]13

Bài 9. Trình bày dữ liệu bằng biểu đồ

c. Xóa biểu đồ.

- Nháy chuột trên biểu đồ và nhấn phím Delete

d. Sao chép biểu đồ vào văn bản Word

1. Nháy chuột trên biểu đồ và nháy nút lệnh

Copy

.

2. Mở văn bản Word và nháy nút lệnh

Paste 

trên thanh công cụ

của Word.

4. Chỉnh sửa biểu đồ



	Hoạt động 2: Củng cố

	- Củng cố lại các kiến thức cơ bản của việc sử dụng biểu đồ trong chương trình bảng tính.

-  Cách chèn biểu đồ vào văn bản Word.


	- HS trả lời

- HS trả lời
	


V - DẶN DÒ
- Hướng dẫn HS về ôn bài, đọc trước bài thực hành số 9.

 Rút kinh nghiệm

........................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................
Ngày soạn  :  …/…/2013
Ngày giảng : …/…/2013
Tiết: 56

(t1)
I -  MỤC TIÊU
a. Kiến thức

- Ôn lại cách nhập các công thức và hàm vào ô tính.

- Thực hiện được các thao tác tạo biểu đồ đơn giản.

b. Kỹ Năng

- Thực hiện thành thạo thao tác vẽ biểu đồ, các cách tính toán trong ô tính.

II – PHƯƠNG PHÁP
- Thuyết trình và thực hành trên máy.

III -  CHUẨN BỊ
1. Giáo viên: Giáo trình, Phòng máy.

2. Học sinh: Nghiên cứu trước bài học ở nhà. 

IV -  HOẠT ĐỘNG DẠY HỌC
	HOẠT ĐỘNG CỦA THẦY
	HOẠT ĐỘNG CỦA TRÒ
	NỘI DUNG

	Hoạt động 1:Ôn tập lý thuyết

	GV :Chiếu các câu hỏi lên máy chiếu và yêu cầu học sinh nhớ lại kiến thức và trả lời
	HS: Theo dõi và trả lời các câu hỏi trên máy chiếu
	
[image: image97.emf]Bài thực hành 9: Tạo biểu đồ để minh hoạ
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hình tròn

Dùng để so sánh dữ liệu

có trong nhiều cột của

bảng dữ liệu.

Dùng để so sánh dữ liệu

và dự đoán xu thế tăng

hay giảm của dữ liệu.

Dùng để mô tả tỷ lệ

của từng dữ liệu

so với tổng các dữ liệu.

Câu 1. Những loại biểu đồ nào hay được sử dụng ?

I. ÔN TẬP LÝ THUYẾT



	Hoạt động 2: Bài tập 1

	GV: Yêu cầu HS mở máy, khởi động chương trình bảng tính Excel, nhập dữ liệu vào trang tính như hình 113.

? Tính cột Tổng cộng ta làm ntn? 

GV: Yêu cầu HS thực hiện tạo biểu đồ với khối dữ liệu A4:D9.

? Để có được dữ liệu như hình 114 ta làm ntn?

GV: Yêu cầu HS xoá cột Nam trong bảng dữ liệu.

GV: Yêu cầu HS thực hiện tạo biểu đồ với khối dữ liệu A4:C9.


	HS: Mở máy tính, khởi động Excel và nhập dữ liệu vào trang tính.

=SUM(B5,C5)

HS: Thực hành theo yêu cầu của giáo viên.

HS: Trả lời.

HS: Thực hiện thao tác xoá cột.

HS: Thực hành theo yêu cầu của giáo viên.
	1. Bài tập 1

a) Nhập dữ liệu


[image: image98.emf]Bài thực hành 9: Tạo biểu đồ để minh hoạ

II. THỰC HÀNH

Bài tập 1.

a)

Khởi động bảng tính Excel, nhập dữ liệu vào trang tính (h. 113, 

SGK), có thể nhập theo số liệu khác và thêm lớp ở cột A;

b)

Tạo biểu đồ trên cơ sở dữ liệu của khối A4:D9;

c)

Thực hiện thao tác cần thiết để có trang tính như hình 114, SGK;

d)

Tạo biểu đồ cột trên cơ sở dữ liệu của khối A4:C9.

Hình 113 Hình 114


=SUM(B5,C5)

b) Tạo biểu đồ với dữ liệu khối A:D9

c) Thực hiện các thao tác để có trang tính như hình 114

d) Tạo biểu đồ với dữ liệu khối A4:C9

	                                                     Hoạt động 3: Bµi tËp 2

	- Yêu cầu HS tạo mới biểu đồ đường gấp khúc với khối dữ liệu A4:C9.

- Yêu cầu HS đổi biểu đồ  mục d của BT1 thành biểu đồ đường gấp khúc.

- Yêu cầu HS so sánh kết quả nhận được ở mục a.

? Để thay đổi dạng biểu đồ ta làm ntn?

- Yêu cầu HS thay đổi dạg biểu đồ như hình 116.
	HS: Tạo mới biểu đồ đường gấp khúc.

- Đổi biểu đồ mục d bài tập 1 thành biểu đồ đường gấp khúc.

HS: Quan sát so sánh và nhận xét.

HS: Trả lời.


	2. Bài tập 2

a) Tạo biểu đồ đường gấp khúc với dữ liệu khối A 4:C9


[image: image99.emf]Bài thực hành 9: Tạo biểu đồ để minh hoạ

Hoạt động 3:

Phiếu bài tập 2. Học sinh phải sử dụng lại các kết quả của bài tập 1 và

thực hành trên máy các yêu cầu sau:

Hình 115

a)

Tạo mới một biểu đồ đường thẳng trên cơ sở dữ liệu của khối A4:C9  (h. 

114, SGK);

b)

Nháy chọn lại biểu đồ cột đã tạo trong mục d) của Bài tập 1 và đổi dạng

biểu đồ thành biểu đồ đường thẳng. So sánh với kết quả nhận được ở mục

a);

c)

Đổi dạng biểu đồ vừa nhận được ở mục b) thành biểu đồ hình tròn bằng

cách nháy nút trên thanh công cụ

Chart

và chọn biểu tượng

(h.115, SGK). Nhận xét về dữ liệu xử lí của biểu đồ đã tạo ở mục b) và biểu

đồ vừa tạo; 

d)

Thực hiện thao tác xoá cột để có trang tính như hình 117, SGK;

e)

Tạo biểu đồ hình tròn trên cơ sở dữ liệu của khối A4:B9. Kết quả của em sẽ

tương tự như hình 118, SGK. Đổi biểu đồ nhận được thành biểu đồ đường

thẳng và sau đó thành biểu đồ cột;

f)

Lưu bảng tính với tên Hoc sinh gioi khoi 7.


b) Thay đổi dạng biểu đồ
c) Thay đổi dạng biểu đồ


V - DẶN DÒ

- Hướng dẫn HS về ôn bài
Rút kinh nghiệm

.........................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................
Ngày soạn  :  …/…/2013
Ngày giảng : …/…/2013
Tiết: 57

(t2)
I -  MỤC TIÊU
a. Kiến thức

- Ôn lại cách nhập các công thức và hàm vào ô tính.

- Thực hiện được các thao tác tạo biểu đồ đơn giản.

b. Kỹ Năng

- Thực hiện thành thạo thao tác vẽ biểu đồ, các cách tính toán trong ô tính.

c. Phương pháp
- Thuyết trình và thực hành trên máy.

II -  CHUẨN BỊ
1. Giáo viên: Giáo trình, Phòng máy.

2. Học sinh: Nghiên cứu trước bài học ở nhà. 

III -  TIẾN TRÌNH DẠY HỌC 
	HOẠT ĐỘNG CỦA THẦY
	HOẠT ĐỘNG CỦA TRÒ
	NỘI DUNG

	Hoạt động 1: Bài tập 2

	? Để xoá cột ta làm ntn?

- Yêu cầu HS thực hiện thao tác xoá cột để có trang tính như hình ....7.

GV : Yêu cầu HS tạo biểu đồ hình tròn trên cơ sở dữ liệu của khối A4:B9.

- Yêu cầu HS đổi biểu đồ nhận được thành biểu đ đường gấp khúc và biểu đồ cột.

? Để lưu bảng tính ta làm ntn?


	HS: Trả lời.

HS: Thực hiện theo yêu cầu.

HS: Trả lời.

HS: Làm theo yêu cầu của GIV/
HS: Thực hiện thao tác đổi biểu đồ.


	2. Bài tập 2

d) Xoá cột

e) Tạo biểu đồ hình tròn

g) Lưu bảng tính



	                                                     Hoạt động 2: Bµi tËp 3

	GV: Yêu cầu HS mở bảng tính “Bảng điểm lớp em” đã lưu trong bài thực hành 7.

GV: Yêu cầu HS tính điểm trung bình theo từng môn.

- Yêu cầu HS tạo biẻu đồ cột để minh hoạ ĐTB của các môn học.

? Để sao chép biểu đồ trên trang tính vào Word ta làm ntn?

- Yêu cầu HS thực hiện thao tác sao chép sang Word.
	HS: Làm theo yêu cầu.

HS: Trả lời.

HS: Trả lời.

HS: Thực hành theo yêu cầu của GIV/
	3. Bài tập 3

a) Tính ĐTB theo từng môn học của cả lớp vào hàng dưới cùng của danh sách dữ liệu

b) Tạo biểu đồ hình cột

c) Sao chép biểu đồ được tạo trên trang tính vào văn bản Word


IV - DẶN DÒ

- Hướng dẫn HS về ôn bài, đọc trước bài học vẽ hình học động với Geogebra.

Rút kinh nghiệm

..............................................................................................................................................................................................................................................................................................................................................................................................................................................................................
Ngày soạn  :  …/…/2013
Ngày giảng : …/…/2013
Tiết: 58


I -  MỤC TIÊU
a. Kiến thức

- Kiểm tra việc nắm bắt kiến thức thực hành của học sinh về trình bày, định dạng, s dụng  công thức tính toán, vẽ biểu dồ, sắp xếp và lọc dữ liệu.

b. Kỹ Năng

- Có kĩ năng tư duy, vận dụng kiến thức vào thực hành.

II – PHƯƠNG PHÁP


- Hoạt động cá nhân.. 

III -  CHUẨN BỊ

1. Giáo viên: Đề bài kiểm tra, Phòng máy.

2. Học sinh: Kiến thức đã học. 

IV -  TIẾN TRÌNH DẠY HỌC 






ĐỀ BÀI
Cho bảng tính

	Stt
	A
	B
	C
	D
	E
	F

	1
	Lớp
	Gỏi
	Khá
	T.bình
	Yếu
	Tổng cộng

	2
	6A
	5
	15
	9
	0
	?

	3
	6B
	4
	11
	5
	0
	?

	4
	6C
	6
	16
	5
	0
	?

	5
	6D
	9
	20
	4
	0
	?

	6
	6E
	5
	16
	8
	0
	?

	7
	7A
	4
	19
	8
	3
	?

	8
	7B
	2
	18
	10
	5
	?

	9
	7C
	1
	14
	15
	1
	?

	10
	7D
	10
	20
	4
	0
	?

	....
	7E
	15
	21
	6
	0
	?


Yêu cầu

1. Khởi động Excel, nhập dữ liệu và trình bày theo mẫu trên.

2. Sử dụng hàm để tính cột Tổng cộng.

3. Tạo biểu đồ cột trên cơ sở dữ liệu của khối A2:E12 có giải thích trục đứng, trục ngang).

4. Lọc ra lớp có số học sinh giỏi nhiều nhất.

Đáp án + Biểu điểm

	Câu
	Đáp án
	Biểu điểm

	1
	Khởi động Excel, nhập dữ liệu và trình bày theo mẫu 
	2

	2
	Trong cột F nhập công thức
	5

	
	=SUM(B2:E2)
	0.5

	
	=SUM(B3:E3)
	0.5

	
	=SUM(B4:E4)
	0.5

	
	=SUM(B5:E5)
	0.5

	
	=SUM(B6:E6)
	0.5

	
	=SUM(B7:E7)
	0.5

	
	=SUM(B8:E8)
	0.5

	
	=SUM(B9:E9)
	0.5

	
	=SUM(B10:E10)
	0.5

	
	=SUM(B11:E11)
	0.5

	3
	Tạo biểu đồ đúng (Có giải thích trục đứng, trục ngang)
	1

	4
	- Lọc được lớp có số học sinh giỏi nhiều nhất
	1

	
	- Trình bày đẹp, chính xáII.  nhanh
	1


V – DẶN DÒ

- Hướng dẫn HS về nhà chuẩn bị cho bài ôn tập cuối năm.

 Rút kinh nghiệm

____________________________________________________________________________________________________________________________________________________________________________________________________________________________________
Ngày soạn  :  …/…/2013
Ngày giảng : …/…/2013
Tiết: 59


I -  MỤC TIÊU
a. Kiến thức

- Củng cố lại cho HS cách lập trang tính, định dạng, sử dụng công thứII.  các hàm và trình bày trang in.

- Sử dụng nút lệnh Print Preview để xem trước khi in.

b. Kỹ Năng

- Thực hiện thành thạo các thao tác trong trang tính.

II – PHƯƠNG PHÁP

- Thuyết trình và thực hành trên máy.
III -  CHUẨN BỊ
1. Giáo viên: Giáo trình, Phòng máy.

2. Học sinh: Nghiên cứu trước bài học ở nhà. 

IV -  TIẾN TRÌNH DẠY HỌC 
	HOẠT ĐỘNG CỦA THẦY
	HOẠT ĐỘNG CỦA TRÒ
	NỘI DUNG

	Hoạt động 1: Bài tập 1

	GV: Yêu cầu HS khởi động Excel và nhập dữ liệu vào trang tính như hình 119.

-  Nờu cỏc bước để chốn thờm cột và hang ?

- Để điều chỉnh độ rộng cột, độ cao hàng ta làm ntn?

? Nêu các thao tác để kẻ khung cho ô tính?

? Để tạo màu nền cho ô tính ta làm ntn?

? Để tạo màu chữ cho ô tính ta làm ntn?

? Nhắc lại các thao tác sao chép và chỉnh sửa dữ liệu trong ô tính.

	HS: Mở máy, khởi động Excel và nhập dữ liệu.
HS: Suy nghĩ trả lời.

HS: Suy nghĩ trả lời.

HS: Suy nghĩ trả lời.

HS: Suy nghĩ trả lời.

HS: Suy nghĩ trả lời.

HS: Trả lời.


	1. Bài tập 1

a) Khởi động chương trình bảng tính Excel và nhập dữ liệu vào trang tính
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b) Điều chỉnh hàng, cột và định dạng
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c) Sao chép và chỉnh sửa dữ liệu
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V - DẶN DÒ
- Nhận xét giờ học.  ý thức làm bài và kết quả bài làm của HS. 

- Hướng dẫn HS về nhà ôn tập và đọc trước các phần tiếp theo.

 Rút kinh nghiệm

__________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________
Ngày soạn  :  …/…/2013
Ngày giảng : …/…/2013
Tiết: 60


I -  MỤC TIÊU
a. Kiến thức

- Củng cố lại cho HS cách lập trang tính, định dạng, sử dụng công thứII.  các hàm và trình bày trang in.

- Sử dụng nút lệnh Print Preview để xem trước khi in.

b. Kỹ Năng

- Thực hiện thành thạo các thao tác trong trang tính.

II – PHƯƠNG PHÁP

- Thuyết trình và thực hành trên máy.

III -  CHUẨN BỊ
1. Giáo viên: Giáo trình, Phòng máy.

2. Học sinh: Nghiên cứu trước bài học ở nhà. 

IV -  TIẾN TRÌNH DẠY HỌC 
	HOẠT ĐỘNG CỦA THẦY
	HOẠT ĐỘNG CỦA TRÒ
	NỘI DUNG

	                                                         Hoạt động 1: Bµi tËp 1

	GV: Yêu cầu HS mở bảng tính Bài tập 1 đã lưu.

? Để tính cột tổng cộng ta làm ntn?

? Tại sao cần xem trang tính trước khi in?

? Để xem trước khi in ta làm ntn? 


	HS: Thực hiện theo yêu cầu của GV và trả lời câu hỏi.

HS: Trả lời.

HS: Thực hiện thao tác.


	1. Bài tập 1

d) Lập công thức để tính tổng số  hiện vật

- Dùng công thức:

=D5+D14

-  Dùng hàm:

=SUM(D5,D14)

e) Xem trước trang in



	                                                     Hoạt động 2: Bài tập 2

	GV: Yêu cầu HS nhập dữ liệu vào trang tính.

? Để tính cột tổng cộng ta làm ntn?

? Để tính thu nhập trung bình theo từng ngành ta làm ntn?

GV: Yêu cầu HS lưu lại bảng tính với tên Baitap2.

GV: Giám sát việc thực hành của HS, hướng dẫn HS khi cần.
	HS: Nhập dữ liệu.

HS: Trả lời.

HS: Trả lời.

HS: Thực hiện thao tác lưu lại trang tính theo yêu cầu GIV/

	2. Bài tập 2
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V - DẶN DÒ

- Nhận xét giờ họII.  ý thức làm bài và kết quả bài làm của HS. 

- Hướng dẫn HS về nhà ôn tập và đọc trước các phần tiếp theo.

 Rút kinh nghiệm

___________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________
Ngày soạn  :  …/…/2013
Ngày giảng : …/…/2013
Tiết: 61


I -  MỤC TIÊU
a. Kiến thức

- Củng cố lại cho HS cách chỉnh sửa, chén thêm hàng, định dạng văn bản, sắp xếp và lọc dữ liệu.

b. Kỹ Năng

- Thực hành thành thạo các thao tác.

II – PHƯƠNG PHÁP

- Thuyết trình và thực hành trên máy.
III -  CHUẨN BỊ
1. Giáo viên: Giáo trình, Phòng máy.

2. Học sinh: Nghiên cứu trước bài học ở nhà. 

IV -  TIẾN TRÌNH DẠY HỌC 
	HOẠT ĐỘNG CỦA THẦY
	HOẠT ĐỘNG CỦA TRÒ
	NỘI DUNG

	Hoạt động 1: Bài tập 2

	GV: Yêu cầu HS mở máy tính, khởi động Excel và mở bảng tính Baitap2.

? Để cho tiêu đề của bảng “Thu nhập bình quân theo đầu người” ra giữa ta làm ntn?

? Để chọn màu cho chữ ta làm ntn?

? Nêu thao tác chèn thêm 1 hàng.

GV: Yêu cầu HS trình bày giống mẫu hình 123.

? Để sắp xếp tên xã với thứ tự a, b, c ta làm ntn?

? Để sắp xếp thu nhập bình quân về nông nghiệp với thứ tự giảm dần ta làm ntn?

? Để lọc dữ liệu trong trang tính ta làm ntn?

? Em hãy thực hiện thao tác lọc dữ liệu lấy 3 xã thu nhập bình quân về nông nghiệp cao nhất.

? Để thoát khỏi chế độ lọc ta làm ntn?

GV : Yêu cầu HS lưu lại trang tính với tên Thongke.

ntn ?

GV : Giám sát việc thực hành của HS, hướng dẫn các em khi cần thiết.
	HS: Mở máy, khởi động Excel và mở bảng tính Baitap2. 

HS: Trả lời.

HS: Trả lời.

HS: Nhớ lại kiếm thức lý thuyết và trả lời.

HS: Suy nghĩ trả lời.

HS: Trả lời.

HS: Thực hành theo yêu cầu của GIV/
HS: Trả lời.

HS: Thực hiện thao tác lưu trang tính.

HS: Mở bảng tính Baitap2.

HS: Trả lời.


	Bài tập 2
c) Chỉnh sửa và chèn thêm hàng

-   Chỉnh sửa

-  Chèn hàng

d) Sắp xếp các xã 

- Theo tên xã với thứ tự a, b, c.

- Sắp xếp giảm dần.

e) Lọc dữ liệu

Data -> Filter -> AutoFilter -> Chọn Top 10. XHHT, chọn Top 3 -> OK.




V - DẶN DÒ

- Giáo viên đến từng máy kiểm tra kết quả thực hành của HS.

- Nhận xét giờ họII.  ý thức làm bài và kết quả bài làm của HS. 

- Hướng dẫn HS về nhà ôn tập và đọc trước các phần tiếp theo.

 Rút kinh nghiệm

______________________________________________________________________________________________________________________________________________________________________________________________________________________________________
Ngày soạn  :  …/…/2013
Ngày giảng : …/…/2013
Tiết: 62


I -  MỤC TIÊU
a. Kiến thức

- Củng cố cách tạo biểu đồ, trình bày trang in, sao chép vùng dữ liệu và di chuyển biểu đồ.

b. Kỹ Năng

- Thực hành thành thạo các thao tác.

II – PHƯƠNG PHÁP

- Thuyết trình và thực hành trên máy.

III -  CHUẨN BỊ
1. Giáo viên: Giáo trình, Phòng máy.

2. Học sinh: Nghiên cứu trước bài học ở nhà. 

IV -  TIẾN TRÌNH DẠY HỌC 
	HOẠT ĐỘNG CỦA THẦY
	HOẠT ĐỘNG CỦA TRÒ
	NỘI DUNG

	Hoạt động 1: Bài tập 3

	GV: Yêu cầu HS mở Baitap2 đã lưu trong máy.

? Để sao chép cột B và cột D sang vùng khác ta làm ntn?

? Để vẽ biểu đồ ta sử dụng nút lệnh nào ?

? Em hãy thực hiện thao tác sao chép hàng dữ liệu sang vùng khác.

GV: yêu cầu HS vẽ biểu đồ như mẫu hình 125.

? Để di chuyển biểu đồ ta làm ntn?

GV : Yêu cầu HS di chuyển biểu đồ.

? Để xem trước khi in ta làm ntn ?

GV : Giám sát việc thực hành của HS, hướng dẫn các em khi cần thiết.
	HS: Trả lời. (Chart Wizard).

HS: Thực hiện thao tác.

HS: Thực hiện thao tác vẽ biểu đồ.

HS: Trả lời.

HS: Thực hiện di chuyển biểu đồ theo yêu cầu.

HS: Sử dụng Print Preview.

HS: Thực hành.
	3. Bài tập 3

Tạo biểu đồ và trình bày trang in.

a) Sao chép cột và vẽ biểu đồ
b) Sao chép hàng và vẽ biểu đồ
c) Di chuyển biểu đồ và trình bày trang in

d) Xem trước khi in


V - DẶN DÒ

- Giáo viên đến từng máy kiểm tra kết quả thực hành của HS.

- Nhận xét giờ họII.  ý thức làm bài và kết quả bài làm của HS. 

- Ôn lại toàn bộ các bài, tiết sau kiểm tra 1 tiết thực hành

 Rút kinh nghiệm

______________________________________________________________________________________________________________________________________________________________________________________________________________________________________
Tiết: 66                                                                                                          Ngày Soạn: 5/04/10
Tuần: 33                                                                                                       Ngày dạy : ..../04/10
KIỂM TRA THỰC HÀNH
I -  MỤC TIÊU
a. Kiến thức

- Kiểm tra việc nắm bắt kiến thức thực hành của học sinh về trình bày, định dạng, s dụng  công thức tính toán, vẽ biểu dồ, sắp xếp và lọc dữ liệu.

b. Kỹ Năng

- Có kĩ năng tư duy, vận dụng kiến thức vào thực hành.

II – PHƯƠNG PHÁP


- Hoạt động cá nhân.. 

III -  CHUẨN BỊ
1. Giáo viên: Đề bài kiểm tra, Phòng máy.

2. Học sinh: Kiến thức đã học. 

IV -  TIẾN TRÌNH DẠY HỌC 






ĐỀ BÀI
Cho bảng tính

	Stt
	A
	B
	C
	D
	E
	F

	1
	Lớp
	Gỏi
	Khá
	T.bình
	Yếu
	Tổng cộng

	2
	6A
	5
	15
	9
	0
	?

	3
	6B
	4
	11
	5
	0
	?

	4
	6C
	6
	16
	5
	0
	?

	5
	6D
	9
	20
	4
	0
	?

	6
	6E
	5
	16
	8
	0
	?

	7
	7A
	4
	19
	8
	3
	?

	8
	7B
	2
	18
	10
	5
	?

	9
	7C
	1
	14
	15
	1
	?

	10
	7D
	10
	20
	4
	0
	?

	....
	7E
	15
	21
	6
	0
	?


Yêu cầu

1. Khởi động Excel, nhập dữ liệu và trình bày theo mẫu trên.

2. Sử dụng hàm để tính cột Tổng cộng.

3. Tạo biểu đồ cột trên cơ sở dữ liệu của khối A2:E12 có giải thích trục đứng, trục ngang).

4. Lọc ra lớp có số học sinh giỏi nhiều nhất.

Đáp án + Biểu điểm

	Câu
	Đáp án
	Biểu điểm

	1
	Khởi động Excel, nhập dữ liệu và trình bày theo mẫu 
	2

	2
	Trong cột F nhập công thức
	5

	
	=SUM(B2:E2)
	0.5

	
	=SUM(B3:E3)
	0.5

	
	=SUM(B4:E4)
	0.5

	
	=SUM(B5:E5)
	0.5

	
	=SUM(B6:E6)
	0.5

	
	=SUM(B7:E7)
	0.5

	
	=SUM(B8:E8)
	0.5

	
	=SUM(B9:E9)
	0.5

	
	=SUM(B10:E10)
	0.5

	
	=SUM(B11:E11)
	0.5

	3
	Tạo biểu đồ đúng (Có giải thích trục đứng, trục ngang)
	1

	4
	- Lọc được lớp có số học sinh giỏi nhiều nhất
	1

	
	- Trình bày đẹp, chính xáII.  nhanh
	1


V – DẶN DÒ

- Hướng dẫn HS về nhà chuẩn bị cho bài ôn tập cuối năm.

 Rút kinh nghiệm

____________________________________________________________________________________________________________________________________________________________________________________________________________________________________

Tiết: 67                                                                                                          Ngày Soạn: 5/04/09

Tuần: 34                                                                                                       Ngày dạy : ..../04/09

ÔN TẬP
I -  MỤC TIÊU
a. Kiến thức

- Tổng hợp kiến thức về định dạng trang tính, trình bày và in trang tính.

- Củng cố cách sắp xếp và lọc dữ liệu, cách tạo biểu đồ minh hoạ dữ liệu.

b. Kỹ Năng

- Hình thành kĩ năng tư duy tổng hợp, thành thạo các thao tác.

II – PHƯƠNG PHÁP

- Thuyết trình và thực hành trên máy.. 

III -  CHUẨN BỊ
1. Giáo viên: Giáo trình, Phòng máy.

2. Học sinh. Các kiến thức đã học.

IV -  TIẾN TRÌNH DẠY HỌC 

	HOẠT ĐỘNG CỦA THẦY
	HOẠT ĐỘNG CỦA TRÒ
	NỘI DUNG

	Hoạt động 1: Định dạng trang tính

	? Để thay đổi phông chữ ta làm ntn?

? Để thay đổi cỡ chữ ta làm ntn?

? Để thay đổi kiêu chữ ta làm ntn?

? Nêu cách chọn màu cho phông?

? Cách căn lề trong ô tính?

? Để tăng, giảm số chữ số thập phân ta làm ntn?

? Trình bày cách tô màu nền và ket đường biên trong trang tính.


	HS: Trả lời.

HS: Trả lời.

HS: Trả lời.

HS: Trả lời.

HS: Trả lời.

HS: Trả lời.

HS: Trả lời.


	1. Định dạng trang tính

a) Thay đổi phông chữ
-  Đánh dấu ô.

-  Nháy mũi tên ở ô Font và chọn phông thích hợp.

b) Thay đổi cỡ chữ
-  Đánh dấu ô.

-  Nháy mũi tên ở ô cỡ chữ và chọn cỡ thích hợp.

c) Thay đổi kiểu chữ
-  Đánh dấu ô.

-   Nháy vào B, I, U

d) Chọn màu phông

-  Đánh dấu ô.

-  Nháy mũi tên ở nút chữ A

e) Căn lề trong ô tính

- Đánh dấu ô.

- Nháy chọn các nút lệnh căn lề.

f) Tăng, giảm số chữ số thập phân

- Nháy chọn ô.

- Sử dụng hai nút lệnh tăng, giảm chữ số thập phân.

g) Tô màu nền và kẻ đường biên

 Tô màu nền

- Nháy chọn ô.

- Sử dụng nút lệnh Fill Color.

Kẻ đường biên

- Chọn ô.

- Sử dụng nút Border.



	                                          Hoạt động 2: Tr×nh bµy vµ in trang tÝnh.

	? Trình bày cách đặt lề hướng giấy in.

? Để in trang tính ta làm ntn?


	HS: Trả lời.

HS: Trả lời.
	2. Trình bày và in trang tính

- Đặt lề hướng giấy in

File -> Page Setup. XHHT, lựa chọn hướng giấy và lề giấy -> Ok.

-  In trang tính

File -> Print.




V – DẶN DÒ

- Hướng dẫn HS về nhà ôn tập:


+  Sắp xếp và lọc dữ liệu


+ Trình bày dữ liệu bằng biểu đồ
Rút kinh nghiệm

___________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________
Tiết: 68                                                                                                          Ngày Soạn: 5/04/09

Tuần: 34                                                                                                       Ngày dạy : ..../04/09

ÔN TẬP
I -  MỤC TIÊU
a. Kiến thức

- Tổng hợp kiến thức về định dạng trang tính, trình bày và in trang tính.

- Củng cố cách sắp xếp và lọc dữ liệu, cách tạo biểu đồ minh hoạ dữ liệu.

b. Kỹ Năng

- Hình thành kĩ năng tư duy tổng hợp, thành thạo các thao tác.

II - PHƯƠNG PHÁP

- Thuyết trình và thực hành trên máy.. 

III -  CHUẨN BỊ
1. Giáo viên: Giáo trình, Phòng máy.

2. Học sinh. Các kiến thức đã học.

IV -  TIẾN TRÌNH DẠY HỌC 

	HOẠT ĐỘNG CỦA THẦY
	HOẠT ĐỘNG CỦA TRÒ
	NỘI DUNG

	Hoạt động 1: Sắp xếp và lọc dữ liệu

	? Trình bày cách sắp xếp dữ liệu trong trang tính?

? Để lọc dữ liệu trong trang tính ta làm ntn?

? Sau khi lọc để hiển thị lại dữ liệu ta làm ntn?

? Nêu cách thoát khỏi chế đọ lọc?


	
	3. Sắp xếp và lọc dữ liệu

a) Sắp xếp dữ liệu

-  Chọn ô trong cột cần sắp xếp.

-  Nháy nút lệnh sắp xếp tăng (hoặc giảm).

b) Lọc dữ liệu

- Chọn ô trong vùng cần lọc.

- Data -> Filter -> AutoFilter

Hiển thị lại dữ liệu

-  Data -> Filter -> Show All

Thoát khỏi chế độ lọc

-  Data -> Filter -> AutoFilter.



	                                      Hoạt động 2: Tr×nh bµy d÷ liÖu b»ng biÓu ®å.

	? Em hãy trình bày cách vẽ biểu đồ biểu diễn dữ liệu trên trang tính ?


	
	4. Trình bày dữ liệu bằng biểu đồ
-  Chọn ô trong vùng dữ liệu

-  Nháy nút Chart Wizard.

-  Nháy Next liên tiếp.

-  Nháy Finish khi Next mờ đi.



	                                                       Hoạt động 3: LuyÖn tËp

	GV : Cho HS thùc hµnh l¹i tÊt c¶ c¸c thao t¸c ®· häc.
	
	5. LuyÖn tËp

(¤n tËp c¸c thao t¸c ®· häc)


V – DẶN DÒ
- Hướng dẫn HS về nhà ôn tập chuẩn bị cho bài kiểm tra cuối năm.

Rút kinh nghiệm

___________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________
Tiết: 69                                                                                                          Ngày Soạn: 15/04/09

Tuần: 35                                                                                                       Ngày dạy : ..../04/09

KIỂM TRA HỌC KỲ II - PHẦN THỰC HÀNH  
I -  MỤC TIÊU
a. Kiến thức

- Kiểm ta việc nắm bắt kiến thức thực hành của HS về định dạng trang tính, trình bày trang in, sắp xếp và lọc dữ liệu, vẽ biểu đồ.

b. Kỹ Năng

- Thành thạo các thao tác trên.

c. Phương pháp
  - Thực hành, hoạt động cá nhân.

II -  CHUẨN BỊ
1. Giáo viên: Đề bài, Phòng máy.

2. Học sinh. Các kiến thức đã học.

III -  TIẾN TRÌNH DẠY HỌC 

Đề bài

Cho bảng điểm học sinh:

Bảng điểm lớp 7A

	STT
	Họ và tên
	Toán
	Ngữ Văn
	Tin Học
	Vật Lí
	ĐTB

	1
	Nguyễn Hoà An
	8
	7
	8
	7
	?

	2
	Lê Thái Anh
	8
	5
	7
	8
	?

	3
	Trần Quốc Bình
	8
	9
	9
	8
	?

	4
	Phạm Ngọc Mai
	9
	9
	10
	8
	?

	5
	Bùi Thu Hà
	7
	6
	8
	5
	?

	6
	Chu Thị Hương
	8
	8
	6
	8
	?

	7
	Bùi Mỹ Linh
	8
	9
	8
	7
	?

	8
	Vũ Thị Mai
	7
	5
	5
	7
	?

	9
	Lê Văn Quang
	3
	4
	6
	5
	?

	10
	Trần Thu Phương
	5
	6
	7
	7
	?

	....
	Hà Thanh Thư
	8
	7
	6
	8
	?

	12
	Phạm Hải Yến
	10
	8
	10
	9
	?


a) Khởi động chương trình bảng tính Excel và  Vietkey rồi nhập đúng nội dung bảng trên.            (1 điểm)

b) Tính các ô trong cột ĐTB bằng điểm trung bình của các môn học.             (1 điểm)

c) Sắp xếp lại cột ĐTB theo thứ tự điểm tăng  dần.                                          (0,5 điểm)

d) Dùng hàm Max tìm ra học sinh có ĐTB cao nhất.                                       (0,5 điểm)

e) Lọc ra học sinh có ĐTB là 8.0.                                                                     (1 điểm)

f) Nhập lại bảng hệ thống dưới và vẽ đồ thị thích hợp để mô tả tỉ lệ lực học của từng loại học sinh so với tổng thể.                                                                         (1 điểm)

	Lực học
	Tổng cộng

	Giỏi
	4

	Khá
	5

	Trung bình
	2

	Yếu
	1


Đáp án

	Câu
	Đáp án

	a
	Khởi động Excel và Vietkey, nhập đúng dữ liệu

	b
	Tính các ô trong cột ĐTB

	
	G3 = AVERAGE(C3:F3)

	
	G4 = AVERAGE(C4:F4)

	
	G5 = AVERAGE(C5:F5)

	
	G6 = AVERAGE(C6:F6)

	
	G7 = AVERAGE(C7:F7)

	
	G8 = AVERAGE(C8:F8)

	
	G9 = AVERAGE(C9:F9)

	
	G10 = AVERAGE(C10:F10)

	
	G.... = AVERAGE(C....:F....)

	
	G12 = AVERAGE(C12:F12)

	
	G13 = AVERAGE(C13:F13)

	
	G14 = AVERAGE(C14:F14)

	c
	Nháy 1 ô trong cột ĐTB và nháy nút sắp xếp tăng dần

	d
	=MAX(G2:G13)

	e
	Chọn ô, Data -> Filter -> AutoFilter. Chọn 8.0

	f
	Vẽ đúng biểu đồ thích hợp


IV – DẶN DÒ

- Hướng dẫn HS ôn tập chuẩn bị cho bài kiểm tra lý thuyết cuối năm.

Rút kinh nghiệm

____________________________________________________________________________________________________________________________________________________________________________________________________________________________________
Tiết: 70                                                                                                          Ngày Soạn: 15/04/09

Tuần: 35                                                                                                       Ngày dạy : ..../04/09

KIỂM TRA HỌC KỲ II - PHẦN LÝ THUYẾT  

I -  MỤC TIÊU
a. Kiến thức

- Kiểm ta việc nắm bắt kiến thức lý thuyết của HS về tất cả các phần đã học của học kỳ II

b. Kỹ Năng

- Rèn cho học sinh kỹ năng trong suy nghĩ, tư duy, làm chủ tình huống.
c. Phương pháp
- Viết trên giấy. Hoạt động cá nhân.

II -  CHUẨN BỊ
1. Giáo viên: Đề bài.

2. Học sinh. Các kiến thức đã học.

III -  TIẾN TRÌNH DẠY HỌC 

Đề bài

I. Chọn câu trả lời đúng và ghi vào phần trả lời .

Câu 1: Có mấy dạng biểu đồ phổ biến nhất mà em được học trong chương trình?

a/  2



b/  3


c/  4



d/  5

Câu 2. Giả sử cần tính tổng các giá trị trong các ô C2 và D4, sau đó nhân với giá trị trong ô B2. Công thức nào sau đây là đúng?

a/   (C2+D4)*B2;

b/ = C2+D4* B2;        
 c/ =(C2+D4)*B2;

d/ =(C2+D4)B2;

Câu 3: Địa chỉ ô C3 nằm ở :

a/  Cột II.  dòng 3

b/  Dòng II.  cột 3
 c/  Dòng II.  Dòng 3

d/ Cột II.  cột 3

Câu 4: Cho dữ liệu trong các ô sau A1= 19; A2 = 12; A3 = 5.    = SUM (A1: A3) có kết quả là: 

a/ 47



b/ 25           

 c/ 21


 
d/ 36

Câu 5:  Nếu trong 1 ô tính có các ký hiệu ########, điều đó có nghĩa là?

a/ Công thức nhập sai và bảng tính thông báo lỗi

b/ Dòng chứa ô đó có độ cao thấp nên không hiển thị hết chữ số

c/Ô tính đó có độ rộng hẹp nên không hiển thị hết chữ số

d/ Nhập sai dữ liệu.

Câu 6: Biểu đồ sẽ được tạo ngay với thông tin ngầm định lúc hộp thoại hiện ra, khi nháy nút:

   a/  Cancel


b/  Back

c/  Next



d/  Finish

Câu 7 : Nút sắp xếp tăng


a

[image: image105.png]





b

[image: image106.png]




c

[image: image107.png]|






d

[image: image108.png]|




Câu 8: Để sắp xếp điểm của một môn học (vd Tin học), bước đầu tiên là.

a/ Bấm vào nút 
[image: image109.png]|




 


  


b/ Ckck chuột vào cột Tin học

c/ Tô đen hết vùng dữ liệu





c/ Bấm vào nút 
[image: image110.png]





Câu 9: Cho hàm =Sum(A5:A10) để thực hiện?

   a/ Tính tổng của ô A5 và ô A10

        


a/   giá trị lớn nhất của ô A5 và ô A10

   c/ Tính tổng từ ô A5 đến ô A10 
       
        


d/ Tìm giá trị lớn nhất từ ô A5 đến  ô A10

Câu 10 Để vẽ biểu đồ y=9*x + 3


a/  simplify


b/  expand

c/  solve


d/  plot

Câu ....: Hãy chọn câu đúng.

a/ Mỗi ô có thể có nhiều địa chỉ khác nhau

b/ Dấu = là dấu cuối cùng cần gõ khi nhập công thức vào ô

c/ Thanh công thức và ô tính bao giở cũng giống nhau

d/ Tất cả đều sai

Câu 12: Để chỉnh độ rộng của cột vừa khích với dữ liệu đã có trong cột cần thực hiện thao tác nào sau đây?

a/ Nháy chuột trên vạch phân cách cột.



b/ Nháy đúp chuột trên vạch phân cách cột.

c/ Nháy chuột trên vạch phân cách dòng.



d/ Cả 3 câu trên đều sai.

Câu 13: Để chèn thêm hàng em thực hiện các thao tác nào sau đây:

a/ Click phải tại hàng chọn Insert.




b/ Chọn hàng vào Insert chọn Rows.

c/ Chọn hàng vào Insert chọn Columns.



d/ Cả 2 câu a và b dều đúng.

Câu 14: Câu nào sau đây đúng?

    a/ Sắp xếp dữ liệu là hoán đổi vị trí của các hàng với nhau.
   



    b/ Sắp xếp dữ liệu là hoán đổi vị trí của các cột với nhau.

    c/ Sắp xếp dữ liệu là chỉ chọn và hiển thị những hàng thoả mãn các tiêu chuẩn nhất định nào đó.

    d/ Sắp xếp dữ liệu là chỉ chọn và hiển thị những cột thoả mãn các tiêu chuẩn nhất định nào đó.

Câu 15: Để lọc dữ liệu thực hiện lệnh

a/ Data/Filter/Show All;
                                
 

 b/ Data/Filter/Advanced Filter;


c/ Data/Filter/AutoFilter;
                                 
 
 
d/ Data/Filter/AutoFillter.

Câu 16: Tiêu chuẩn lọc Top 10 là tiêu chuẩn lọc:

a/ Hàng có giá trị cao nhất;




 
b/ Hàng có giá trị thấp nhất;


c/ Cột có giá trị cao nhất hoặc thấp nhất;


 
d/ Hàng có giá trị cao nhất hoặc thấp nhất.

Câu 17: Để gộp nhiều ô của trang tính thành một ô và thực hiện canh giữa dữ liệu chọn nút lệnh

a/ [image: image111.bmp];



b/  [image: image112.bmp]; 



c/ [image: image113.bmp];


d/ [image: image114.bmp] 

Câu 18:  Nút lệnh Sort Descending dùng để sắp xếp theo thứ tự :

    a/ Tăng dần







b/ Giảmdần 




    c/ Theo thứ tự từ nhỏ đến lớn





d/ b và c đúng

Câu 19: Để thực hiện việc in văn bản sử dụng nút lệnh

   a/ [image: image115.bmp]
b/ [image: image116.bmp]
c/ [image: image117.bmp]

d/ b và c đúng

Câu 20: Hàm=Average(4,10,16) sẽ cho kết quả là bao nhiêu?

a/ 30



b/10             

 c/ 16



d/ 4    

Câu 21: Tác dụng của nút lệnh Setup... trên thanh công cụ Print Preview dùng để
    a/ Xem trang trước






b/ Canh lề cho văn bản


    c/ Thay đổi hướng giấy





d/ Thiết đặt lề và hướng giấy

Câu 22: Tác dụng của nút lệnh Previous trên thanh công cụ Print Preview dùng để 

    a/ Xem trang kế tiếp






b/ Điều chỉnh chế độ ngắt trang


    c/ Xem trang trước






d/ Điều chỉnh hướng giấy 

Câu 23: Để thay đổi lề của trang in sử dụng lệnh sử dụng lệnh                       

    a/ File/Page Setup/chọn trang Magins



b/ File/Page Setup/chọn trang Sheet

    c/ File/Page Setup/chọn trang Page




d/ Cả a, b, c đều đúng

Câu 24: Để định dạng kiểu chữ đậm sử dụng nút lệnh trên thanh công cụ định dạng

    a/ [image: image118.bmp]


b/ [image: image119.bmp]



c/ [image: image120.bmp]



d/ a và c đúng

Câu 25: Trong các phần mềm có tên sau, phần mềm nào là phần mềm bảng tính.
  a/ MicroSoft Word





 
b/ MicroSoft Excel

  c/ MicroSoft Power Point

    


 
d/ MicroSoft Access

Câu 26: Để định dạng màu chữ cho văn bản sử dụng nút nút lệnh:

    a/ Fill Color
 

b/ Color Font.


c/Font Color.


d/ Color Fill.

Câu 27: Nút lệnh Fill Color dùng để
    a/Tô màu chư;õ
b/ Tô màu đường viền;
c/ Tô màu nền;


d/  a,b,c đều sai.

Câu 28: Để thiết đặt lề trên cho trang in chọn

    a/ Left;


b/ Bottom;


c/ Top;

          

d/ Right.

Câu 29: Ô A1 của trang tính có số 5.25 và ô B1 có số 6.24. Số trong ô C1 được định dạng là số nguyên. Nếu trong ô C1 có công thức =A1+B1, em nhận được kết quả là:

    a/....
b/.....5
c/12


d/.....49

Câu 30: Ô A1 có nền màu xanh chữ màu trắng. Ô A3 có nền trắng chữ đen. Nếu sao chép nội dung ô A1 vào ô A3 thì sẽ nhận được :

    a/ Nền màu trắng chữ màu xanh;



b/ Nền màu xanh chữ màu trắng; 



    c/ Nền màu đen chữ màu trắng;



d/ Nền màu trắng chữ màu đen.

 III.  Trả lời

	Câu
	1
	2
	3
	4
	5
	6
	7
	8
	9
	10
	....
	12
	13
	14
	15
	16
	17
	18
	19
	20

	Đ. Án
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	

	Câu
	21
	22
	23
	24
	25
	26
	27
	28
	29
	30
	
	
	
	
	
	
	
	
	
	

	Đ. Án
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	


* Kết quả
	Lớp
	Giỏi
	Khá
	TB
	Yếu

	7A1
	
	
	
	

	7A2
	
	
	
	

	7A3
	
	
	
	


-----------------------------------------------------------------------------------
	Ngày soạn:
	
	
	
	Tiết 66

	Ngày giảng:
	7A: 
	7B: 
	7C: 
	7D: 


kiểm tra thực hành
I -  Mục tiêu
1. Kiến thức

- Kiểm tr việc nắm bắt kiến thức thực hành của học sinh về trình bày, định dạng, s dụng công thức tính toán, vẽ biểu dồ, sắp xếp và lọc dữ liệu.

2. Kỹ Năng

- Có kĩ năng tư duy, vận dụng kiến thức vào thực hành.

3. Thái độ
- Hình thành thái độ học tập nghiêm túII.  trung thực khi làm bài. 

II -  Chuẩn bị
1. Giáo viên: Đề bài kiểm tra, Phòng máy.

2. Học sinh: Kiến thức đã học. 

III -  Phương pháp
- Hoạt động cá nhân.

IV -  Tiến trình bài giảng
A. ổn định (1’ )

	7A: đủ
	7b: đủ
	7C: đủ
	7đ: đủ


B. Kiểm ra bài cũ ( kiểm tra thực hành )

C. Bài mới (40’)

Cho bảng tính

	Stt
	A
	B
	C
	D
	E
	F

	1
	Lớp
	Gỏi
	Khá
	T.bình
	Yếu
	Kém

	2
	6A
	5
	15
	9
	0
	?

	3
	6B
	4
	....
	5
	0
	?

	4
	6C
	6
	16
	5
	0
	?

	5
	6D
	9
	20
	4
	0
	?

	6
	6E
	5
	16
	8
	0
	?

	7
	7A
	4
	19
	8
	3
	?

	8
	7B
	2
	18
	10
	5
	?

	9
	7C
	1
	14
	15
	1
	?

	10
	7D
	10
	20
	4
	0
	?

	....
	7E
	15
	21
	6
	0
	?


Yêu cầu

1. Khởi động Excel, nhập dữ liệu và trình bày theo mẫu trên.

2. Sử dụng hàm để tính cột Tổng cộng.

3. Tạo biểu đồ cột trên cơ sở dữ liệu của khối A2:E12.

4. Lọc ra lớp có số học sinh giỏi nhiều nhất.

Đáp án + Biểu điểm

	Câu
	Đáp án
	Biểu điểm

	1
	Khởi động Excel, nhập dữ liệu và trình bày theo mẫu 
	2

	2
	Trong cột F nhập công thức
	5

	
	=SUM(B2:E2)
	0.5

	
	=SUM(B3:E3)
	0.5

	
	=SUM(B4:E4)
	0.5

	
	=SUM(B5:E5)
	0.5

	
	=SUM(B6:E6)
	0.5

	
	=SUM(B7:E7)
	0.5

	
	=SUM(B8:E8)
	0.5

	
	=SUM(B9:E9)
	0.5

	
	=SUM(B10:E10)
	0.5

	
	=SUM(B....:E....)
	0.5

	3
	Tạo biểu đồ đúng (Có giải thích trục đứng, trục ngang)
	1

	4
	- Lọc được lớp có số học sinh giỏi nhiều nhất
	1

	
	- Trình bày đẹp, chính xáII.  nhanh
	1


D -  Củng cố ( 3’ )

- Giáo viên đến từng máy kiểm tra kết quả kiểm tra của HS.

- Nhận xét giờ kiểm tra, ý thức làm bài, kết quả bài làm và cho điểm. 

E -  Hướng dẫn học ở nhà (1’)

- Hướng dẫn HS về nhà chuẩn bị cho bài ôn tập cuối năm.

V - Rút kinh nghiệm

- Học sinh cơ bản nắm bài tốt.

- Thời gian đảm bảo

- Học sinh thực hành nghiêm túc và thực hành tốt trên máy tính

- Một số học sinh chưa thực sự chú trọng trong việc trình bày.

	Ngày soạn:
	
	
	
	Tiết 67-68

	Ngày giảng:
	7A: 
	7B: 
	7C: 
	7D: 


ôn tập
I -  Mục tiêu
1. Kiến thức

- Tổng hợp kiến thức về định dạng trang tính, trình bày và in trang tính.

- Củng cố cách sắp xếp và lọc dữ liệu, cách tạo biểu đồ minh hoạ dữ liệu.

2. Kỹ Năng

- Hình thành kĩ năng tư duy tổng hợp, thành thạo các thao tác.

3. Thái độ
- Hình thành thái độ học tập nghiêm túII.  hăng hái phát biểu ý kiến xây dựng bài. 

II -  Chuẩn bị
1. Giáo viên: Giáo trình, Phòng máy.

2. Học sinh. Các kiến thức đã học.

III -  Phương pháp
- Thuyết trình và thực hành trên máy.

IV -  Tiến trình bài giảng
A. ổn định (1’)

	7A: đủ
	7b: đủ
	7C: đủ
	7đ: v1


B. Kiểm ra bài cũ
- Kết hợp trong giờ ôn tập. 

C. Bài mới (40’)

	Hoạt động của GV
	HĐ của HS
	Ghi bảng

	? Để thay đổi phông chữ ta làm ntn?

? Để thay đổi cỡ chữ ta làm ntn?

? Để thay đổi kiêu chữ ta làm ntn?

? Nêu cách chọn màu cho phông?

? Cách căn lề trong ô tính?

? Để tăng, giảm số chữ số thập phân ta làm ntn?

? Trình bày cách tô màu nền và ket đường biên trong trang tính.

? Trình bày cách đặt lề hướng giấy in.

? Để in trang tính ta làm ntn?

? Trình bày cách sắp xếp dữ liệu trong trang tính?

? Để lọc dữ liệu trong trang tính ta làm ntn?

? Sau khi lọc để hiển thị lại dữ liệu ta làm ntn?

? Nêu cách thoát khỏi chế đọ lọc?

? Em hãy trình bày cách vẽ biểu đồ biểu diễn dữ liệu trên trang tính ?

GV : Cho HS thực hành lại tất cả các thao tác đã học. 
	HS: Trả lời.

HS: Trả lời.

HS: Trả lời.

HS: Trả lời.

HS: Trả lời.

HS: Trả lời.

HS: Trả lời.

HS: Trả lời.

HS: Trả lời.
	1. Định dạng trang tính

a) Thay đổi phông chữ
-  Đánh dấu ô.

-  Nháy mũi tên ở ô Font và chọn phông thích hợp.

b) Thay đổi cỡ chữ
-  Đánh dấu ô.

-  Nháy mũi tên ở ô cỡ chữ và chọn cỡ thích hợp.

c) Thay đổi kiểu chữ
-  Đánh dấu ô.

-   Nháy vào B, I, U

d) Chọn màu phông

-  Đánh dấu ô.

-  Nháy mũi tên ở nút chữ A

e) Căn lề trong ô tính

- Đánh dấu ô.

- Nháy chọn các nút lệnh căn lề.

f) Tăng, giảm số chữ số thập phân

- Nháy chọn ô.

- Sử dụng hai nút lệnh tăng, giảm chữ số thập phân.

g) Tô màu nền và kẻ đường biên

 Tô màu nền

- Nháy chọn ô.

- Sử dụng nút lệnh Fill Color.

Kẻ đường biên

- Chọn ô.

- Sử dụng nút Border.

2. Trình bày và in trang tính

- Đặt lề hướng giấy in

File -> Page Setup. XHHT, lựa chọn hướng giấy và lề giấy -> Ok.

-  In trang tính

File -> Print.

3. Sắp xếp và lọc dữ liệu

a) Sắp xếp dữ liệu

-  Chọn ô trong cột cần sắp xếp.

-  Nháy nút lệnh sắp xếp tăng (hoặc giảm).

b) Lọc dữ liệu

- Chọn ô trong vùng cần lọc.

- Data -> Filter -> AutoFilter

Hiển thị lại dữ liệu

-  Data -> Filter -> Show All

Thoát khỏi chế độ lọc

-  Data -> Filter -> AutoFilter.

4. Trình bày dữ liệu bằng biểu đồ
-  Chọn ô trong vùng dữ liệu

-  Nháy nút Chart Wizard.

-  Nháy Next liên tiếp.

-  Nháy Finish khi Next mờ đi.

5. Luyện tập

(Ôn tập các thao tác đã học)


D -  Củng cố (3’)

- Nhắc lại tất cả các thao tác đã học.

E -  Hướng dẫn học ở nhà (1’)

- Hướng dẫn HS về nhà ôn tập chuẩn bị cho bài kiểm tra cuối năm.

V - Rút kinh nghiệm

- Học sinh cơ bản nắm chắc kiến thức

- Một số học sinh chưa thật sự chú ý trong quá trình ôn tập

- Thời gian đảm bảo

- Hs hăng hái phát biểu và xây dựng bài.

	Ngày soạn:
	17/4/2009
	
	
	Tiết 69+ 70

	Ngày giảng:
	7A:  21/4
	7B:  21/4
	7C: 23/4
	7D: 23/4


kiểm tra học kỳ ii - phần thực hành  
I -  Mục tiêu
1. Kiến thức

- Kiểm ta việc nắm bắt kiến thức thực hành của HS về định dạng trang tính, trình bày trang in, sắp xếp và lọc dữ liệu, vẽ biểu đồ.

2. Kỹ Năng

- Thành thạo các thao tác trên.

3. Thái độ
- Hình thành thái độ nghiêm túII.  trung thực trong giờ kiểm tra.

II -  Chuẩn bị
1. Giáo viên: Đề bài, Phòng máy.

2. Học sinh. Các kiến thức đã học.

III -  Phương pháp
- Thực hành, hoạt động cá nhân.

IV -  Tiến trình bài giảng
A. ổn định (1’)

B. Kiểm ra bài cũ
C. Bài mới

Đề bài

Cho bảng điểm học sinh:

Bảng điểm lớp 7A

	STT
	Họ và tên
	Toán
	Ngữ Văn
	Tin Học
	Vật Lí
	ĐTB

	1
	Nguyễn Hoà An
	8
	7
	8
	7
	?

	2
	Lê Thái Anh
	8
	5
	7
	8
	?

	3
	Trần Quốc Bình
	8
	9
	9
	8
	?

	4
	Phạm Ngọc Mai
	9
	9
	10
	8
	?

	5
	Bùi Thu Hà
	7
	6
	8
	5
	?

	6
	Chu Thị Hương
	8
	8
	6
	8
	?

	7
	Bùi Mỹ Linh
	8
	9
	8
	7
	?

	8
	Vũ Thị Mai
	7
	5
	5
	7
	?

	9
	Lê Văn Quang
	3
	4
	6
	5
	?

	10
	Trần Thu Phương
	5
	6
	7
	7
	?

	....
	Hà Thanh Thư
	8
	7
	6
	8
	?

	12
	Phạm Hải Yến
	10
	8
	10
	9
	?


g) Khởi động chương trình bảng tính Excel và  Vietkey rồi nhập đúng nội dung bảng trên.            (1 điểm)

h) Tính các ô trong cột ĐTB bằng điểm trung bình của các môn học.             (2 điểm)

i) Sắp xếp lại cột ĐTB theo thứ tự điểm tăng  dần.                                          (1 điểm)

j) Dùng hàm Max tìm ra học sinh có ĐTB cao nhất.                                       (2 điểm)

k) Lọc ra học sinh có ĐTB là 8.0.                                                                     (2 điểm)

l) Nhập lại bảng hệ thống dưới và vẽ đồ thị thích hợp để mô tả tỉ lệ lực học của từng loại học sinh so với tổng thể.                                                                         (2 điểm)

	Lực học
	Tổng cộng

	Giỏi
	4

	Khá
	5

	Trung bình
	2

	Yếu
	1


Đáp án + Biểu điểm

	Câu
	Đáp án
	Biểu điểm

	a
	Khởi động Excel và Vietkey, nhập đúng dữ liệu
	2

	b
	Tính các ô trong cột ĐTB
	

	
	G2 = AVERAGE(C2:F2)
	0.25

	
	G3 = AVERAGE(C3:F3)
	0.25

	
	G4 = AVERAGE(C4:F4)
	0.25

	
	G5 = AVERAGE(C5:F5)
	0.25

	
	G6 = AVERAGE(C6:F6)
	0.25

	
	G7 = AVERAGE(C7:F7)
	0.25

	
	G8 = AVERAGE(C8:F8)
	0.25

	
	G9 = AVERAGE(C9:F9)
	0.25

	
	G10 = AVERAGE(C10:F10)
	0.25

	
	G.... = AVERAGE(C....:F....)
	0.25

	
	G12 = AVERAGE(C12:F12)
	0.25

	
	G13 = AVERAGE(C13:F13)
	0.25

	c
	Nháy 1 ô trong cột ĐTB và nháy nút sắp xếp tăng dần
	1

	d
	=MAX(G2:G13)
	1

	e
	Chọn ô, Data -> Filter -> AutoFilter. Chọn 8.0
	1

	f
	Vẽ đúng biểu đồ thích hợp
	1


D -  Củng cố
- Đến từng máy nhận xét ư, nhược điểm, sửa sai cho các em.

-  Nhận xét về ý thức làm bài của học sinh và cho điểm.

E -  Hướng dẫn học ở nhà
- Hướng dẫn HS ôn tập chuẩn bị cho bài kiểm tra lý thuyết cuối năm.

Tiết 70

kiểm tra học kỳ ii - phần lý thuyết  
I -  Mục tiêu
1. Kiến thức

- Kiểm ta việc nắm bắt kiến thức lý thuyết của HS về tất cả các phần đã học của học kỳ III. 
2. Kỹ Năng

- Rèn cho học sinh kỹ năng trong suy nghĩ, tư duy, làm chủ tình huống.
3. Thái độ
- Hình thành thái độ nghiêm túII.  trung thực trong giờ kiển tra.

II -  Chuẩn bị
1. Giáo viên: Đề bài.

2. Học sinh. Các kiến thức đã học.

III -  Phương pháp
- Viết trên giấy. Hoạt động cá nhân.

IV -  Tiến trình bài giảng
A. ổn định

B. Kiểm ra bài cũ
C. Bài mới

Đề bài

Phần I: Trắc nghiệm: Chọn câu trả lời đúng trong các câu sau đây:

Câu 1: các nút lệnh  [image: image121.png]


 nằm trên thanh nào ?

a.Thanh tiêu đề

b.Thanh thực đơn

c.Thanh công cụ

d.Thanh trạnh thái

Câu 2: Để lưu trang tính ta phải sử dụng lệnh

a.File -> New

b.File ->  Exit

c.Fle -> Open

d.File -> Save

Câu 3: Để ngắt trang tinh ta sử dung lệnh

a.Frint PreView

b.Page Break Preview

c.Print

d.Cả a, b, c đều sai

Câu 4: Muốn đặt lề trên của trang tính thì trong hộp thoại PageSetup chọn ô
a.Top

b.Left

c.Bottom

d.Right

Câu 5: Nút lệnh nào dùng để sắp xếp theo thứ tụ tăng dần ?

a.[image: image122.png]




b.[image: image123.png]%l




c.[image: image124.png]




d.cả a, b, c đều sai

Câu 6: Để giảm chữ số thập phânta sử dụng lệnh:

a.[image: image125.png]




b.[image: image126.png]



c.[image: image127.png]




d.cả a, b, c đều sai

Câu 7: Biểu đồ cột dùng để:

a.So Sánh dữ liệu và dự đoán xu thế của tăng hay giảm của dữ liệu.

b.Mô tả tỉ lệ của dữ liệu so với tổng tổng thể.

c.So sánh dữ liệu trong nhiều cột.

d.Cả a, b, c đều sai.

Câu 8: để lọc dữ liệu ta sử dụng lệnh

a.Data -> Filter -> AutoFilter

b.Data -> Filter -> Show All

c.Data -> Sort

d.Cả a, b, c đều sai

Câu 9: để vẽ biểu đồ ta dùng nút lệnh:

a.[image: image128.png]




b.[image: image129.png]



c.[image: image130.png]




d.[image: image131.png]



Câu 10: Để in trang tính ta sử dụng nút lệnh

a.[image: image132.png]




b.[image: image133.png]



c.[image: image134.png]




d.[image: image135.png]



Phần II : Tự Luận ( 5 điểm )

Câu 1( 2,5 điểm). Giả Sử ô A1 có nền màu xanh và chữ màu đỏ. Ô A3 có nền màu trắng và chữ màu đen. em hãy nêu cách sao chép nội dung ô A1 vào iô A3 và thử dự đoán xem sau khi sao chép ô A3 có nền và phông chữ màu gì ?

Câu 2 (2.5 điểm). Em hãy nêu các thao tác định dạng trang tính?

Đáp án + Biểu điểm

	Câu
	Đáp án
	Biểu điểm

	Trắc nghiệm

	1
	C
	0,5

	2
	D
	0,5

	3
	B
	0,5

	4
	A
	0,5

	5
	C
	0,5

	6
	B
	0,5

	7
	C
	0,5

	8
	A
	0,5

	9
	D
	0,5

	10
	B
	0,5

	Tự luận

	1
	- Sử dụng 2 nút lệnh Copy và Paste 

- Ô A3 có nền xanh, chữ đỏ
	1,5

1

	2
	· Định dạng phông chữ, cỡ chữ và kiểu chữ
· Chon màu phông

· Căn lề trong ô tính

· Tăng hoặc giảm số chữ sô thập phân

· Tô màu nền và kẻ đường biên của các ô tính
	0,5

0,5

0,5

0,5

0,5


D -  Củng cố
- Đến từng máy nhận xét ưu, nhược điểm, sửa sai cho các em.

-  Nhận xét về ý thức làm bài của học sinh và cho điểm.

E -  Hướng dẫn học ở nhà
- Hướng dẫn HS ôn tập chuẩn bị cho bài kiểm tra lý thuyết cuối năm.
* Kết quả
	Lớp
	Giỏi
	Khá
	TB
	Yếu

	7A
	
	
	
	

	7B
	
	
	
	

	7C
	
	
	
	

	7D
	
	
	
	


-----------------------------------------------------------------------------------
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Giáo viên: Trần Thanh Viện                -99-               Trường THCS Phong Hòa
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